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1.1 Informazioni sul presente manuale 

Figura 1-1: La *necessità* dei manuali (xkcd.com).

Il Manuale utente MX è il risultato del lavoro di un nutrito gruppo di volontari della comunità MX Linux. Pertanto, 
nonostante ci siamo impegnati al massimo per ridurli al minimo, è inevitabile che contenga errori e omissioni. Vi 
preghiamo di inviarci commenti, correzioni o suggerimenti utilizzando uno dei metodi elencati di seguito. Gli 
aggiornamenti verranno effettuati secondo necessità.

Questo manuale è stato progettato per guidare i nuovi utenti attraverso i passaggi necessari per ottenere una copia 
di MX Linux, installarla, configurarla per funzionare con il proprio hardware e utilizzarla quotidianamente. Il suo 
scopo è fornire un'introduzione generale di facile lettura, privilegiando gli strumenti grafici quando disponibili. Per 
argomenti dettagliati o poco frequenti, l'utente dovrebbe consultare il Wiki e altre risorse o pubblicare un post sul 
forum MX Linux.

MX Fluxbox non è incluso qui perché differisce da Xfce e KDE in modo così significativo che allungherebbe e 
complicherebbe questo manuale. Un documento di aiuto separato è incluso con ogni installazione di MX Fluxbox.

I nuovi utenti potrebbero trovare alcuni dei termini utilizzati in questo manuale poco familiari o confusi. Abbiamo 
cercato di limitare l'uso di termini e concetti difficili, ma alcuni sono semplicemente inevitabili. Il Glossario 
situato alla fine del documento fornisce definizioni e commenti che vi aiuteranno a comprendere i passaggi 
difficili.

Tutti i contenuti sono © 2025 di MX Linux Inc. e rilasciati sotto licenza GPLv3. La citazione deve essere:

MX Linux Community Documentation Project. 2025. Manuale utente per MX Linux.

Feedback:

• Email: manual AT mxlinux DOT org

• Forum: Documentazione e video MX

1 Introduzione

https://forum.mxlinux.org/
https://forum.mxlinux.org/viewforum.php?f=101


1.2 Informazioni su MX Linux 

Gli utenti hanno atteggiamenti molto diversi nei confronti di MX Linux, o di qualsiasi sistema operativo. Alcuni 
potrebbero desiderare semplicemente un dispositivo che funzioni, come una caffettiera che produce una bevanda 
calda su richiesta. Altri potrebbero essere curiosi di sapere come funziona realmente, ovvero perché ottengono del 
caffè e non una sostanza densa e torbida. Questa sezione è pensata per orientare il secondo gruppo. Il primo gruppo 
potrebbe preferire passare direttamente alla Sezione 1.3: "Informati!".

MX Linux è una versione desktop della fusione tra la collezione GNU di software libero e il kernel Linux, entrambi 
nati all'inizio degli anni '90. GNU/Linux, o più semplicemente e comunemente chiamato solo "Linux", è un sistema 
operativo (OS) libero e open-source che ha un approccio unico e di grande successo a tutto, dal kernel agli strumenti 
alla struttura dei file (Sezione 7). Viene fornito agli utenti attraverso distribuzioni o "distro", di cui una delle più 
antiche e popolari è Debian, su cui è basato MX Linux.

1.2.1 Linux

Per fornire una rapida panoramica, ecco un diagramma semplificato e una descrizione di un sistema operativo 
Linux, adattato da Anatomy of the Linux kernel.

• Nella parte superiore si trova lo spazio utente, noto anche come spazio applicativo. È qui che vengono 
eseguite le applicazioni utente fornite dalla distribuzione o aggiunte dall'utente. C'è anche l'interfaccia 
GNU C Library (glibc) che collega le applicazioni al kernel. (Da qui il nome alternativo "GNU/Linux" 
mostrato nel diagramma).

• Sotto lo spazio utente si trova lo spazio kernel, dove risiede il kernel Linux. Il kernel è dominato dai 
driver hardware.

File system

https://www.gnu.org/
https://en.wikipedia.org/wiki/Linux
https://en.wikipedia.org/wiki/Linux_distribution
https://en.wikipedia.org/wiki/Debian


Uno dei primi problemi con cui molti nuovi utenti Linux si trovano a lottare è il funzionamento del file system. 
Molti nuovi utenti hanno cercato invano di trovare l'unità C:\ o D:\ , ad esempio, ma Linux gestisce i dischi rigidi e 
altri supporti di memorizzazione in modo diverso rispetto a Windows. Anziché avere un albero di file system 
separato su ogni dispositivo, MX Linux ha un unico albero di file system (chiamato radice del file system), che è 
indicato come "/" e contiene tutti i dispositivi collegati. Quando un dispositivo di archiviazione viene aggiunto al 
sistema, il suo file system viene collegato a una directory o sottodirectory del file system; questa operazione è 
chiamata montaggio di un'unità o di un dispositivo. Inoltre, ogni utente ha una sottodirectory dedicata sotto /home, 
e per impostazione predefinita è qui che si cercano i propri file. Per i dettagli, vedere la Sezione 7.

La maggior parte delle impostazioni dei programmi e del sistema su MX Linux sono memorizzate in file di 
configurazione discreti in testo semplice; non esiste un "Registro" che richieda strumenti speciali per essere 
modificato. I file sono semplici elenchi di parametri e valori che descrivono il comportamento dei programmi al 
loro avvio.

Attenzione

I nuovi utenti arrivano con aspettative derivanti dalla loro esperienza precedente. Questo è naturale, ma all'inizio 
può portare a confusione e frustrazione. Due nozioni fondamentali da tenere a mente:

1. MX Linux non è Windows. Come indicato sopra, non esiste un Registro di sistema o un'unità C:\ e la 
maggior parte dei driver è già presente nel kernel.

2. MX Linux non è basato sulla famiglia Ubuntu, ma su Debian stesso. Ciò significa che i comandi, i 
programmi e le applicazioni (in particolare quelli presenti nei "Personal Package Archives" o PPA) della 
famiglia Ubuntu potrebbero non funzionare correttamente o addirittura mancare.

1.2.2 MX Linux

MX Linux, rilasciato per la prima volta nel 2014, è una collaborazione tra le comunità antiX ed ex MEPIS che 
utilizza i migliori strumenti e talenti di ciascuna distribuzione e include il lavoro e le idee originariamente creati da 
Warren Woodford. È un sistema operativo di peso medio progettato per combinare un desktop elegante ed efficiente 
con una configurazione semplice, un'elevata stabilità, prestazioni solide e un ingombro medio.

Basandosi sull'eccellente lavoro a monte di Linux e della comunità open source, con MX-25 implementiamo il 
nostro fiore all'occhiello Xfce 4.20 come ambiente desktop, insieme a KDE/Plasma
5.27 e Fluxbox 1.3.7 come versioni autonome separate. Tutto poggia su una base Debian Stable (Debian 13, 
"Trixie"), attingendo anche dal sistema antiX core. I backport continui e le aggiunte esterne ai nostri repository 
servono a mantenere i componenti aggiornati con gli sviluppi richiesti dagli utenti.

Il team di sviluppo MX è composto da un gruppo di volontari con background, talenti e interessi diversi. Per i 
dettagli, consultare la sezione Chi siamo. Un ringraziamento speciale per il forte sostegno continuo a questo 
progetto va ai MX Linux Packagers, ai produttori video, ai nostri fantastici volontari e a tutti i nostri traduttori!

https://antixlinux.com/
https://en.wikipedia.org/wiki/MEPIS
https://www.xfce.org/about/tour418
https://wiki.debian.org/DebianStable
https://mxlinux.org/about-us


1.2.3 La grande novità

Sistemi Init separati

MX-25 non è più in grado di fornire due sistemi init disponibili in un'unica installazione: SysVinit (systemd 
predefinito). A partire dalla versione MX-25, avremo quindi ISO separate per ciascun sistema init. I nostri 
pacchetti systemd-shim, che in passato ci permettevano di fornire sia systemd che sysVinit su una singola iso, 
attualmente non sono funzionanti con gli ultimi kernel di Debian. Di conseguenza, sysVinit e systemd non 
potranno coesistere sulla stessa iso o installazione.

Per la massima compatibilità con l'ecosistema Debian, le versioni standard di Xfce, Fluxbox e KDE utilizzeranno 
systemd. Saranno disponibili anche versioni sysVinit delle versioni Xfce e Fluxbox. Avrete comunque la 
possibilità di scegliere, ma dovrete farlo al momento del download anziché all'avvio.

Una sola architettura
A partire da MX-25, MX Linux offre solo l'architettura a 64 bit. Con Debian che ha eliminato i kernel a 32 bit dai 
propri pacchetti mantenuti, MX sta seguendo l'esempio e non produrrà immagini ISO ufficiali a 32 bit. ALTRO: 
Sezione 2.1.1

1.3 Informatevi!

Le icone sul desktop rimandano a due documenti utili: le FAQ e il Manuale utente.

• Le FAQ forniscono una rapida guida per i nuovi utenti rispondendo alle domande più frequenti poste 
sul forum.

• Il Manuale utente fornisce una panoramica dettagliata del sistema operativo. Poche persone lo leggono 
dall'inizio alla fine, ma può essere consultato rapidamente 1) utilizzando l'indice per passare 
all'argomento generale che ti interessa, oppure 2) premendo Alt + F1 per aprirlo e Ctrl + F per cercare 
un argomento specifico.

• Altre fonti di informazione includono il Forum, il Wiki, la raccolta di video online e vari account sui 
social media. Queste risorse sono facilmente accessibili dalla Home page.

• Particolarmente utili sono le numerose guide pratiche della community pubblicate sul forum. 
Sebbene non siano documenti MX ufficiali, sono state create e solitamente revisionate dagli stessi 
utenti MX esperti.

1.4 Assistenza e EOL

Che tipo di supporto è disponibile per MX Linux? La risposta a questa domanda dipende dal tipo di supporto a cui 
ti riferisci:

• Problemi relativi agli utenti. Esistono numerosi meccanismi di supporto per MX Linux, dai 
documenti e video ai forum e motori di ricerca. Per ulteriori dettagli, consultare la pagina Supporto 
della community.

https://en.wikipedia.org/wiki/Systemd
https://en.wikipedia.org/wiki/64-bit_computing
https://forum.mxlinux.org/
https://mxlinux.org/wiki/
https://mxlinux.org/
https://forum.mxlinux.org/viewforum.php?f=152
https://mxlinux.org/support
https://mxlinux.org/support


• Hardware. L'hardware è supportato nel kernel, dove è in corso uno sviluppo continuo. L'hardware 
molto recente potrebbe non essere ancora supportato e quello molto vecchio, sebbene ancora 
supportato, potrebbe non essere più sufficiente per le esigenze del desktop e delle applicazioni. 
Tuttavia, la maggior parte degli utenti troverà disponibile il supporto per il proprio hardware.

• Desktop. Xfce4 è un desktop maturo che rimane in fase di sviluppo. La versione fornita con MX 
Linux (4.20) è considerata stabile; gli aggiornamenti importanti saranno applicati non appena 
disponibili. L'ambiente KDE/Plasma è mantenuto su base continuativa.

• Applicazioni. Le applicazioni continuano a essere sviluppate dopo il rilascio di qualsiasi versione di 
MX Linux, il che significa che le versioni fornite diventeranno obsolete con il passare del tempo. 
Questo problema viene affrontato attraverso una combinazione di fonti: Debian (inclusi Debian 
Backports), singoli sviluppatori (inclusi MX Devs) e il Community Packaging Team, che accetta il più 
possibile le richieste di aggiornamento degli utenti. MX Updater segnala quando sono disponibili 
nuovi pacchetti da scaricare.

• Sicurezza. Gli aggiornamenti di sicurezza di Debian copriranno gli utenti MX Linux per un massimo 
di 5 anni. Controlla MX Updater per le notifiche sulla loro disponibilità.

• Fine del ciclo di vita. Il supporto per la base Debian è attualmente previsto fino al 30 giugno 
2030. I dettagli sul supporto e gli aggiornamenti sono disponibili su questo sito Debian.

Note per i traduttori
Alcune indicazioni per chi desidera tradurre il Manuale utente:

• I testi in inglese dell'ultima versione sono disponibili in un repository GitHub. Le traduzioni disponibili 
sono memorizzate nella directory "tr".

◦ È possibile lavorare all'interno del sistema GitHub: clonare il repository principale, apportare le 
modifiche e quindi inviare una richiesta di pull per farla revisionare e unire al codice sorgente.

◦ In alternativa, è possibile scaricare ciò che interessa e lavorarci localmente prima di comunicare che 
è pronto tramite e-mail all'indirizzo manual AT mxlinux DOT org o pubblicando un post sul forum.

• In termini di importanza, si consiglia di iniziare con le sezioni 1-3, che forniscono le informazioni più 
rilevanti per i nuovi utenti. Una volta completate, possono essere distribuite agli utenti come traduzione 
parziale mentre le sezioni successive vengono tradotte.

https://endoflife.date/debian
https://github.com/MX-Linux/mx-docs
https://help.github.com/articles/cloning-a-repository/
https://help.github.com/articles/about-pull-requests/


 2 Installazione

2.1 Requisiti di sistema 

2.1.1 Architettura
Seguire il metodo appropriato riportato di seguito per verificare se il proprio computer è in grado di gestire 
l'architettura MX-25 a 64 bit.

• Linux. Apri un terminale e inserisci il comando lscpu, quindi esamina le prime righe per verificare 
l'architettura, il numero di core, ecc.

• Windows. Consultare questo documento Microsoft.
• Apple. Consultare questo documento Apple.

Se non è compatibile, gli utenti a 32 bit non saranno esclusi, poiché MX 23 sarà supportato dopo il rilascio di MX 
25 e il supporto di sicurezza LTS di Debian dovrebbe durare fino a giugno 2028. Abbiamo anche in programma di 
continuare a creare pacchetti a 32 bit per il nostro repository MX 25, il che potrebbe consentire la possibilità di un 
"Community Respin" a 32 bit se un kernel diventasse disponibile.
NOTA: la nostra distribuzione gemella antiX attualmente prevede di continuare a fornire un ISO ufficiale a 32 bit.

2.1.2 Memoria (RAM)
• Linux. Apri un terminale e inserisci il comando free -h, quindi controlla il numero nella colonna 

Totale.
• Windows. Apri la finestra Sistema utilizzando il metodo consigliato per la tua versione e cerca la voce 

"Memoria installata (RAM)".
• Apple. Clicca sulla voce "Informazioni su questo Mac" nel menu Apple su Mac OS X e cerca le 

informazioni sulla RAM.

2.1.3 Hardware

Per un sistema MX Linux installato su un disco rigido, normalmente sono necessari i seguenti componenti.

Minimo

• Un'unità CD/DVD (e un BIOS in grado di avviare il sistema da tale unità) o una USB live (e un 
BIOS in grado di avviare il sistema da USB).

• Un moderno processore Intel o AMD i686, noto anche come CPU.

• 1 GB di memoria RAM.

• 6 GB di spazio libero sul disco rigido.

• Per l'uso come USB live, 4 GB liberi.

https://support.microsoft.com/en-us/kb/827218
https://support.apple.com/en-us/HT201948


Consigliato

• Un'unità CD/DVD (e BIOS in grado di avviarsi da tale unità) o una Live USB (e BIOS in grado di 
avviarsi da USB).

• Una CPU Intel o AMD i686 moderna, ovvero un processore.

• 2 GB di memoria RAM o più.

• Almeno 20 GB di spazio libero sul disco rigido.

• Una scheda video con supporto 3D per il desktop 3D.

• Una scheda audio compatibile con SoundBlaster, AC97 o HDA.

• Per l'uso come LiveUSB, 8 GB liberi se si utilizza la persistenza.

NOTA: alcuni utenti di MX Linux a 64 bit segnalano che 2 GB di RAM sono sufficienti per un uso generico, 
anche se si consigliano almeno 4 GB di RAM se si eseguono processi (come il remastering) o applicazioni (come 
un editor audio o video) che richiedono molta memoria.

2.2 Creazione di un supporto di avvio

2.2.1 Ottenere l'ISO
MX Linux è distribuito come ISO, un file immagine disco nel formato del file system ISO 9660. È disponibile in 
quattro formati nella pagina Download.

• La versione originale di una determinata versione.
• Si tratta di una versione statica che, una volta rilasciata, rimane invariata.
• Più tempo è trascorso dal rilascio, meno è aggiornata.

• Un aggiornamento mensile di una determinata versione. Questo ISO mensile viene creato dalla 
versione originale utilizzando MX Snapshot (vedere la Sezione 6.6.4).

• Include tutti gli aggiornamenti successivi alla versione originale, eliminando così la necessità di 
scaricare un gran numero di file dopo l'installazione.

• Consente inoltre agli utenti di eseguire Live con la versione più recente dei programmi.
• Disponibile solo come download diretto!

 Creare una live-usb antiX/MX da Windows

Acquista

• Laptop precaricati e pretestati da Starlabs.

• DVD e USB precaricati e pretestati da Shop Linux Online

• Desktop virtuale sicuro da utilizzare su qualsiasi dispositivo da Shells.

http://en.wikipedia.org/wiki/ISO_9660
http://www.mxlinux.org/download-links
https://youtu.be/GTxphqvKYss
https://starlabs.systems/
https://www.shoplinuxonline.com/
https://www.shells.com/l/en-US/pricing?special=mx_linux


Scarica
MX Linux può essere scaricato in due modi dalla pagina Download.

• Diretto. I download diretti sono disponibili dal nostro Direct Repo o dai nostri Mirror. Salva l'ISO sul tuo 
disco rigido. Se una fonte sembra lenta, prova l'altra. Disponibile sia per la versione originale che per 
l'aggiornamento mensile.

• Torrent. La condivisione di file BitTorrent fornisce un protocollo Internet per il trasferimento efficiente di 
grandi quantità di dati. Decentralizza il trasferimento in modo tale da utilizzare connessioni con una buona 
larghezza di banda e ridurre al minimo il carico sulle connessioni con larghezza di banda ridotta. Un 
ulteriore vantaggio è che tutti i client BitTorrent eseguono il controllo degli errori durante il processo di 
download, quindi non è necessario eseguire un controllo md5sum separato al termine del download. È già 
stato fatto!
Il team MX Linux Torrent gestisce uno swarm BitTorrent seedato dell'ultima ISO MX Linux (solo 
versione originale), registrato su archive.org entro 24 ore dal suo rilascio ufficiale. I link ai torrent 
saranno disponibili nella pagina Download.

Vai alla pagina Download e clicca sul link Torrent corretto per la tua architettura. Il tuo browser dovrebbe 
riconoscere che si tratta di un torrent e chiederti come desideri gestirlo.
In caso contrario, clicca con il tasto sinistro del mouse sul torrent per la tua architettura per visualizzare la 
pagina, clicca con il tasto destro del mouse per salvarlo. Cliccando sul torrent scaricato si avvierà il tuo 
client torrent (Transmission per impostazione predefinita), mostrando il torrent nel suo elenco; 
evidenzialo e clicca su Avvia per iniziare il processo di download. Se hai già scaricato l'ISO, assicurati 
che si trovi nella stessa cartella del torrent che hai appena scaricato.

2.2.2 Verifica della validità delle ISO scaricate
Dopo aver scaricato un ISO, il passo successivo è verificarlo. Sono disponibili diversi metodi.

md5sum
Ogni ISO è accompagnato da un file md5sum corrispondente nella fonte, e dovresti controllare il suo md5sum 
rispetto a quello ufficiale. Se la tua copia è autentica, sarà identico al md5sum ufficiale. I seguenti passaggi ti 
permetteranno di verificare l'integrità dell'ISO scaricato su qualsiasi piattaforma OS.

• Windows
Gli utenti possono verificare più facilmente con il programma Rufus bootable USB maker; è inoltre 
disponibile uno strumento chiamato WinMD5FREE che può essere scaricato e utilizzato gratuitamente.

• Linux
In MX Linux, vai alla cartella in cui hai scaricato il file ISO e il file md5sum. Fai clic con il pulsante 
destro del mouse sul file md5sum > Verifica integrità dati. Se i numeri sono identici, verrà visualizzata 
una finestra di dialogo con il messaggio "<nome del file ISO>: OK". Puoi anche fare clic con il pulsante 
destro del mouse sul file ISO > Calcola md5sum e confrontarlo con un'altra fonte.
Nei casi in cui tale opzione non sia disponibile, apri un terminale nella posizione in cui hai scaricato l'ISO 
(i file manager Linux di solito hanno un'opzione "Apri terminale qui"), quindi digita:

md5sum filename.iso

https://mxlinux.org/download-links
http://en.wikipedia.org/wiki/BitTorrent
https://mxlinux.org/download-links
https://rufus.akeo.ie/
http://www.winmd5.com/


Assicurarsi di sostituire "filename" con il nome effettivo del file (digitare le prime due lettere, quindi 
premere Tab e verrà compilato automaticamente). Confrontare il numero ottenuto da questo calcolo con il 
file md5sum scaricato dal sito ufficiale. Se sono identici, la copia è identica alla versione ufficiale.

• Mac
Gli utenti Mac devono aprire una console/terminale e passare alla directory con i file ISO e md5sum. 
Quindi eseguire questo comando:

md5 -c nomefile.md5sum

Assicurati di sostituire nomefile con il nome effettivo del file.

sha256sum
A partire dalla versione MX-19, sha256 e sha512 garantiscono una maggiore sicurezza. Scaricare il file per 
verificare l'integrità dell'ISO.

• Windows: il metodo varia a seconda della versione. Effettuare una ricerca sul web con "windows 
<versione> controllare somma sha256".

• Linux: segui le istruzioni per md5sum riportate sopra, sostituendo "sha256sum" o 
"sha512sum" con "md5sum".

• Mac: apri una console, passa alla directory con i file ISO e sha256 ed esegui questo comando:

shasum -a 256 /percorso/del/file

Firma GPG
I file ISO di MX Linux da scaricare sono stati firmati dai loro sviluppatori. Questo metodo di sicurezza consente 
all'utente di essere sicuro che l'ISO sia ciò che dice di essere: un ISO ufficiale dello sviluppatore. Istruzioni 
dettagliate su come eseguire questo controllo di sicurezza sono disponibili nel Wiki tecnico MX/antiX.

2.2.3 Creare il LiveMedium

USB
È possibile creare facilmente una USB avviabile che funziona sulla maggior parte dei PC. MX Linux include lo 
strumento Live USB Maker (vedere la Sezione 3.2.12) per questo lavoro. Ventoy è il migliore per i principianti. 
Ventoy passo dopo passo Come fare.

• Windows - Ventoy, KDE Image Writer, USBImager, Rufus o balena Etcher.

• Linux - MX Live USB Maker, KDE Image Writer, balena Etcher, USBImager o Ventoy.

• Offriamo anche MX Live USB Maker qt come AppImage a 64 bit.

https://en.wikipedia.org/wiki/SHA-2
https://mxlinux.org/wiki/system/signed-iso-files
https://www.ventoy.net/
https://fullscale4me.com/Ventoy-How-To.pdf
https://www.ventoy.net/
https://download.kde.org/Attic/isoimagewriter/1.0.0/
https://gitlab.com/bztsrc/usbimager/
https://rufus.ie/
https://etcher.balena.io/
https://download.kde.org/Attic/isoimagewriter/1.0.0/
https://etcher.balena.io/
https://gitlab.com/bztsrc/usbimager/
https://www.ventoy.net/
https://mxlinux.org/blog/live-usb-maker-tool-now-available-as-an-appimage/


Figura 2-1: esempio di output del comando lsblk (due dischi rigidi ciascuno con due partizioni).

DVD
Masterizzare un ISO su un DVD è facile, purché si seguano alcune importanti linee guida.

• Non masterizzare l'ISO su un CD/DVD vuoto come se fosse un file di dati! Un ISO è un'immagine 
formattata e avviabile di un sistema operativo. È necessario selezionare Masterizza immagine disco o 
Masterizza ISO nel menu del programma di masterizzazione CD/DVD. Se lo si trascina semplicemente in 
un elenco di file e lo si masterizza come un file normale, non si otterrà un LiveMedium avviabile.

• Utilizza un DVD-R o DVD+R scrivibile di buona qualità con una capacità di 4,7 GB.

2.3 Pre-installazione

2.3.1 Da Windows
Se si intende installare MX Linux in sostituzione di Microsoft Windows®, è consigliabile consolidare ed eseguire il 
backup dei file e degli altri dati attualmente memorizzati in Windows. Anche se si prevede di eseguire il dual-boot, 
è opportuno eseguire un backup di questi dati in caso di problemi imprevisti durante l'installazione.

Backup dei file
Individuare tutti i file, come documenti di Office, immagini, video o musica:

• In genere, la maggior parte di questi si trova nella cartella Documenti.
• Cerca nel menu Applicazioni di Windows i vari tipi di file per assicurarti di averli trovati e salvati tutti.
• Alcuni utenti eseguono il backup dei propri font per riutilizzarli in MX Linux con applicazioni 

(come LibreOffice) in grado di eseguire documenti Windows.
• Una volta individuati tutti questi file, masterizzali su un CD o DVD oppure copiali su un dispositivo 

esterno, ad esempio una chiavetta USB.

Backup di e-mail, calendario e dati dei contatti
A seconda del programma di posta elettronica o calendario utilizzato, i dati relativi alla posta elettronica e al 
calendario potrebbero non essere salvati in una posizione o con un nome file evidenti. La maggior parte delle 
applicazioni di posta elettronica o di pianificazione (come Microsoft Outlook) è in grado di esportare questi dati in 
uno o più formati di file. Consultare la documentazione di aiuto dell'applicazione per scoprire come esportare i 
dati.

• Dati e-mail: il formato più sicuro per le e-mail è il testo semplice, poiché la maggior parte dei programmi 
di posta elettronica supporta questa funzione; assicurati di comprimere il file per garantire che tutti gli 
attributi del file vengano mantenuti. Se utilizzi Outlook Express, la tua posta viene archiviata in un file 
.dbx o .mbx, entrambi importabili in Thunderbird (se installato) su MX Linux. Utilizza la funzione di 
ricerca di Windows per individuare questo file e copiarlo nel tuo backup. La posta di Outlook deve essere 
prima importata in Outlook Express prima di essere esportata per l'uso in MX Linux.

• Dati del calendario: esporta i dati del calendario in formato iCalendar o vCalendar se desideri utilizzarli in 
MX Linux.

• Dati dei contatti: i formati più universali sono CSV (valori separati da virgola) o vCard.



Account e password
Sebbene di solito non siano memorizzati in file leggibili di cui è possibile eseguire il backup, è importante ricordarsi 
di prendere nota delle varie informazioni relative agli account che potresti aver salvato sul tuo computer. I tuoi dati 
di accesso automatico a siti web o servizi come il tuo ISP dovranno essere reinseriti, quindi assicurati di 
memorizzare su disco le informazioni necessarie per accedere nuovamente a questi servizi. Alcuni esempi:

• Informazioni di accesso all'ISP: avrete bisogno almeno del nome utente e della password del vostro 
provider di servizi Internet e del numero di telefono per la connessione se utilizzate una connessione dial-
up o ISDN. Altri dettagli potrebbero includere un numero di uscita, il tipo di composizione (a impulsi o a 
toni) e il tipo di autenticazione (per la connessione dial-up); indirizzo IP e subnet mask, server DNS, 
indirizzo IP del gateway, server DHCP, VPI/VCI, MTU, tipo di incapsulamento o impostazioni DHCP (per 
varie forme di banda larga). Se non sei sicuro di ciò che ti serve, consulta il tuo ISP.

• Rete wireless: avrete bisogno della vostra chiave di accesso o passphrase e del nome della rete.
• Password web: avrete bisogno delle vostre password per vari forum web, negozi online o altri siti 

protetti.
• Dettagli dell'account e-mail: avrete bisogno del vostro nome utente e password, nonché degli indirizzi o 

URL dei server di posta. Potrebbe anche essere necessario il tipo di autenticazione. Queste informazioni 
dovrebbero essere recuperabili dalla finestra di dialogo Impostazioni account del vostro client di posta 
elettronica.

• Messaggistica istantanea: il nome utente e la password per i tuoi account di messaggistica istantanea, la 
tua lista di contatti e, se necessario, le informazioni di connessione al server.

• Altro: se disponi di una connessione VPN (ad esempio con il tuo ufficio), un server proxy o altri 
servizi di rete configurati, assicurati di scoprire quali informazioni sono necessarie per riconfigurarli 
in caso di necessità.

Preferiti del browser
I preferiti del browser web (segnalibri) sono spesso trascurati durante il backup e di solito non sono memorizzati in 
un luogo ben visibile. La maggior parte dei browser contiene un'utilità per esportare i segnalibri in un file, che può 
poi essere importato nel browser web di vostra scelta in MX Linux. Controllate la sezione dei segnalibri nel 
browser che utilizzate per istruzioni specifiche aggiornate.

Licenze software
Molti programmi proprietari per Windows non possono essere installati senza una chiave di licenza o un codice CD. 
A meno che non siate determinati a eliminare Windows in modo permanente, assicuratevi di avere una chiave di 
licenza per qualsiasi programma che la richieda. Se decidete di reinstallare Windows (o se la configurazione dual-
boot non funziona correttamente), non potrete reinstallare questi programmi senza la chiave.
Se non riesci a trovare la licenza cartacea fornita con il prodotto, potresti riuscire a individuarla nel registro di 
Windows o utilizzare un keyfinder come ProduKey. Se tutto il resto fallisce, prova a contattare il produttore del 
computer per chiedere aiuto.

Esecuzione di programmi Windows
I programmi Windows non funzionano all'interno di un sistema operativo Linux e gli utenti MX Linux sono 
invitati a cercare equivalenti nativi (vedere la Sezione 4). Le applicazioni fondamentali per un utente possono 
funzionare con Wine (vedere la Sezione 6.1), anche se con alcune variazioni.

http://www.nirsoft.net/utils/product_cd_key_viewer.html


2.3.2 Computer Apple Intel
L'installazione di MX Linux su computer Apple con chip Intel può essere problematica, anche se la situazione varia 
in una certa misura a seconda dell'hardware specifico utilizzato. Si consiglia agli utenti interessati alla questione di 
cercare e consultare i materiali relativi a MX Linux e Debian. Numerosi utenti Apple lo hanno installato con 
successo, quindi dovresti avere fortuna se cerchi o pubblichi domande sul forum MX Linux.

Link
Installazione di Debian su computer Apple: forum 
Debian

2.3.3 Domande frequenti sul disco rigido

Dove devo installare MX Linux?
Prima di iniziare l'installazione, è necessario decidere dove installare MX Linux.

• L'intero disco rigido.
• Partizione esistente su un disco rigido.
• Nuova partizione su un disco rigido.

È possibile selezionare semplicemente una delle prime due opzioni durante l'installazione, ma la terza richiede la 
creazione di una nuova partizione. È possibile farlo durante l'installazione, ma si consiglia di farlo prima di avviare 
l'installazione. Su MX Linux, di solito si utilizza Gparted (Xfce/Fluxbox) o KDE Partition Manager (KDE) per 
creare e gestire graficamente le partizioni.

Un formato di installazione tradizionale per Linux ha diverse partizioni, una per root, una per home e una per 
Swap, come nella figura sottostante, e si dovrebbe iniziare con questo se si è nuovi a Linux. Potrebbe anche essere 
necessaria una partizione ESP formattata in fat-32 per macchine compatibili con UEFI. Sono possibili altre 
disposizioni delle partizioni, ad esempio alcuni utenti esperti combinano root e home, con una partizione separata 
per i dati.

Figura 2-2: GParted che mostra tre partizioni.

Cos'è la tabella di partizione del disco?

Sui PC più vecchi viene comunemente utilizzata la tabella delle partizioni di tipo MBR, nota anche come MSDOS. I 
PC più recenti (meno di 12 anni) utilizzano una tabella delle partizioni di tipo GPT. Tutti gli attuali strumenti di 
partizionamento del disco possono creare entrambi i tipi.

ALTRO: Manuale di GParted

https://wiki.debian.org/InstallingDebianOn/Apple
http://forums.debian.net/
http://forums.debian.net/
https://en.wikipedia.org/wiki/GUID_Partition_Table
http://gparted.org/display-doc.php?name=help-manual


Partizione di avvio BIOS
Tabella di partizione GUID (GPT)

Creare una nuova partizione con GParted

Partizionare un sistema multi-boot

Come posso modificare le partizioni?
Lo strumento molto utile per tali azioni, Disk Manager, è disponibile in MX Tools. Questa utility fornisce 
un'interfaccia grafica per montare, smontare e modificare rapidamente e facilmente alcune proprietà delle partizioni 
del disco. Le modifiche vengono automaticamente e immediatamente scritte in /etc/fstab e vengono quindi 
conservate per il prossimo avvio.

AIUTO: Dischi Gnome

Cosa sono quelle altre partizioni sulla mia installazione di Windows?
I computer domestici recenti con Windows vengono venduti con una partizione diagnostica e una partizione di 
ripristino, oltre a quella che contiene l'installazione del sistema operativo. Se in GParted vengono visualizzate più 
partizioni di cui non eri a conoscenza, probabilmente si tratta di quelle e dovrebbero essere lasciate così come sono.

Devo creare una Home separata?
Non è necessario creare una partizione home separata, poiché il programma di installazione creerà una directory 
/home all'interno di / (root). Tuttavia, avere una partizione separata semplifica gli aggiornamenti e protegge dai 
problemi causati dagli utenti che riempiono il disco con molte immagini, musica o dati video.

Quanto deve essere grande / (root)?

• (In Linux, il segno di barra '/' indica la partizione root.) La dimensione installata è leggermente inferiore a 
12 GB, quindi si consiglia un minimo di 16 GB per consentire le funzioni di base.

• Questa dimensione minima non consentirà di installare molti programmi e potrebbe causare difficoltà 
nell'eseguire aggiornamenti, eseguire VirtualBox, ecc. La dimensione consigliata per un uso normale è 
quindi di 25 GB.

• Se la directory Home (/home) si trova all'interno della directory Root (/) e si memorizzano molti file di 
grandi dimensioni, sarà necessaria una partizione root più grande.

• I giocatori che utilizzano giochi di grandi dimensioni (ad esempio Wesnoth) devono tenere presente che 
avranno bisogno di una partizione root più grande del solito per dati, immagini e file audio; 
un'alternativa è quella di utilizzare un'unità dati separata.

Devo creare uno spazio SWAP?
Lo SWAP è lo spazio su disco utilizzato per la memoria virtuale. È simile al file "Pagina" che Windows utilizza per 
la memoria virtuale. Per impostazione predefinita, MX Installer creerà un file di swap (vedere la Sezione 2.5.1). Se 
si intende ibernare (e non solo sospendere) il sistema, ecco i consigli per la dimensione dello spazio di swap:

• Per meno di 1 GB di memoria fisica (RAM), lo spazio di swap dovrebbe essere almeno pari alla quantità 
di RAM e al massimo il doppio della quantità di RAM, a seconda dello spazio disponibile sul disco 
rigido per il sistema.

https://en.wikipedia.org/wiki/BIOS_boot_partition
https://en.wikipedia.org/wiki/GUID_Partition_Table
https://www.youtube.com/watch?v=lf8eXhCKghg
https://www.youtube.com/watch?v=khg6_sdrOBQ
https://linuxhint.com/gnome_disk_utility/


• Per i sistemi con quantità maggiori di RAM fisica, lo spazio di swap dovrebbe essere almeno pari alla 
dimensione della memoria.

• Tecnicamente un sistema Linux può funzionare senza swap, anche se possono verificarsi alcuni problemi 
di prestazioni, errori e arresti anomali dei programmi anche su sistemi con grandi quantità di RAM fisica.

Cosa significano nomi come "sda" e "nvme"?
Prima di iniziare l'installazione, è fondamentale comprendere come i sistemi operativi Linux trattano i dischi rigidi e 
le loro partizioni.

• Nomi delle unità. A differenza di Windows, che assegna una lettera di unità a ciascuna delle partizioni del 
disco rigido, Linux assegna un nome breve a ciascuna unità disco rigido o altro dispositivo di 
archiviazione presente nel sistema. I nomi dei dispositivi spesso iniziano con sd più una singola lettera. Ad 
esempio, la prima unità del sistema sarà sda, la seconda sdb e così via. Esistono anche metodi più avanzati 
per denominare le unità, il più comune dei quali è l'UUID (Universally Unique IDentifier), utilizzato per 
assegnare un nome permanente che non verrà modificato dall'aggiunta o dalla rimozione di 
apparecchiature.

• Nomi delle partizioni. All'interno di ciascuna unità, ogni partizione è indicata con un numero aggiunto 
al nome del dispositivo. Quindi, ad esempio, sda1 sarebbe la prima partizione sul primo disco rigido, 
mentre sdb3 sarebbe la terza partizione sulla seconda unità.

• Partizioni estese. In origine, i dischi rigidi dei PC potevano avere solo quattro partizioni. Queste sono 
chiamate partizioni primarie in Linux e sono numerate da 1 a 4. È possibile aumentare il numero 
trasformando una delle partizioni primarie in una partizione estesa, quindi dividendola in partizioni logiche 
(limite 15) numerate da 5 in poi. Linux può essere installato in una partizione primaria o logica.

2.4 Prima occhiata

Accesso al supporto live

Nel caso in cui si desideri effettuare il logout e il login, installare nuovi pacchetti, ecc., ecco i nomi 
utente e le password:

• Utente normale

• nome: demo

• password: demo

• Superutente (amministratore)

• nome: root

• password: root

https://en.wikipedia.org/wiki/Universally_unique_identifier


2.4.1 Avvia il LiveMedium

Live CD/DVD
È sufficiente inserire il DVD nel lettore e riavviare il computer.

Live USB
Potrebbe essere necessario eseguire alcuni passaggi per avviare correttamente il computer utilizzando l'USB.

• Per avviare il sistema con l'unità USB, molti computer dispongono di tasti speciali che è possibile 
premere durante l'avvio per selezionare tale dispositivo. I tasti tipici (una tantum) del menu Boot Device 
sono Esc, uno dei tasti funzione, F12, F9, F2, Invio o il tasto Maiusc. Osservare attentamente la prima 
schermata che appare al riavvio per trovare il tasto corretto.

• In alternativa, potrebbe essere necessario accedere al BIOS per modificare l'ordine dei dispositivi di avvio:
• Avviare il computer e premere il tasto richiesto (ad esempio F2, F10 o Esc) all'inizio per accedere 

al BIOS.
• Fare clic sulla scheda Avvio (o spostarsi su di essa con le frecce).
• Identifica ed evidenzia il tuo dispositivo USB (di solito, USB HDD), quindi spostalo in cima 

all'elenco (o premi Invio, se il tuo sistema è impostato in questo modo). Salva ed esci.
• Se non sei sicuro o non ti senti a tuo agio nel modificare il BIOS, chiedi assistenza nei 

forum.
• Sui computer meno recenti senza supporto USB nel BIOS, è possibile utilizzare il LiveCD Plop 

Linux che caricherà i driver USB e presenterà un menu. Per ulteriori dettagli, consultare il sito web.
• Una volta che il sistema è impostato per riconoscere l'unità USB durante il processo di avvio, basta 

collegare l'unità e riavviare la macchina.

UEFI

 Problemi di avvio UEFI e alcune impostazioni da controllare!

Se sul computer è già installato Windows 8 o versioni successive, è necessario adottare misure speciali per gestire 
la presenza di (U)EFI e Secure Boot. Si consiglia alla maggior parte degli utenti di disattivare Secure Boot 
accedendo al BIOS all'avvio del computer. Purtroppo, la procedura esatta da seguire varia a seconda del 
produttore:

Nonostante le specifiche UEFI richiedano il supporto completo delle tabelle di partizione MBR, 
alcune implementazioni del firmware UEFI passano immediatamente all'avvio CSM basato su 
BIOS a seconda del tipo di tabella di partizione del disco di avvio, impedendo di fatto l'avvio 
UEFI dalle partizioni di sistema EFI su dischi con partizione MBR. (Wikipedia, "Unified Extensible 
Firmware Interface", consultato il 10/12/19)

L'avvio e l'installazione UEFI sono supportati su macchine a 32 bit e 64 bit, nonché su macchine a 64 bit con UEFI 
a 32 bit. Tuttavia, le implementazioni UEFI a 32 bit possono ancora essere problematiche. Per la risoluzione dei 
problemi, consultare il Wiki MX/antiX o chiedere sul forum MX Linux.

http://www.plop.at/
http://www.plop.at/
https://www.youtube.com/watch?v=cLFUZ6LtqiE
https://en.wikipedia.org/wiki/Unified_Extensible_Firmware_Interface
https://mxlinux.org/wiki/system/uefi


Lo schermo nero
A volte può capitare di trovarsi davanti a uno schermo nero vuoto con un cursore lampeggiante in un angolo. 
Ciò indica un errore nell'avvio di X, il sistema Windows utilizzato da Linux, e nella maggior parte dei casi è 
dovuto a problemi con il driver grafico in uso.

Soluzione: riavviare e selezionare le opzioni di avvio Safe Video o Failsafe nel menu; i dettagli su questi codici di 
avvio sono disponibili nel Wiki di MX Linux. Vedere la Sezione 3.3.2.

2.4.2 La schermata di apertura standard

Figura 2-3: Schermata di avvio di LiveMedium dell'ISO x64.

All'avvio di LiveMedium, verrà visualizzata una schermata simile a quella della figura sopra; la schermata installata 
ha un aspetto molto diverso. Nel menu principale potrebbero anche apparire voci personalizzate.

Voci del menu principale
Tabella 1: voci del menu nell'avvio Live

Voce Commento
MX-XX.XX 

(<DATA DI RILASCIO>)
Questa voce è selezionata per impostazione predefinita ed è il modo standard con 
cui la maggior parte degli utenti avvia il sistema Live. È sufficiente premere Invio 

per avviare il sistema.

Avvio da disco rigido Avvia qualsiasi sistema attualmente installato sul disco rigido del sistema.

Test della memoria Esegue un test per controllare la RAM. Se il test ha esito positivo, potrebbe 
comunque esserci un problema hardware o anche un problema con la RAM, ma se 

il test ha esito negativo, allora saprete che c'è qualcosa che non va.

Nella riga inferiore dello schermo vengono visualizzate una serie di voci verticali, sotto le quali si trova una riga di 
opzioni orizzontali; premere F1 quando si guarda quella schermata per i dettagli.

Opzioni

• F2 Lingua. Imposta la lingua per il bootloader e il sistema MX. Questa impostazione verrà 
trasferita automaticamente sul disco rigido durante l'installazione.

• F3 Fuso orario. Imposta il fuso orario per il sistema. Questo verrà automaticamente trasferito sul disco 
rigido durante l'installazione.

• F4 Opzioni. Opzioni per controllare e avviare il sistema Live. La maggior parte di queste opzioni non 
viene trasferita sul disco rigido durante l'installazione.

• F5 Persist. Opzioni per mantenere le modifiche al LiveUSB quando la macchina si spegne.
• F6 Opzioni video sicure/a prova di errore. Opzioni per macchine che non si avviano su X per impostazione predefinita.
• F7 Console. Imposta la risoluzione delle console virtuali. Potrebbe entrare in conflitto con Kernel Mode 

Setting. Può essere utile se si avvia l'installazione dalla riga di comando o se si sta cercando di eseguire il 
debug del processo di avvio iniziale. Questa opzione verrà trasferita durante l'installazione.

Altri cheat code per LiveUSB sono disponibili nel Wiki MX/antiX. I cheat code per l'avvio di un sistema installato 
sono diversi e sono disponibili nella stessa posizione.

ALTRO: Processo di avvio di Linux

https://mxlinux.org/wiki/system/boot-parameters
https://mxlinux.org/wiki/system/boot-parameters
https://mxlinux.org/wiki/system/boot-parameters
http://en.wikipedia.org/wiki/Linux_startup_process


2.4.3 UEFI

Una nota su Secure Boot
A partire da MX 25, Secure Boot è supportato sia per l'avvio live che per i sistemi installati, a condizione che 
l'utente utilizzi il kernel Debian standard, 6.12.XX per la serie MX 25 / Debian 13. Questi sono necessari 
perché utilizziamo i bootloader UEFI firmati da Debian.

Se l'utente passa a un altro kernel, come uno della serie Liquorix (MX Package Installer > Applicazioni popolari > 
Kernel), sarà necessario accedere al BIOS e disabilitare manualmente Secure Boot: utilizzare il menu di avvio di 
GRUB per selezionare "Configurazione del sistema" oppure premere il tasto designato dalla macchina all'avvio. 
L'intera catena UEFI deve essere sempre presente, altrimenti Secure Boot non riuscirà a caricare il sistema.

Figura 2-3: esempio di schermata di avvio LiveMedium di x64 quando viene rilevato UEFI.

Se l'utente utilizza un computer impostato per l'avvio UEFI, verrà visualizzata la schermata di avvio di UEFI Live 
con diverse opzioni.

• I menu vengono utilizzati per impostare le opzioni di avvio al posto dei menu dei tasti F.
• L'opzione in alto avvierà il sistema operativo con tutte le opzioni selezionate abilitate.
• Opzioni avanzate imposta elementi come Persistenza e altri presenti nei menu F di avvio legacy.
• Lingua - Tastiera - Fuso orario imposta queste opzioni.

https://www.mxlinux.org/wiki/system/uefi


Figura 2-4: Esempi di schermate per LiveMedium (a sinistra) e opzioni installate.

Se desideri che le opzioni di avvio siano persistenti, assicurati di selezionare un'opzione Salva.

2.4.4 Schermata di accesso

Figura 2-5: Sinistra: esempio di schermata di login Xfce A destra: esempio di schermata di login KDE/plasma.

A meno che non sia stato selezionato il login automatico, il processo di avvio installato termina con la schermata di 
login; in una sessione Live viene visualizzata solo l'immagine di sfondo, ma se si esce dal desktop si vedrà lo 
schermo completo. (Il layout dello schermo varia da una versione all'altra di MX). Su schermi di piccole 
dimensioni, l'immagine potrebbe apparire ingrandita; questa è una proprietà del display manager utilizzato da MX 
Linux.

È possibile vedere tre piccole icone all'estremità destra della barra superiore; da destra a sinistra:

• Il pulsante di accensione sul bordo contiene le opzioni per sospendere, riavviare e spegnere.
• Il pulsante della lingua consente all'utente di selezionare la tastiera appropriata per la schermata di 

accesso.
• Il pulsante degli ausili visivi che soddisfa le esigenze speciali di alcuni utenti.



Al centro della barra superiore in Xfce si trova il pulsante di sessione che consente di scegliere quale gestore 
desktop si desidera utilizzare: Xsession predefinita, sessione Xfce, insieme a qualsiasi altro che si possa aver 
installato (Sezione 6.3).

Se si desidera evitare di dover effettuare il login ogni volta che si avvia il sistema (sconsigliato per motivi di 
sicurezza), è possibile passare al "login automatico" nella scheda "Opzioni" di MX User Manager.

Le versioni MX KDE/plasma sono dotate di una schermata di accesso diversa, che contiene un selettore di 
sessione, una tastiera su schermo e funzioni di accensione/spegnimento/riavvio.

2.4.5 Desktop diversi

Figura 2-6a: Il desktop Xfce predefinito.

Figura 2-6b: il desktop KDE/plasma predefinito.

Il desktop è creato e gestito da Xfce o KDE/plasma, e ogni aspetto e disposizione sono stati pesantemente 
modificati per MX Linux. Notate le due caratteristiche dominanti al primo sguardo: il pannello e la schermata di 
benvenuto.

http://docs.xfce.org/xfce/getting-started


Pannello
Il desktop predefinito di MX Linux ha un unico pannello verticale sullo schermo. L'orientamento del pannello è 
facilmente modificabile in MX Tools > MX Tweak. Le caratteristiche comuni del pannello sono:

• Pulsante di accensione, apre una finestra di dialogo per il logout, il riavvio, lo spegnimento e la sospensione. (Xfce).
• Orologio in formato LCD: cliccare per visualizzare il calendario (Xfce)
• Taskswitcher/Pulsanti finestra: area in cui vengono visualizzate le applicazioni aperte.
• Browser Firefox.
• File Manager (Thunar).
• Area di notifica.

• Gestione aggiornamenti.
• Gestore degli appunti.
• Gestione rete.
• Gestione volume.
• Gestione alimentazione.
• Espulsore USB.

• Pager: visualizza gli spazi di lavoro disponibili (di default 2, clicca con il tasto destro per modificarli).
• Menu delle applicazioni ("Whisker" su Xfce).
• Altre applicazioni possono inserire icone nel pannello o nell'area di notifica quando sono in 

esecuzione. Per modificare le proprietà del pannello, vedere la Sezione 3.8.

Schermata di benvenuto

Figura 2-7: La schermata di benvenuto e la scheda Informazioni in MX Linux (installato).

Quando l'utente avvia il sistema per la prima volta, al centro dello schermo appare una schermata di benvenuto con 
due schede: "Benvenuto" offre una rapida panoramica e collegamenti di aiuto (Figura 2-7), mentre "Informazioni" 
mostra una sintesi delle informazioni sul sistema operativo, sul sistema in esecuzione, ecc. Quando si esegue Live, 
le password per gli utenti demo e root saranno visualizzate nella parte inferiore. Una volta chiusa, in esecuzione 
live o installata, la schermata di benvenuto può essere visualizzata nuovamente utilizzando il menu o MX Tools.

È molto importante che i nuovi utenti utilizzino con attenzione i pulsanti, poiché ciò consentirà di evitare 
confusione e sforzi inutili nell'uso futuro di MX-Linux. Se il tempo a disposizione è limitato, si consiglia di



di dare un'occhiata al documento FAQ collegato sul desktop, dove si trovano le risposte alle domande più comuni.

2.4.6 Suggerimenti e trucchi

Figura 2-8: Impostazioni è il punto di riferimento unico per apportare modifiche. I contenuti variano.

Alcune cose utili da sapere all'inizio:

• Se si riscontrano problemi con l'audio, la rete, ecc., consultare Configurazione (Sezione 3).
• Regola il volume generale dell'audio scorrendo con il cursore sull'icona dell'altoparlante o facendo clic 

con il pulsante destro del mouse sull'icona dell'altoparlante > Apri mixer.
• Imposta il sistema in base al layout della tua tastiera facendo clic su Menu Applicazioni > 

Impostazioni > Tastiera, scheda Layout e selezionando il modello dal menu a tendina. Qui puoi 
anche aggiungere tastiere in altre lingue.

• Regola le preferenze per il mouse o il touchpad facendo clic su Menu Applicazioni > Impostazioni > 
Mouse e touchpad.

• Il cestino può essere facilmente gestito nel File Manager, dove vedrai la sua icona nel riquadro di sinistra. 
Fai clic con il tasto destro per svuotarlo. Può anche essere aggiunto al desktop o al pannello. È importante 
rendersi conto che l'uso del tasto Canc, sia evidenziando e premendo il tasto Canc sia tramite una voce del 
menu contestuale, rimuove l'elemento in modo definitivo e non sarà recuperabile.

• Mantieni aggiornato il tuo sistema controllando che l'indicatore (riquadro contornato) degli 
aggiornamenti disponibili su MX Updater diventi verde. Vedi la Sezione 3.2 per i dettagli.

• Combinazioni di tasti utili (gestite in Tutte le impostazioni > Tastiera > Scorciatoie applicazioni).

Tabella 2: Combinazioni di tasti utili.
Tasti Azione

F4 Apre un terminale nella parte superiore dello schermo

Tasto Windows Apre il menu Applicazioni

Ctrl-Alt-Esc Trasforma il cursore in una x bianca per chiudere qualsiasi programma

Ctrl-Alt-Bksp Chiude la sessione (senza salvare!) e riporta alla schermata di login

Ctrl-Alt-Canc Blocca il desktop su Xfce. Logout su KDE/plasma

Ctrl-Alt-F1 Esce dalla sessione X e passa alla riga di comando; usa Ctrl-Alt-F7 per tornare indietro.



Alt-F1 Apre questo Manuale utente MX Linux (solo Xfce, menu su KDE/plasma)

Alt-F2 Apre una finestra di dialogo per eseguire un'applicazione

Alt-F3 Apre il Finder delle applicazioni che consente anche alcune modifiche alle voci di menu (solo Xfce)

Alt-F4 Chiude l'applicazione attiva; sul desktop, apre la finestra di dialogo di uscita.

PrtScr Apre Screenshooter per acquisire schermate

Applicazioni
Le applicazioni possono essere avviate in vari modi.

Figura 2-9: SINISTRA: menu Whisker di Xfce (il contenuto varia) DESTRA: menu KDE/plasma.

• Fare clic sull'icona del menu Applicazioni, nell'angolo in basso a sinistra.
• Si aprirà la categoria Preferiti e sarà possibile passare il mouse sulle altre categorie sul lato 

destro per visualizzarne il contenuto nel riquadro sinistro.
• Nella parte superiore è presente una potente casella di ricerca incrementale: basta digitare 

alcune lettere per trovare qualsiasi applicazione senza bisogno di conoscerne la categoria.
• Fare clic con il tasto destro del mouse sul desktop > Applicazioni.
• Se conosci il nome dell'applicazione, puoi utilizzare Application Finder, che può essere avviato facilmente 

in due modi.
• Fai clic con il pulsante destro del mouse sul desktop > Esegui comando ...
• Alt-F2
• Alt-F3 (Xfce) fa apparire una versione avanzata che consente di controllare comandi, 

posizioni ecc.

• Sul desktop KDE/plasma, basta iniziare a digitare.

• Utilizza una combinazione di tasti che hai definito per aprire un'applicazione preferita.

• Xfce: fai clic su Menu Applicazioni > Impostazioni, quindi su Tastiera, scheda Scorciatoie 
applicazioni.

• KDE/plasma - Scorciatoie globali nel menu.



Figura 2-10: Application Finder che identifica l'applicazione.

Informazioni di sistema
• Fare clic su Menu Applicazioni > Informazioni rapide sul sistema per inserire i risultati del comando

inxi -Fxrz negli appunti, pronti per essere incollati nei post del forum, nei file di testo, ecc.
• KDE/plasma - Fare clic su Menu Applicazioni > Sistema > Infocenter per una bella 

visualizzazione grafica,

Video e audio
• Per le impostazioni di base del monitor, clicca su Menu Applicazioni > Impostazioni > Schermo.
• La regolazione dell'audio viene effettuata tramite Menu Applicazioni > Multimedia > Controllo 

volume PulseAudio (o cliccando con il tasto destro sull'icona Gestione volume).

NOTA: per la risoluzione di problemi relativi a schermo, audio o Internet, consulta la Sezione 3: Configurazione.

Collegamenti.

• Documentazione Xfce
• Domande frequenti su Xfce
• KDE

2.4.7 Uscita
Quando apri il menu dell'applicazione, vedrai per impostazione predefinita quattro pulsanti di comando nell'angolo 
in alto a destra (modifica ciò che viene visualizzato facendo clic con il tasto destro sull'icona del menu > Proprietà, 
scheda Comandi). Da sinistra a destra:

• Tutte le impostazioni (All Settings).
• Blocca schermo.
• Cambia utente.
• Esci.

Figura 2-11: pulsanti di comando. In 

alto: Xfce.

A destra: KDE/plasma.

http://www.xfce.org/about
https://wiki.xfce.org/faq
https://userbase.kde.org/Welcome_to_KDE_UserBase


È importante uscire correttamente da MX Linux al termine della sessione, in modo che il sistema possa essere 
spento in modo sicuro. Tutti i programmi in esecuzione vengono prima avvisati che il sistema sta per essere 
spento, dando loro il tempo di salvare eventuali file in fase di modifica, uscire dai programmi di posta elettronica e 
di news, ecc. Se si spegne semplicemente l'alimentazione, si rischia di danneggiare il sistema operativo.

Opzioni simili ai pulsanti di comando sono disponibili nel menu KDE/plasma LEAVE.

Uscita - Permanente
Per uscire definitivamente da una sessione, selezionare una delle seguenti opzioni nella finestra di dialogo Logout:

• Esci. Selezionando questa opzione, tutte le attività in corso verranno interrotte e verrà chiesto se si 
desidera salvare il lavoro aperto, qualora i file non siano stati chiusi manualmente, quindi si tornerà alla 
schermata di accesso con il sistema ancora in esecuzione.

• Il comando nella parte inferiore dello schermo, "Salva sessione per accessi futuri", è selezionato 
per impostazione predefinita. La sua funzione è quella di salvare lo stato del desktop (applicazioni 
aperte e loro posizione) e ripristinarlo al successivo avvio. Se hai riscontrato problemi con il 
funzionamento del desktop, puoi deselezionare questa opzione per ottenere un nuovo avvio; se ciò 
non risolve il problema, fai clic su Tutte le impostazioni > Sessione e avvio, scheda Sessione, 
quindi premi il pulsante Cancella sessioni salvate.

• Riavvia o Spegni. Opzioni intuitive che modificano lo stato del sistema stesso. Disponibili anche 
tramite l'icona nell'angolo in alto a destra della barra superiore nella schermata di accesso.

SUGGERIMENTO: in caso di problemi, Ctrl-Alt-Bksp interromperà la sessione e tornerà alla schermata di 
accesso, ma i programmi e i processi aperti non verranno salvati.

Uscita - Temporanea
È possibile uscire temporaneamente dalla sessione in uno dei seguenti modi:

• Blocca schermo. Questa opzione è facilmente accessibile dall'icona nell'angolo in alto a destra del menu 
Applicazioni. Protegge il desktop da accessi non autorizzati mentre si è assenti, richiedendo la password 
utente per tornare alla sessione.

• Avviare una sessione parallela come utente diverso. Questa opzione è disponibile dal pulsante di 
comando Cambia utente nell'angolo in alto a destra del menu Applicazioni. Scegli questa opzione per 
lasciare la sessione corrente dove si trova e consentire l'avvio di una sessione per un utente diverso.

• Sospendi utilizzando il pulsante di accensione. Questa opzione è disponibile dalla finestra di dialogo 
Logout e mette il sistema in uno stato di basso consumo energetico. Le informazioni sulla configurazione 
del sistema, le applicazioni aperte e i file attivi vengono memorizzati nella memoria principale (RAM), 
mentre la maggior parte degli altri componenti del sistema vengono spenti. È molto comodo e in genere 
funziona molto bene in MX Linux. Richiamata dal pulsante di accensione, la sospensione funziona bene 
per molti utenti, anche se il suo successo varia a seconda della complessa interazione tra i componenti di 
un sistema: kernel, display manager, chip video, ecc. In caso di problemi, provare ad apportare le seguenti 
modifiche:

• Cambia il driver grafico, ad esempio da radeon ad AMDGPU (per le GPU più recenti) o da 
nouveau al driver proprietario Nvidia.

• Modifica le impostazioni in Menu Applicazioni > Impostazioni > Gestione alimentazione. Ad 
esempio: nella scheda Sistema, prova a deselezionare "Blocca schermo quando il sistema entra in 
modalità di sospensione".



• Fare clic su Menu Applicazioni > Impostazioni > Screensaver e regolare i valori di Gestione 
alimentazione display nella scheda Avanzate.

• Schede AGP: aggiungere l'opzione "NvAgp" "1" alla sezione Dispositivo di xorg.conf
• Sospendi chiudendo il coperchio del laptop. Alcune configurazioni hardware potrebbero avere 

problemi con questa opzione. L'azione alla chiusura del coperchio può essere regolata nella scheda 
Generale di Power Manager, dove "Spegni display" si è dimostrato affidabile nell'esperienza degli 
utenti MX.

• Ibernazione. L'opzione di ibernazione è stata rimossa dalla finestra di logout nelle versioni precedenti 
di MX Linux perché gli utenti riscontravano diversi problemi. Può essere abilitata in MX Tweak, 
scheda Altro. Consultare anche il Wiki di MX Linux/antiX.

2.5 Il processo di installazione

Video YouTube degli sviluppatori di MX Linux  
Installazione di base di MX Linux (con partizionamento)

 Installazione crittografata di MX Linux (con partizionamento)

 Configurazione della cartella Home

Per iniziare, avviare LiveMedium, quindi fare clic sull'icona MX Linux Installer nell'angolo in alto a sinistra. Se 
l'icona non è presente, fare clic su F4 e inserire: minstall-launcher (password root su LiveMedium: root).

Organizzazione generale della schermata:

• Il lato destro presenta le scelte dell'utente man mano che l'installazione procede
• Il lato sinistro fornisce chiarimenti sul contenuto del lato destro.
• Le impostazioni della tastiera consentono di modificare la tastiera per il processo di installazione.

Selezionare il tipo di installazione.
Fare clic su →Avanti per selezionare il tipo di installazione.

https://mxlinux.org/wiki/system/hibernate
https://youtu.be/jSYycsZPm_Q
https://youtu.be/jSYycsZPm_Q
https://youtu.be/tQjftZsoySg
https://www.youtube.com/watch?v=twDhZFBMgJ0


Procedere alla sezione desiderata:

2.5.1 "Installazione normale utilizzando l'intero disco" (subito dopo)

2.5.2 Personalizza il layout del disco

2.5.3 Sostituisci l'installazione esistente

NOTE:
1. Sui PC meno recenti (BIOS/Legacy) la selezione di un disco partizionato GPT genera un avviso:

Figura 2-12: Avviso sull'uso di GPT

2. Il disco selezionato verrà esaminato sommariamente per verificarne l'affidabilità tramite la tecnologia 
SMART (Self-Monitoring, Analysis, and Reporting Technology).

2.5.1 Installazione regolare utilizzando l'intero disco
Selezionare questa opzione se si intende utilizzare l'intero disco rigido per MX Linux. Questa potrebbe anche 
essere la scelta giusta se si intende utilizzare un secondo disco rigido, lasciando l'installazione di Windows sul 
primo disco. Il disco verrà ripartizionato e tutti i dati esistenti andranno persi.

• Se non sei sicuro di quale sia l'unità disco desiderata, utilizza i nomi visualizzati in GParted. Può essere 
qualsiasi disco desideri, purché superi i test di base.

• Per impostazione predefinita, verranno creati una partizione root e un file di swap. Se si sceglie di 
utilizzare la crittografia, verrà creata anche una partizione /boot.

• Se desideri una partizione home separata, puoi utilizzare il cursore per dividere lo spazio disponibile tra le 
partizioni root e home.

https://en.wikipedia.org/wiki/Self-Monitoring%2C_Analysis_and_Reporting_Technology


• Un messaggio di "Conferma dell'installazione" chiederà di confermare la scelta: "Formattare e utilizzare 
l'intero disco (sda) per MX Linux?

Figura 2-13: Cursore dello spazio root-home impostato su Root (60%) e Home (40%)

Il disco può essere suddiviso in partizioni separate per il sistema (root) e i dati utente (home) utilizzando il cursore.
La partizione root conterrà il sistema operativo e le applicazioni. La partizione home conterrà i dati di tutti gli 
utenti.

• Spostare il cursore verso destra per aumentare lo spazio per la root. Spostarlo verso sinistra per 
aumentare lo spazio per la home.

• Spostare il cursore completamente a destra se si desidera che sia la root che la home si trovino sulla 
stessa partizione. Mantenere la directory home in una partizione separata migliora l'affidabilità degli 
aggiornamenti del sistema operativo. Inoltre, facilita il backup e il ripristino.

2.5.2 Personalizza il layout del disco
• Se sul disco vengono rilevate partizioni esistenti, questa opzione sarà quella predefinita. Utilizza la 

schermata "Scegli partizioni" per selezionare le partizioni desiderate.



Figura 2-14: Scegli le partizioni.

Figura 2-15: Fare clic con il tasto destro del mouse su un disco per visualizzare le opzioni del modello.

• Aggiungi partizione: aggiunge una partizione al layout del disco selezionato.

• Nuovo layout: rimuove tutte le voci relative a quel disco per un nuovo layout.

• Reimposta layout: ripristina le voci del disco selezionato al layout corrente sul disco e ignora eventuali 
modifiche.

• Layout Builder: assiste nella creazione di un layout.

• Trascinare la barra verticale grigia per scorrere.

• Cliccando sul cursore, questo si sposta del 10% per ogni clic.

• I valori per lo swap, l'ibernazione e lo snapshot vengono 
calcolati dal sistema effettivo su cui è in esecuzione il 
programma di installazione.



Figura 2-16: Risultato delle scelte home e root in Layout Builder su un disco da 64 Gb.

Commenti

• Scegliere le partizioni. Specificare le partizioni root ed ESP che si desidera utilizzare. Selezionare l'uso 
che si desidera fare di una partizione nella colonna USE FOR. Se si imposta una partizione separata per 
la directory home, specificarla qui, altrimenti lasciare /home impostato su root.

• I PC di tipo UEFI (prodotti dopo il 2014) richiedono un MINIMO di 2 partizioni: /root ed ESP.
• Molti utenti preferiscono collocare la propria directory home in una partizione diversa da quella 

di / (root), in modo che qualsiasi problema con la partizione di installazione, o anche la sua 
sostituzione totale, lasci intatte tutte le impostazioni e i file individuali dell'utente.

• A meno che non si utilizzi la crittografia o si sappia cosa si sta facendo, lasciare /boot non 
impostato (su root).

• In questa schermata è disponibile una semplice gestione delle partizioni. Fare clic con il tasto 
destro del mouse su un disco per visualizzare i modelli di partizione. I modelli sono adatti solo 
per modifiche dell'intero disco, quindi se si desidera ridimensionare o ottimizzare il layout delle 
partizioni, utilizzare un gestore di partizioni esterno (ad esempio GParted) disponibile facendo 
clic sul pulsante Gestore partizioni nella parte inferiore destra della schermata Scegli partizioni.

• Partizione di sistema EFI - Se il sistema utilizza l'Extensible Firmware Interface (EFI), per l'avvio 
del sistema è necessaria una partizione denominata Partizione di sistema EFI (ESP). Questi 
sistemi non richiedono alcuna partizione contrassegnata come "Attiva", ma richiedono invece una 
partizione formattata con un file system FAT32 e "contrassegnata" come ESP.

• Preferenze
• Selezionare "Conserva dati" in /home se si sta eseguendo un aggiornamento e si dispone già di 

dati in una partizione o cartella esistente. Questa opzione non è generalmente consigliata a causa 
del rischio che le vecchie configurazioni non corrispondano alla nuova installazione, ma può 
essere utile in situazioni specifiche, ad esempio per riparare un'installazione.



• Selezionare "Controlla blocchi danneggiati" se si desidera eseguire una scansione alla ricerca di 
difetti fisici sul disco rigido durante la formattazione. Questa opzione è consigliata per gli utenti 
con unità più vecchie.

• Puoi modificare l'etichetta della partizione in cui desideri eseguire l'installazione (ad esempio, in 
"MX-23 Testing Installation") nella colonna Etichetta.

• Infine, è possibile selezionare facoltativamente il tipo di file system che si desidera utilizzare 
sul disco rigido. Se non si ha una preferenza particolare, in MX Linux è consigliato il file 
system ext4 predefinito.

• Puoi ottimizzare le impostazioni di crittografia con il pulsante "Impostazioni di crittografia 
avanzate" o semplicemente mantenere quelle predefinite.

Schermate di informazioni di configurazione aggiuntive
Mentre il sistema operativo MX Linux viene copiato sul disco rigido, è possibile fare clic sul pulsante "Avanti" per 
inserire ulteriori informazioni di configurazione.

Figura 2-17: Metodo di avvio e initramfs specifico dell'host.

Commenti
• Genera immagine initramfs specifica per l'host: tenta di creare un initramfs su misura per il 

dispositivo specifico piuttosto che un initramfs generico per tutti gli usi. Questa opzione è riservata 
agli esperti.

• La maggior parte degli utenti medi accetterà le impostazioni predefinite, che installeranno il bootloader 
all'inizio del disco. Questa è la posizione usuale e non causerà alcun danno.

• Gli utenti UEFI dovrebbero scegliere la partizione ESP che desiderano utilizzare. L'impostazione 
predefinita è la prima trovata.

Figura 2-18: Caratteristiche del file di swap



Abilita swap Zram - Lo swap Zram è un metodo per inserire lo spazio di swap nella RAM. Un dispositivo di 
swap compresso viene inserito nella RAM. Può essere utilizzato in combinazione con altre forme di swap o da 
solo.

2.5.3 Sostituisci installazione esistente
L'opzione Sostituisci installazione esistente tenterà di sostituire un'installazione esistente con la stessa 
configurazione del disco dell'installazione esistente. Le directory home vengono conservate.

Selezionare l'installazione da sostituire e fare clic su → Avanti.

Verificare che l'installazione abbia la partizione corretta elencata.



Genera initramfs specifico per l'host tenterà di creare un initramfs su misura per il dispositivo specifico piuttosto 
che un initramfs generico per tutti gli usi. Questa opzione è riservata agli esperti.

Figura 2-19: Nome della rete del computer.

Commenti

• Molti utenti scelgono un nome univoco per il proprio computer: laptop1, MyBox, StudyDesktop, 
UTRA, ecc. È anche possibile lasciare il nome predefinito così com'è.

• Se non si dispone di una rete di computer, è sufficiente fare clic su Avanti.
• Se non si intende ospitare cartelle di rete condivise sul proprio PC, è possibile disabilitare 

(deselezionare) Samba. Ciò non influirà sulla capacità del PC di accedere alle condivisioni Samba 
ospitate altrove sulla rete.



Figura 2-20: Impostazioni locali, fuso orario e servizi.

Commenti

• Le impostazioni predefinite saranno solitamente corrette, a condizione che si sia prestata attenzione a 
inserire eventuali eccezioni nella schermata di avvio di LiveMedium.

• Le impostazioni possono essere modificate nuovamente una volta avviato MX Linux.

Figura 2-21: Abilita/Disabilita servizi.

Commenti

• Questa schermata viene visualizzata solo se si è fatto clic su "Visualizza" nella schermata Impostazioni 
locali, fuso orario e servizi.

• I servizi sono applicazioni e funzioni associate al kernel che forniscono funzionalità per i processi di 
livello superiore. Se non si ha familiarità con un servizio, è consigliabile lasciarlo invariato.

• Queste applicazioni e funzioni richiedono tempo e memoria, quindi se siete preoccupati per la capacità del 
vostro computer, potete consultare questo elenco per individuare gli elementi che siete sicuri di non aver 
bisogno.

• Se in seguito desideri modificare o regolare i servizi di avvio, puoi utilizzare uno strumento MX 
chiamato MX Service Manager, installato di default.



Figura 2-22: Configurazione utente.

Commenti

• Il livello di sicurezza delle password scelte qui dipenderà in gran parte dalle impostazioni del computer 
stesso. Un computer desktop domestico è generalmente meno soggetto a intrusioni.

• Se si seleziona Autologin, sarà possibile bypassare la schermata di login e velocizzare il processo di avvio. 
Lo svantaggio di questa scelta è che chiunque abbia un qualche tipo di accesso al computer potrà accedere 
direttamente al proprio account. È possibile modificare in un secondo momento le preferenze di autologin 
nella scheda "Opzioni" di MX User Manager.

• Puoi trasferire tutte le modifiche apportate al desktop Live all'installazione su disco rigido 
selezionando l'ultima casella. Una piccola quantità di informazioni critiche (ad esempio, il nome del 
tuo punto di accesso wireless) verrà tradotta automaticamente.

• Se non si imposta una password di root, le autenticazioni GUI saranno impostate sulla password utente.

2.5.4 Installazione completata
• Al termine della copia del sistema e delle operazioni di configurazione, verrà visualizzata la schermata 

"Installazione completata" e sarai pronto per iniziare!

• Se non si desidera riavviare il sistema al termine dell'installazione, deselezionare l'opzione "Riavvia 
automaticamente il sistema alla chiusura del programma di installazione" prima di fare clic su "Fine".

2.6 Risoluzione dei problemi 

2.6.1 Nessun sistema operativo trovato
Quando si riavvia il computer dopo l'installazione, a volte capita che il computer segnali che non è stato trovato 
alcun sistema operativo o disco di avvio. Potrebbe anche non visualizzare un altro sistema operativo installato, 
come Windows. Di solito, questi problemi indicano che GRUB non è stato installato correttamente, ma è facile da 
correggere.

• Se si avvia con UEFI, assicurarsi che Secure Boot sia disattivato nelle impostazioni BIOS/UEFI del 
sistema.



• Se è possibile avviare almeno una partizione, aprire un terminale root ed eseguire questo 
comando:
update-grub

• Altrimenti, procedi con MX Boot Repair.
• Avvia il LiveMedium.
• Avvia MX Tools > Boot Repair.
• Assicurati che "Reinstall GRUB Bootloader" sia selezionato, quindi fai clic su OK.
• Se il problema persiste, è possibile che il disco rigido sia difettoso. Di solito, all'avvio 

dell'installazione viene visualizzata una schermata di avviso SMART al riguardo.

2.6.2 Dati o altre partizioni non accessibili. 
Le partizioni e le unità diverse da quella designata come di avvio potrebbero non essere avviate o richiedere 
l'accesso come root dopo l'installazione. Esistono diversi modi per modificare questa impostazione.

• Per le unità interne, utilizzare Start > Impostazioni > MX Tweak, scheda Altro: selezionare "Abilita il 
montaggio delle unità interne da parte di utenti non root".

• GUI. Utilizza Disk Manager per selezionare tutto ciò che desideri montare all'avvio e salva; al riavvio 
dovrebbe essere montato e potrai accedervi nel file manager (Thunar).

• CLI. Aprire un file manager e navigare fino al file /etc/fstab; utilizzare l'opzione del tasto destro del 
mouse per aprirlo come root in un editor di testo. Cercare la riga contenente la partizione o l'unità a cui si 
desidera accedere (potrebbe essere necessario digitare blkid in un terminale per identificare l'UUID). 
Modificarla seguendo questo esempio per una partizione di dati.

UUID=9501<snip>912 /data ext4 users 0 2
Questa voce farà sì che la partizione venga montata automaticamente all'avvio e ti consentirà anche di montarla e 
smontarla come utente normale. Questa voce farà anche sì che il file system venga controllato periodicamente 
all'avvio. Se non desideri che venga montato automaticamente all'avvio, modifica il campo delle opzioni da "user" 
a "user,noauto".

• Se non si desidera che venga controllato regolarmente, modificare il "2" finale in "0". Poiché si dispone 
di un file system ext4, si consiglia di abilitare il controllo automatico.

• Se l'elemento è montato ma non viene visualizzato nel file manager, aggiungi un ulteriore 
"comment=x-gvfs-show" alla riga nel tuo file fstab, che forzerà la visualizzazione del montaggio. 
Nell'esempio sopra, la modifica sarebbe simile a questa:

UUID=9501<snip>912 /data ext4 users,comment=x-gvfs-show 0 2 NOTA: nessuna di 
queste procedure modificherà i permessi Linux, che vengono applicati a livello di cartella e file. Vedere la 
Sezione 7.3.

2.6.3 Problemi con il portachiavi
Un portachiavi predefinito dovrebbe essere creato automaticamente e l'utente non dovrà fare nulla. Se si utilizza il 
login automatico, quando un'applicazione accede al portachiavi, all'utente verrà chiesto di inserire una nuova 
password per creare un nuovo portachiavi predefinito. Per i dettagli, consultare il Wiki tecnico MX/Antix.

Si noti che se agenti malintenzionati ottengono l'accesso fisico al computer, l'uso di una password vuota renderà 
più facile l'intrusione. Ma sembra abbastanza chiaro che se un agente malintenzionato ha accesso fisico al 
computer, è comunque tutto finito.

https://mxlinux.org/wiki/system/gnome-keyring


2.6.4 Blocco
Se MX Linux si blocca durante l'installazione, di solito è dovuto a un problema con l'hardware del computer 
difettoso o a un DVD danneggiato. Se avete stabilito che il DVD non è il problema, potrebbe essere dovuto a una 
RAM difettosa, a un disco rigido difettoso o ad altro hardware difettoso o incompatibile.

• Aggiungi una delle opzioni di avvio utilizzando F4 all'avvio o consultando il Wiki MX/antiX. Il 
problema più comune deriva dal driver grafico.

• Il tuo lettore DVD potrebbe avere dei problemi. Se il tuo sistema lo supporta, crea una chiavetta 
USB avviabile MX Linux e installa da quella.

• I sistemi spesso si bloccano a causa del surriscaldamento. Apri il case del computer e assicurati che tutte 
le ventole del sistema funzionino quando è acceso. Se il tuo BIOS lo supporta, controlla le temperature 
della CPU e della scheda madre (inserisci i sensori in un terminale root, se possibile) e confrontale con 
le specifiche di temperatura del tuo sistema.

Spegni il computer e rimuovi tutto l'hardware non essenziale, quindi riprova a eseguire l'installazione. L'hardware 
non essenziale può includere dispositivi USB, seriali e con porta parallela; schede di espansione rimovibili PCI, 
AGP, PCIE, slot modem o ISA (esclusa la scheda video, se non si dispone di una scheda video integrata); 
dispositivi SCSI (a meno che non si stia installando su o da uno di essi); dispositivi IDE o SATA su cui non si sta 
installando o da cui non si sta installando; joystick, cavi MIDI, cavi audio e qualsiasi altro dispositivo multimediale 
esterno.

https://mxlinux.org/wiki/system/boot-parameters


 VIDEO: Cose da fare dopo l'installazione di MX Linux

Questa sezione contiene le istruzioni di configurazione necessarie per far funzionare correttamente il sistema dopo 
una nuova installazione di MX Linux e una breve guida alla personalizzazione.

3.1 Periferiche 

3.1.1 Smartphone (Samsung, Google, LG, ecc.)

 VIDEO: Smartphone e MX-16 (Samsung Galaxy S5 e iPhone 6s)

Android

Condivisione di file con un dispositivo Android.

1. È possibile accedere ai telefoni Android tramite un browser web installando un'app dal Play Store di Google, 
come AirDroid.

2. Possono anche essere montati direttamente.

• La maggior parte dei telefoni con Android 4.xx e versioni successive include la funzionalità Media 
Transfer Protocol (MTP) ed è possibile utilizzare la seguente procedura.

• Collegare il telefono e toccare il collegamento che appare per assicurarsi che l'opzione di 
archiviazione sia impostata su "scambio file" o qualcosa di simile.

• Aprire File Manager. Quando il dispositivo mostra il nome del telefono (o: Archiviazione), 
fare clic su di esso. Se non lo si vede, riavviare il telefono. Il telefono potrebbe quindi 
visualizzare una finestra di dialogo che chiede se si desidera consentire l'accesso.

• Passa alla posizione che stai cercando.

• Alcuni file possono essere visualizzati e gestiti con le applicazioni MX Linux: clicca su Dispositivo 
nel riquadro di sinistra, quindi fai doppio clic su Unità CD, se necessario.

• KDE Connect è un'altra opzione per condividere file con un telefono Android, disponibile in KDE 
o installabile in Xfce dall'MX Package Installer. Se non è già installato sul tuo telefono Android, è 
disponibile sul Google Play Store.

3 Configurazione

https://youtu.be/aESEb8lTvz4
https://www.youtube.com/watch?v=YoMRRXP3Pic
http://web.airdroid.com/


• Per impostazione predefinita, il firewall bloccherà la connessione dal dispositivo Android. Dovrà 
essere disabilitato o dovrà essere impostata una regola del firewall per consentire la connessione. 
Vedere la Sezione 4.5.1.

Figura 3-1a: Thunar connesso a un telefono Android Samsung.

Figura 3-1b: Dolphin connesso a un telefono Android Samsung.

Apple iPhone
MX iDevice Mounter fornisce l'accesso tramite Thunar ai dispositivi meno recenti. I telefoni più recenti non sono 
più accessibili con questo processo.



3.1.2 Stampante
MX Linux rileverà automaticamente la stampante e selezionerà il driver 
appropriato. Il database dei driver di supporto per stampanti OpenPrinting 
(PPD) è incluso con molti altri forniti da Debian.

Le stampanti che supportano AirPrint, IPP Everywhere e IPP-over-USB 
(prodotte dal 2010) vengono rilevate e configurate automaticamente.

Impostazioni di stampa è una semplice alternativa all'applicazione web 
CUPS che funziona bene nella maggior parte dei casi.

Figura 3-2: Schermata dell'app Impostazioni di stampa.

Configurazione delle stampanti

MX Linux offre due modi per aggiungere e configurare nuove stampanti e gestire quelle esistenti.

1) Impostazioni di stampa:

• Fare clic sul menu Start > Sistema > Impostazioni di stampa.

• Fare clic sul pulsante "+Aggiungi".

L'applicazione cercherà le stampanti collegate tramite USB e le stampanti di rete connesse al web, elencando i 
primi risultati consigliati per tutte le stampanti trovate. Fare clic per evidenziare la scelta, quindi utilizzare la 
finestra di dialogo "Descrivi stampante" che appare per apportare le modifiche necessarie.

2) OpenPrinting CUPS - applicazione web

A volte i problemi relativi alla stampante possono essere risolti utilizzando l'applicazione web CUPS, digitando 
http://localhost:631/admin nel browser web.

Nella parte superiore sono presenti diversi menu di azione. Le attività più comuni si trovano in "Amministrazione" 
per gestire le stampanti esistenti/rilevate: clicca sul pulsante "Aggiungi stampante" e segui le istruzioni.

AIUTO: Panoramica di CUPS

3) Stampanti HP: il pacchetto aggiuntivo "HP Printing" (hplip) deve essere installato utilizzando MX Package 
Installer > Applicazioni popolari. Verrà installato un Toolbox nel menu Start e un'applet nel SysTray. Fare clic 
sull'applet (o su hp-setup nel terminale) per configurare la stampante una sola volta.

Se la stampante è molto recente o ha più di 8 anni, potrebbe essere necessario scaricare l'app direttamente dalla 
pagina web HPLIP. Assicurarsi di seguire le istruzioni fornite. Assicurarsi di selezionare MX Linux, non Debian, 
come opzione di download.

https://openprinting.github.io/
http://localhost:631/admin
http://localhost:631/admin
https://openprinting.github.io/cups/doc/overview.html
https://developers.hp.com/hp-linux-imaging-and-printing
https://developers.hp.com/hp-linux-imaging-and-printing


Stampante di rete

La condivisione della stampante Samba su MX Linux consente di stampare in rete su stampanti di altri 
computer (Windows, Mac, Linux) e dispositivi collegati in rete che offrono servizi Samba (router, 
RasberryPi, ecc.).

Per una stampante locale esistente: utilizzare l'app Impostazioni di stampa. Fare clic con il tasto destro del mouse sulla stampante e 
selezionare
"Condivisa". Fai clic con il pulsante destro del mouse su Proprietà > Stampa pagina di prova per assicurarti che la 
connessione e il driver funzionino correttamente.

Per una nuova stampante:

Questa sezione richiede che AirPrint o IPP Everywhere siano abilitati sulla stampante.

• Fare clic sul menu Start > Sistema > Impostazioni di stampa.

• Fare clic sul pulsante "+Aggiungi". L'app cercherà le stampanti di rete collegate tramite USB e Wi-Fi, 
mostrando i suggerimenti per le stampanti trovate.

• Fare clic su Stampante di rete per espandere l'elenco. Immediatamente sotto l'etichetta sarà presente un 
elenco delle stampanti rilevate.

• Fare clic per selezionare una stampante, quindi fare clic su Avanti.

Nota: potrebbero essere elencate più stampanti. Fare clic su ciascuna di esse ed esaminare la casella 
Connessione per selezionare la propria preferenza.

• Fai clic su Avanti. L'app cercherà quindi un driver.

• Verrà visualizzata una descrizione riassuntiva. Fai clic su Applica.

• Esegui un test facendo clic su "Stampa pagina di prova". Se l'operazione ha esito positivo, fai clic 
su OK per accettare la nuova configurazione della stampante.

Risoluzione dei problemi della stampante

Nell'applicazione Impostazioni di stampa è integrata un'utilità di risoluzione dei problemi. Fare clic su "Aiuto" > 
"Risoluzione dei problemi", "→ Avanti". In caso di problemi, si consiglia di passare al sito CUPS in un browser 
come descritto in precedenza. Le stampanti condivise (evidenziate di seguito) vengono visualizzate in questa utilità 
come: Marca_Modello_NomePC

Figura 3.3: Il nome host del PC sopra è mx23xfce



Se la stampante smette improvvisamente di stampare, verificare che l'opzione "abilitato" sia ancora selezionata 
facendo clic su menu Start > Sistema > Impostazioni di stampa. In caso contrario, fare clic con il tasto destro 
del mouse sulla stampante e selezionare nuovamente l'opzione "abilita".

Se la stampante non viene riconosciuta o non funziona correttamente, verificare che la porta firewall CUPS UDP 
631 sia aperta. Per ulteriore assistenza, consultare la sezione 4.5.1 di questo manuale e i link riportati di seguito.

Link

• MX/antiX Wiki – Come installare un driver di stampa. (27 giugno 2022)

• Wiki Debian. - Stampa di sistema, una panoramica di base sul sistema di stampa CUPS. (2025)

3.1.3 Scanner

Gli scanner sono supportati in Linux da SANE (Scanner Access Now Easy), che fornisce un accesso 
standardizzato a qualsiasi hardware di scansione (scanner piano, scanner portatile, videocamere e fotocamere, 
frame grabber, ecc.

Passaggi di base

È possibile gestire lo scanner in MX Linux con l'applicazione predefinita Document Scan. È molto facile da usare 
e consente di esportare in PDF con un solo clic.

Risoluzione dei problemi

• Alcuni scanner richiedono un front-end diverso (interfaccia di sistema per lo scanner): è possibile 
installare gscan2pdf, fare clic su Modifica > Preferenze e utilizzare il menu a discesa per selezionare un 
front-end (ad esempio, scanimage).

• Molte stampanti multifunzione hanno uno scanner integrato che richiede l'installazione di un driver.

• Assicurarsi che lo scanner sia elencato come supportato da SANE in questo elenco.

• Se hai problemi con uno scanner più vecchio (>7 anni), controlla il Wiki MX/antiX.

3.1.4 Webcam

Probabilmente la tua webcam funzionerà in MX Linux; puoi provarla avviando il menu Start > Multimedia > 
webcamoid e utilizzando le impostazioni nella parte inferiore della finestra per regolarla in base al tuo sistema. Se 
non sembra funzionare, c'è una recente discussione dettagliata sui driver e la configurazione nell'Arch Wiki. 
L'audio della webcam (ad esempio Skype > Sezione 4.1) a volte è più complicato.

https://mxlinux.org/wiki/hardware/printer-drivers
https://wiki.debian.org/SystemPrinting
http://www.sane-project.org/sane-mfgs.html
https://mxlinux.org/wiki/hardware/scanner
https://wiki.archlinux.org/index.php/Webcam


3.1.5 Archiviazione

Unità disco (come SCSI, SATA e SSD), fotocamere, unità USB, telefoni, ecc. – sono tutte diverse forme di 
archiviazione.

Montaggio dell'archiviazione

Per impostazione predefinita, i dispositivi di archiviazione collegati al sistema vengono montati automaticamente nella directory
/media/<nome utente>/ e quindi si apre una finestra del browser dei file per ciascuno di essi (questo comportamento 
può essere modificato in Thunar: Modifica > Preferenze o KDE: Impostazioni di sistema > Archiviazione 
rimovibile).

Non tutti i dispositivi di archiviazione, in particolare le unità interne aggiuntive e le partizioni, vengono montati 
automaticamente quando vengono collegati a un sistema e potrebbero richiedere l'accesso come root. Le opzioni 
possono essere modificate con MX Tweak > Altro; e Impostazioni > Unità rimovibili e supporti.

Autorizzazioni di archiviazione

L'estensione dell'accesso dell'utente all'archiviazione dipenderà dal file system che contiene. La maggior parte dei 
dispositivi di archiviazione esterni commerciali, in particolare i dischi rigidi, sono preformattati come fat32 o ntfs.

File system di archiviazione Autorizzazioni
FAT32 Nessuna.

NTFS Per impostazione predefinita, le autorizzazioni/proprietà vengono concesse 
all'utente che monta il dispositivo.

ext2, ext4 e la maggior parte 
dei file system Linux

Montati per impostazione predefinita con proprietà impostata su Root. 
Regolazione dei permessi: vedere la Sezione 7.3.

È possibile modificare la necessità di essere Root per accedere ai dispositivi di archiviazione interni con file 
system Linux utilizzando MX Tweak > scheda Altro (Sezione 3.2).

Unità a stato solido

I computer più recenti possono avere un SSD interno: un'unità a stato solido che non ha componenti mobili. Queste 
unità tendono ad accumulare blocchi di dati che non sono più considerati in uso, rallentando questa unità molto 
veloce. Per evitare che ciò accada, MX Linux esegue un'operazione TRIM con cadenza settimanale che è possibile 
visualizzare aprendo il file /var/log/trim.log.

3.1.6 Dispositivi Bluetooth

I dispositivi Bluetooth esterni come tastiera, altoparlante, mouse, ecc. normalmente funzionano automaticamente. 
In caso contrario, seguire questi passaggi:

• Xfce: clicca sul menu Start > Impostazioni > Gestione Bluetooth (oppure: clicca con il tasto destro 
sull'icona Bluetooth nell'area di notifica > Dispositivi).

• KDE: clicca sul menu Start > Impostazioni > Impostazioni di sistema > Hardware > Bluetooth

https://en.wikipedia.org/wiki/Solid-state_drive
https://en.wikipedia.org/wiki/Trim_(computing)


• Verificare che l'adattatore sia abilitato e visibile facendo clic su menu Start > Impostazioni > Adattatori 
Bluetooth.

• Assicurati che il dispositivo desiderato sia visibile; in Gestione Bluetooth clicca su Adattatore > 
Preferenze e seleziona l'impostazione di visibilità.

• Se il dispositivo desiderato è nella finestra Dispositivi, selezionalo e poi clicca su Configurazione.

• In caso contrario, clicca sul pulsante Cerca e premi Connetti sulla riga del dispositivo per avviare 
l'accoppiamento.

• Per un telefono, probabilmente dovrai confermare il numero di accoppiamento sia sul telefono che sul 
desktop.

• Dopo l'accoppiamento con il dispositivo Bluetooth, la finestra di dialogo Configurazione richiede di 
confermare il tipo di configurazione Bluetooth da associare ad esso.

• Al termine del processo di configurazione, il dispositivo dovrebbe funzionare.

Trasferimento di oggetti

Per poter trasferire oggetti (documenti, foto, ecc.) tra un desktop MX Linux e un dispositivo come un telefono 
utilizzando il Bluetooth:

• Installare obex-data-server dai repository. In rari casi, il pacchetto potrebbe bloccare 
l'utilizzo del mouse o della tastiera Bluetooth.

• Verificare che il telefono e il desktop abbiano entrambi il Bluetooth abilitato e siano visibili.

• Inviare il file.

• Dal desktop MX Linux: fare clic con il tasto destro sull'icona Bluetooth nell'area di notifica > 
Invia file (oppure utilizzare Bluetooth Manager)

• Dal telefono: seguire le istruzioni appropriate per il proprio dispositivo.

• Tieni d'occhio il dispositivo ricevente per confermare l'accettazione dell'oggetto trasferito.

• Si noti che questo scambio di oggetti può essere piuttosto incerto.

È anche possibile utilizzare hcitool dalla riga di comando.

Collegamenti

• Risoluzione dei problemi di Blueman

http://www.linuxjournal.com/content/bluetooth-hacks
https://github.com/blueman-project/blueman/wiki/Troubleshooting


• Arch Wiki

• Wiki Debian sull'accoppiamento

3.1.7 Tavolette grafiche
Le tavolette grafiche Wacom vengono rilevate automaticamente e sono supportate in modo nativo su Debian. 
Maggiori dettagli sono disponibili nel Wiki MX/antiX.

Link

• Il progetto Linux Wacom

3.2 Strumenti MX di base 

Sono state sviluppate numerose applicazioni specifiche per MX Linux, adattate o trasferite da antiX, oppure 
adattate da fonti esterne per semplificare all'utente l'esecuzione di operazioni importanti che spesso comportano 
passaggi poco intuitivi.

Figura 3-3: Dashboard MX Tools (Xfce installato). Le dashboard Live e KDE sono leggermente diverse.

3.2.1 MX Updater

Questa versatile applet (solo Xfce, KDE utilizza Discover) si trova nell'area di notifica dove ti avvisa quando sono 
disponibili dei pacchetti. Se non appare, avvia MX Updater per aggiornare.

https://wiki.archlinux.org/index.php/Blueman
https://wiki.debian.org/BluetoothUser#Pairing
https://www.wacom.com/en-us/
https://mxlinux.org/wiki/hardware/wacom/
https://linuxwacom.github.io/
https://userbase.kde.org/Discover


Figura 3-4: Schermata di visualizzazione e aggiornamento da MX Updater.

Notare la scelta tra aggiornamento e dist-upgrade.

• full-upgrade (dist-upgrade): l'azione predefinita. Aggiornerà tutti i pacchetti che hanno aggiornamenti, 
anche quelli in cui un aggiornamento comporterà la rimozione automatica di altri pacchetti esistenti o 
causerà l'aggiunta di nuovi pacchetti alla vostra installazione, al fine di risolvere tutte le dipendenze.

• upgrade: consigliato solo per utenti più esperti. Aggiornerà solo i pacchetti aggiornabili che non 
comportano la rimozione o l'installazione di altri pacchetti. L'utilizzo di questa opzione significa che 
alcuni pacchetti aggiornabili potrebbero rimanere "bloccati" sul sistema.

• Nelle Preferenze è disponibile un'opzione per l'"aggiornamento automatico" che non aggiunge nuovi 
pacchetti né rimuove quelli esistenti.

AIUTO: qui.

3.2.2 Configurazione Bash

Bash (il linguaggio shell predefinito in MX Linux) può ora essere configurato con questa piccola applicazione. 
Consente agli utenti avanzati di apportare modifiche agli alias e ai temi del prompt del terminale nel file bashrc 
nascosto dell'utente.

Figura 3-5: la scheda per aggiungere o modificare un alias.

Aiuto: qui.

https://mxlinux.org/wiki/help-files/help-mx-apt-notifier
https://mxlinux.org/wiki/help-files/help-bash-config/


3.2.3 Opzioni di avvio

Figura 3-6: schermata principale che mostra varie opzioni.

Opzioni di avvio consente agli utenti di gestire in modo semplice e veloce i parametri del kernel, i temi GRUB, le 
immagini Splash e altri elementi. Appare solo quando il PC viene avviato in modalità UEFI.

Figura 3-7: Esempio di gestione delle opzioni UEFI

AIUTO: qui.

3.2.4 Riparazione avvio

Il bootloader è il primo programma software ad essere eseguito ed è responsabile del caricamento e del 
trasferimento del controllo al kernel. A volte capita che il bootloader su un'installazione convenzionale (GRUB2) 
diventi disfunzionale, e questo strumento consente di ripristinare il bootloader a uno stato funzionale da un avvio 
LIVE.

https://mxlinux.org/wiki/help-files/help-mx-boot-options


Figura 3-8: Schermata principale di Riparazione avvio, con l'opzione più comune selezionata.

AIUTO: qui.

3.2.5 Sistema di regolazione della luminosità

Questo strumento inserisce un'icona nel vassoio di sistema che visualizza una piccola applicazione con la quale 
l'utente può regolare la luminosità dello schermo.

Figura 3-9: pronto per regolare la luminosità.

3.2.6 Chroot Rescue Scan

Questo strumento consente di accedere a un sistema anche se il suo file di base (initrd.img) è danneggiato.

Figura 3-10: risultati della scansione per i sistemi Linux.

https://mxlinux.org/wiki/help-files/help-mx-boot-repair


AIUTO: qui.

3.2.7 Correzione delle chiavi GPG

Se si tenta di installare pacchetti non autenticati, si verificherà un errore apt: Impossibile verificare le seguenti 
firme perché la chiave pubblica non è disponibile. Questa utile utility consente di evitare di eseguire i numerosi 
passaggi necessari per ottenere tale chiave.

Figura 3-11: risultati della verifica delle chiavi pubbliche del repository con Ripara chiavi GPG.

AIUTO: qui.

3.2.8 Pulizia MX

Figura 3-12: Pulizia pronta per essere eseguita.

https://mxlinux.org/wiki/system/chroot-rescue-scan/
https://mxlinux.org/wiki/help-files/help-mx-check-apt-gpg


Questa piccola e pratica applicazione offre un modo semplice e sicuro per rimuovere i file non necessari e 
ripristinare lo spazio. La scheda Strumenti consente di rimuovere i kernel o i driver WiFi più vecchi e inutilizzati, 
accelerando il processo di aggiornamento.

AIUTO: qui.

3.2.9 MX Conky
L'applicazione MX Conky è stata completamente rielaborata per MX-25 per fornire gestione, personalizzazione e 
modifiche dei colori in un unico posto. Consultare il file di aiuto dettagliato per orientarsi.

Figura 3-13: Schermata principale.

AIUTO: qui.

3.2.10 Job Scheduler

Questa pratica app presenta un'interfaccia grafica per l'app da riga di comando crontab, facilitando la configurazione 
dei lavori.

Figura 3-14: Pianificatore di attività.

AIUTO: file locale: /usr/share/job-scheduler/locale/

https://mxlinux.org/wiki/help-files/help-mx-cleanup/
https://mxlinux.org/wiki/help-files/help-mx-conky
https://mxlinux.org/wiki/system/crontab/


3.2.11 Live-USB Maker

Questo semplice strumento consente di creare rapidamente una Live-USB partendo da un file ISO, un live -
CD/DVD o una Live-USB esistente o anche un sistema live in esecuzione.

Figura 3-15: Live USB Maker.

Aiuto: qui

3.2.12 Locale
Questo nuovo strumento facilita l'impostazione non solo della lingua principale, ma anche di altre caratteristiche 
secondarie come la valuta, il formato della carta, ecc. Consente inoltre una facile gestione delle impostazioni 
locali, compresa la disattivazione di quelle non utilizzate, che può far risparmiare molto tempo durante gli 
aggiornamenti.

Figura 3-16: scheda delle caratteristiche secondarie

Aiuto: qui.

../../GitHub/mx-docs-1/usr/share/doc/mx-live-usb-maker/mx-live-usb-maker.html
../../usr/share/doc/mx-locale/help/mx-locale.html


3.2.13 Assistente di rete

Questa applicazione semplifica notevolmente il processo di risoluzione dei problemi di rete rilevando l'hardware, 
modificando lo stato di uno switch hardware, consentendo la gestione dei driver Linux e fornendo strumenti di rete 
generici.

Figura 3-17: Network Assistant rileva l'hardware wireless.

Aiuto: qui.

3.2.14 Programma di installazione driver Nvidia

Il programma di installazione del driver grafico Nvidia (solo CLI) semplifica notevolmente una procedura 
importante: l'installazione di un driver grafico proprietario utilizzando lo script ddm-mx sottostante. Facendo clic 
sull'icona del programma di installazione del driver Nvidia si apre un terminale e, nella maggior parte dei casi, 
l'utente deve solo accettare le impostazioni predefinite.

AIUTO: qui.

3.2.15 Installatore di pacchetti

 VIDEO: Installare applicazioni con MX Package Installer

Il semplice gestore di pacchetti personalizzato per MX Linux consente di cercare, installare o rimuovere sia i 
pacchetti più diffusi che qualsiasi pacchetto presente nei repository MX/Debian Stable, MX Test, Debian 
Backports e Flatpak in modo rapido, sicuro e semplice.

https://mxlinux.org/wiki/help-files/help-mx-network-assistant
https://mxlinux.org/wiki/help-files/help-amd-ati-and-nvidia-installers
https://www.youtube.com/watch?v=4kXSMfPkQSA


Figura 3-18: Installatore di pacchetti, che mostra i pacchetti più diffusi per lo sviluppo.

AIUTO: qui.

3.2.16 Informazioni rapide sul sistema

Questo utile strumento consente all'utente di consultare facilmente i file di log. Il log predefinito è Informazioni 
rapide sul sistema, necessario per i post sul forum: notare il pulsante "Copia per il forum" che consente di inserire 
con un semplice clic il contenuto del log già formattato. La nuova scheda "Journald" viene visualizzata quando si 
esegue sotto systemd.

Figura 3-19: Schermata principale

https://mxlinux.org/wiki/help-files/help-mx-package-installer


3.2.17 Gestione repository

Ci sono molti motivi per cui l'utente potrebbe voler cambiare il mirror predefinito utilizzato, che vanno da un 
server offline a un cambiamento nella posizione fisica del computer. Questo strumento consente di cambiare 
repository con un solo clic, risparmiando molto tempo e fatica.

Fornisce anche un pulsante che testa tutti i repository (MX o Debian) e seleziona il più veloce.

Figura 3-20: Scelta di un repository.

AIUTO: qui.

3.2.18 Configurazione Samba

MX Samba Config è uno strumento che aiuta gli utenti a gestire le loro condivisioni di rete samba/cifs. Gli utenti 
possono creare e modificare le condivisioni di loro proprietà, nonché gestire i permessi di accesso degli utenti a tali 
condivisioni.

Figura 3-21: Schermata principale dello strumento Configurazione Samba

AIUTO: qui

https://mxlinux.org/wiki/help-files/help-mx-repo-manager
https://mxlinux.org/wiki/help-files/help-mx-samba-config/


3.2.19 Scheda audio

I computer dispongono spesso di più di una scheda audio e l'utente che non sente nulla potrebbe concludere che 
l'audio non funziona. Questa piccola applicazione intelligente consente all'utente di selezionare quale scheda audio 
deve essere utilizzata dal sistema.

Figura 3-22: Effettuare la selezione in Scheda audio.

AIUTO: qui.

3.2.20 Tastiera di sistema

Figura 3-23: Schermata principale pronta per la selezione di una tastiera diversa da parte dell'utente.

Nel caso in cui l'utente abbia trascurato di selezionare la tastiera di sistema dal menu di login, non l'abbia impostata 
nella sessione Live o abbia semplicemente bisogno di apportare una modifica, questa piccola applicazione fornisce 
un modo semplice per eseguire tale operazione dal menu Start.

AIUTO: qui.

3.2.21 Impostazioni locali

https://mxlinux.org/wiki/help-files/help-sound-card
https://mxlinux.org/wiki/help-files/help-mx-system-keyboard


Figura 3-24: Presentazione delle variabili locali da generare per l'utente.

Se l'utente ha trascurato di selezionare le impostazioni locali di sistema dal menu Login, non le ha configurate nella 
sessione Live o semplicemente ha bisogno di apportare una modifica, questa piccola applicazione fornisce un modo 
semplice per eseguire tale operazione dal menu Start.

AIUTO: qui.

3.2.22 Suoni di sistema

Questo piccolo strumento raccoglie in un unico posto le varie azioni e scelte relative alla configurazione dei suoni 
di sistema, come login/logout, azioni, ecc. Solo Xfce.

Figura 3-25: Impostazione dei suoni di login e logout in Suoni di sistema.

AIUTO: qui.

3.2.23 Data e ora

MX Data e ora consente di effettuare regolazioni di ogni tipo da un'unica applicazione. Solo Xfce.

https://mxlinux.org/wiki/help-files/help-mx-system-locales
https://mxlinux.org/wiki/help-files/help-mx-system-sounds


Figura 3-26: La scheda principale di Data e ora

AIUTO: qui.

3.2.24 MX Tweak

MX Tweak riunisce una serie di piccole ma frequenti personalizzazioni come la gestione dei pannelli, la selezione 
dei temi, l'attivazione e la configurazione del compositore, ecc. su base desktop.

Figura 3-27: Le facce di MX-Tweak. Sinistra: XFCE, Destra: Plasma.

AIUTO: qui.

https://mxlinux.org/wiki/help-files/date-time/
https://mxlinux.org/wiki/help-files/help-mx-tweak


3.2.25 Formatta USB

Figura 3-28: Formattatore USB pronto per la riformattazione con FAT32.

Questo piccolo e comodo strumento pulirà e riformatterà un'unità USB per renderla disponibile per nuovi scopi.

AIUTO: qui.

3.2.26 USB Unmounter

Questo strumento per smontare rapidamente supporti USB e ottici si trova nell'area di notifica quando è abilitato 
(impostazione predefinita). Un singolo clic visualizza i supporti disponibili per lo smontaggio. Solo Xfce.

Figura 3-29: USB Unmounter con un dispositivo evidenziato per lo smontaggio.

AIUTO: qui.

3.2.27 Gestione utenti
Questo strumento semplifica notevolmente l'aggiunta, la modifica e la rimozione di utenti e gruppi nel sistema.

https://mxlinux.org/wiki/help-files/help-mx-format-usb/
https://www.mxlinux.org/wiki/help-files/help-mx-usb-unmounter


Figura 3-30: Gestione utenti, scheda Amministrazione.

AIUTO: qui.

3.2.28 Pacchetti installati dall'utente
Questa applicazione ha lo scopo di facilitare la reinstallazione dei pacchetti che l'utente ha 
aggiunto all'installazione predefinita. Visualizza un elenco dei pacchetti installati manualmente 
dall'utente che può essere salvato in un semplice file di testo. Inoltre, l'applicazione consente di 
caricare un elenco salvato di pacchetti per la revisione e la selezione da reinstallare.

Figura 3-31: Schermata principale dell'applicazione Pacchetti installati dall'utente

AIUTO:: file:///usr/share/user-installed-packages/help.html

3.2.29 Deb Installer
Questo semplice strumento (solo CLI) installa i pacchetti deb scaricati (Sezione 5.5.2). Fare clic con il tasto destro 
del mouse sul pacchetto deb che si desidera installare > "Apri con Deb Installer". Fare clic su Installa e inserire la 
password di root quando richiesto. Deb Installer tenterà di installare il pacchetto e segnalerà i risultati.upda

3.2.30 xdelta3 GUI

Questo strumento semplifica notevolmente la creazione e l'applicazione di un "delta" (patch) per l'aggiornamento 
di file di ogni tipo.

https://mxlinux.org/wiki/help-files/help-mx-user-manager
../../GitHub/mx-docs-1/usr/share/user-installed-packages/help.html


Figura 3-31: Schermata principale

3.3 Display 

3.3.1 Risoluzione dello schermo

Figura 3-32: Utilità di visualizzazione. Sinistra: Xfce, destra: KDE/Plasma.

La risoluzione si riferisce al numero fisico di colonne e righe di pixel che compongono il display (ad esempio, 
1920x1200). Nella maggior parte dei casi, la risoluzione viene impostata correttamente dal kernel durante 
l'installazione o quando viene collegato un nuovo monitor. In caso contrario, è possibile modificarla nei seguenti 
modi:

• Xfce: cliccare su Menu Start > Impostazioni > Schermo. Utilizzare i menu a tendina per impostare i 
valori corretti per il monitor che si desidera regolare. Per ulteriori opzioni e un controllo più preciso, 
installare xrandr dai repository.

• La schermata di Xfce rende possibile il ridimensionamento frazionario per i monitor HiDPI. Fare 
clic sul menu a tendina "Scala" e selezionare Personalizza.

• KDE: Menu Start > Impostazioni di sistema > Schermo e monitor > Configurazione schermo.

• In situazioni difficili, è possibile modificare manualmente il file di configurazione
/etc/X11/xorg.conf. Potrebbe non esistere, quindi potrebbe essere necessario crearlo prima. Eseguire 
sempre il backup del file prima di modificarlo e consultare il forum per assistenza sull'uso di tale file.

https://xorg-team.pages.debian.net/xorg/howto/use-xrandr.html
https://wiki.debian.org/Xorg#What_if_I_do_not_have_a_xorg_config_file.3F


3.3.2 Driver grafici

Se non sei soddisfatto delle prestazioni del tuo schermo, potresti aver bisogno/voler aggiornare il tuo driver grafico 
(assicurati di fare prima un backup del file /etc/X11/xorg.conf, se utilizzato). Tieni presente che dopo un 
aggiornamento del kernel potresti dover ripetere questa operazione, vedi Sezione 7.6.3.

Esistono vari metodi per farlo.

• Per la maggior parte delle schede Nvidia, il metodo di gran lunga più semplice è quello di 
utilizzare gli installer accessibili dalla dashboard MX Tools (vedere la Sezione 3.2).

• Alcune schede video più vecchie o meno comuni richiedono driver (come openchrome o 
mach64) che sono facilmente installabili solo con sgfxi (Sezione 6.5.3).

• Alcune schede Nvidia non sono più supportate in Debian Stable, vedere il Wiki MX/antiX. 
Sono tuttavia supportate dai driver nouveau e vesa.

• È possibile installare il pacchetto nvidia-settings per ottenere uno strumento grafico che 
consente di modificare le impostazioni come root con il comando: nvidia-settings

• Consultare il Wiki Debian sui driver open-source ati, radeon e amdgpu. Si noti che i driver open per 
AMD non sono più disponibili.

• È anche possibile, ma più complicato, scaricarli direttamente dal produttore. Questo metodo richiede 
di selezionare e scaricare il driver corretto per il proprio sistema; per informazioni sul sistema, aprire 
un terminale e digitare: inxi -Gxx.

Di seguito sono riportati i siti web dei driver per le marche più diffuse (per le altre, effettuare una ricerca 
web con "<nome marca> linux driver"):

• Nvidia

• Intel

I driver Intel devono essere compilati, ma i driver Nvidia scaricati sono facili da installare:

• In Thunar, naviga fino alla cartella in cui è stato scaricato il driver.

• Fai clic con il pulsante destro del mouse sul file, seleziona la scheda Permessi, seleziona È eseguibile.

• Premere CTRL-ALT-F1 per uscire da X (l'ambiente grafico) e accedere al prompt 
del terminale.

• Accedere come root.

• Digita: service lightdm stop.

https://mxlinux.org/wiki/hardware/unsupported-nvidia-gpus
https://en.wikipedia.org/wiki/Nouveau_(software)
https://wiki.debian.org/AtiHowTo
http://www.nvidia.com/Download/index.aspx
https://www.intel.com/content/www/us/en/download-center/home.html
https://mxlinux.org/wiki/applications-system/compiling-software


• Digita: sh <nomefile>.run (assicurati di utilizzare il nome effettivo del file).

• Consenti al driver NVIDIA di disattivare il kernel nouveau.

• Al termine, digitare: service lightdm start per riavviare lightdm e xorg.

• Un'altra importante opzione del driver è MESA, un'implementazione open source delle specifiche 
OpenGL, un sistema per il rendering di grafica 3D interattiva. Gli utenti di macchine ad alte prestazioni 
riferiscono che l'aggiornamento di questo driver porta una significativa stabilizzazione al loro sistema.

• Una versione più recente potrebbe essere disponibile nel Test Repo; usa MX Package Installer 
(Sezione 3.2) per ottenerla. Deseleziona la casella che nasconde i pacchetti lib e dev, cerca 
"MESA" e seleziona i pacchetti aggiornabili per l'installazione.

• Le schede grafiche ibride combinano due adattatori grafici sulla stessa unità. Un esempio popolare è 
NVidia Optimus, supportato su Linux con Bumblebee/Primus. Le schede grafiche più recenti possono 
anche utilizzare le funzioni Primus integrate nel driver nvidia senza il sistema Bumblebee. Per eseguire 
un'applicazione con le funzioni Primus, utilizzare "nvidia-run-mx APP" per avviare un'applicazione con 
l'accelerazione grafica abilitata.

3.3.3 Font

Regolazione di base

1. XFCE: fare clic su Menu Start > Tutte le impostazioni > Aspetto, scheda Font.

2. KDE/Plasma - Fare clic su Menu Start > Impostazioni di sistema > Aspetto > Font.

3. Fare clic sul menu a discesa per visualizzare l'elenco dei caratteri e delle dimensioni dei punti.

4. Selezionare quello desiderato e fare clic su OK.

Regolazioni avanzate

1. È possibile accedere a una serie di opzioni eseguendo il comando seguente in un terminale root: 
dpkg-reconfigure fontconfig-config

2. Le singole applicazioni possono avere i propri controlli, spesso disponibili in Modifica (o 
Strumenti) > Preferenze.

3. Per ulteriori regolazioni, consulta il Wiki MX/antiX.

4. I display ad alta risoluzione hanno esigenze particolari, consulta il Wiki MX/antiX.

http://www.opengl.org/
https://en.wikipedia.org/wiki/Nvidia_Optimus
https://wiki.debian.org/NVIDIA%20Optimus
https://www.mxlinux.org/wiki/system/font-adjustment
https://mxlinux.org/wiki/other/high-resolution-displays


Aggiunta di font

1. MX Package Installer offre alcuni pacchetti di font disponibili con un solo clic. Per ulteriori possibilità, 
fare clic su (Xfce) Menu Start > Sistema > Gestore pacchetti Synaptic; KDE: utilizzare Discover 
invece di Synaptic. Utilizzare la funzione di ricerca per i font.

2. Seleziona e scarica quelli desiderati. Il pacchetto Microsoft (Core) Fonts ttf-mscorefonts-installer 
in MX Package Installer consente di installare facilmente i font Microsoft True Type Core da 
utilizzare con i siti web e le applicazioni MS che girano su Wine.

3. Se necessario, estrarre, quindi copiare come root (più facile in un Thunar root) la cartella dei font in
/usr/share/fonts/.

4. I nuovi font dovrebbero essere disponibili nel menu a tendina in Tutte le impostazioni > Aspetto, scheda 
Font (Xfce); oppure Menu Start > Impostazioni di sistema > Aspetto > Font (KDE).

3.3.4 Doppio monitor

I monitor multipli sono gestiti in MX Linux Xfce con Menu Start > Impostazioni > Schermo. È possibile utilizzarlo 
per regolare la risoluzione, selezionare se uno clona l'altro, quali saranno accesi, ecc. Spesso è necessario 
disconnettersi e riconnettersi per vedere lo schermo selezionato. Gli utenti dovrebbero anche guardare la scheda 
Schermo di MX Tweak. Un controllo più preciso di alcune funzioni è talvolta disponibile con xrandr.

Nella scheda Avanzate di Schermo (Xfce 4.20 e versioni successive) è possibile consentire impostazioni dettagliate 
per ciascun monitor, salvare i profili dei monitor e utilizzarli automaticamente quando lo stesso hardware viene 
ricollegato. Se i problemi persistono, cercare nel forum Xfce, nel forum MX Linux e nel wiki MX/antiX se si 
riscontrano problemi insoliti.

In KDE/Plasma I monitor doppi vengono configurati con lo strumento di configurazione dello 

schermo. Link

• Documentazione Xfce: Schermo

3.3.5 Gestione dell'alimentazione

Fare clic sull'icona dei plugin Power Manager nel pannello. Qui è possibile passare facilmente alla modalità 
Presentazione (Xfce) o andare nelle Impostazioni per impostare quando uno schermo si spegne, quando il 
computer entra in sospensione, l'azione avviata dalla chiusura del coperchio di un laptop, la luminosità, ecc. Su un 
laptop, vengono visualizzate lo stato e le informazioni della batteria ed è disponibile un cursore per la luminosità.

3.3.6 Regolazione del monitor
Sono disponibili diversi strumenti per regolare il display per monitor particolari.

https://forum.xfce.org/
https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff
https://docs.xfce.org/xfce/xfce4-settings/4.14/display


• La luminosità dello schermo può essere impostata (solo Xfce) con Menu Start > Impostazioni > Power 
Manager, scheda Display; MX Tweak; o MX Brightness Systray che inserirà un pratico widget nella barra 
delle applicazioni.

• Gli utenti con Nvidia possono utilizzare nvidia-settings come root per la regolazione fine del display.

• Per modificare la gamma (contrasto), aprire un terminale e inserire:

xgamma -gamma 1.0

1.0 è il livello normale; aumentarlo o diminuirlo per ridurre/aumentare il contrasto.

• Il colore dell'adattamento del display all'ora del giorno può essere controllato con fluxgui (un pacchetto 
snap che richiede l'avvio con systemd) o Redshift.

• Per una regolazione più avanzata e la creazione di profili, installare displaycal.

• È possibile creare profili colore (solo Xfce): Start > Impostazioni > Profili colore. Un profilo colore 
è un insieme di dati che caratterizza un dispositivo di input o output del colore e la maggior parte di 
essi deriva dai profili ICC.

Figura 3-33: Preparazione per l'aggiunta di un profilo colore.

AIUTO: qui.

3.3.7 Screen tearing
Lo screen tearing è un artefatto visivo nella visualizzazione video in cui un dispositivo di visualizzazione mostra 
informazioni provenienti da più fotogrammi in un unico disegno dello schermo (Wikipedia). Tende a variare 
notevolmente a seconda di fattori che includono l'hardware grafico, l'applicazione specifica e la sensibilità 
dell'utente.

In MX Linux sono disponibili varie soluzioni:

• Fare clic sulla scheda Compositor in MX Tweak e utilizzare il menu a tendina per passare 
dall'impostazione predefinita xfwm a picom, un compositore indipendente.

• Utilizza il menu a tendina per modificare la spaziatura verticale (vblank).

• Quando viene rilevato un driver grafico Intel, nella scheda MX Tweak > Config Options diventa 
disponibile una casella di controllo che disattiva l'impostazione predefinita "modesetting", un'opzione che 
abilita la funzione TearFree del driver Intel. Le opzioni Tearfree esistono anche per nouveau, radeon e 
amdgpu e vengono visualizzate come appropriato.

https://en.wikipedia.org/wiki/Gamma_correction
https://justgetflux.com/linux.html
http://jonls.dk/redshift/
https://displaycal.net/
https://en.wikipedia.org/wiki/ICC_profile
https://docs.xfce.org/xfce/xfce4-settings/4.16/display
https://docs.xfce.org/xfce/xfwm4/start
https://en.wikipedia.org/wiki/Compositing


Link

• MX/antiX Wiki

3.4 Rete 

Le connessioni Internet sono gestite da Network Manager:

--Fare clic con il tasto sinistro del mouse sull'applet nell'area di notifica del vassoio di sistema per visualizzare lo 
stato, la connessione e le opzioni disponibili.

--Fare clic con il tasto destro sull'applet > Modifica connessioni per aprire una finestra Impostazioni con cinque 
schede. KDE: facendo clic con il tasto destro si aprirà Configura connessioni di rete. Fare clic su di esso per aprire 
la finestra Impostazioni.

• Cablato. Nella maggior parte dei casi non è necessario intervenire; evidenziare e fare clic sul pulsante 
Modifica per configurazioni speciali.

• Wireless

• Network Manager di solito rileva automaticamente la scheda di rete e la utilizza per trovare i 
punti di accesso disponibili.

• Per i dettagli, vedere la Sezione 3.4.2 di seguito.

• Banda larga mobile (solo Xfce). Questa scheda consente di utilizzare un dispositivo mobile 3G/4G per 
accedere al web. Fare clic sul pulsante Aggiungi per configurarlo.

• VPN. Fare clic sul pulsante Aggiungi per configurare. In caso di problemi di configurazione, 
consultare il Wiki MX/antiX.

• DSL (solo Xfce). Fare clic sul pulsante Aggiungi per configurare.

ALTRO: Wiki Ubuntu: Network Manager

3.4.1 Accesso cablato

MX Linux in genere rileva l'accesso Internet cablato all'avvio senza particolari problemi. Se è necessario un driver 
Broadcom (raro), utilizzare MX Network Assistant (Sezione 3.2).

Ethernet e cavo

MX Linux è preconfigurato per una LAN (Local Area Network) standard che utilizza il DHCP (Dynamic Host 
Configuration Protocol) per assegnare indirizzi IP e DNS (Domain Name System)

https://mxlinux.org/wiki/hardware/screen-tearing
https://mxlinux.org/wiki/networking/vpn
https://help.ubuntu.com/community/NetworkManager


. Nella maggior parte dei casi funzionerà così com'è. È possibile modificare la configurazione con Network 
Manager (KDE: Interfacce di rete).

All'avvio di MX Linux, agli adattatori di rete viene assegnato un nome di interfaccia breve da udev, il Device 
Manager del kernel. Per i normali adattatori cablati questo è solitamente eth0 (con gli adattatori successivi eth1, 
eth2, eth3, ecc.). Gli adattatori USB spesso vengono visualizzati sull'interfaccia eth0 in MX Linux, ma il nome 
dell'interfaccia può anche dipendere dal chipset dell'adattatore. Ad esempio, le schede Atheros spesso vengono 
visualizzate come ath0, mentre gli adattatori USB ralink possono essere rausb0. Per un elenco più dettagliato di tutte 
le interfacce di rete trovate, aprire un terminale, diventare root e inserire: ifp -a.

È consigliabile connettersi a Internet tramite un router, poiché quasi tutti i router cablati contengono firewall 
opzionali. Inoltre, i router utilizzano il NAT (Network Address Translation) per tradurre gli indirizzi Internet di 
grandi dimensioni in indirizzi IP locali. Ciò garantisce un ulteriore livello di protezione. Connettiti al router 
direttamente o tramite un hub o uno switch e il tuo computer dovrebbe configurarsi automaticamente tramite DHCP.

ADSL o PPPoE (solo Xfce)

Se si utilizza ADSL o PPPoE, connettersi a Internet è facile in MX Linux. Fare clic con il tasto destro sull'icona 
Network Manager, quindi sulla scheda DSL. Fare clic sul pulsante Aggiungi... e inserire le informazioni richieste, 
selezionando l'opzione di connessione automatica se lo si desidera.

NOTA: se si riscontrano problemi durante l'utilizzo di un dispositivo USB per la connessione, collegare l'unità al 
computer, aprire un terminale e digitare:

dmesg | tail

Pubblica l'output sul forum di MX Linux per ottenere aiuto nella ricerca del driver necessario.

Figura 3-34: Configurazione del servizio DSL.



Connessione Internet dial-up

Nella scheda Dispositivo dovrai configurare le informazioni seriali. Accettare l'impostazione predefinita
/dev/modem potrebbe funzionare, ma potrebbe essere necessario provare un'altra interfaccia. Questi sono gli 
equivalenti Linux delle porte COM in Windows:

Tabella 3: Equivalenti Linux delle porte COM.

Porta Equivalente
COM 1 /dev/ttyS0

COM 2 /dev/ttyS1

COM 3 /dev/ttyS2

COM 4 /dev/ttyS3

3.4.2 Accesso wireless.

MX Linux è preconfigurato per rilevare automaticamente una scheda WiFi e, nella maggior parte dei casi, la 
scheda verrà individuata e configurata automaticamente.

Un driver nativo è solitamente incluso nel kernel Linux (ad esempio: ipw3945 per Intel), ma su alcuni computer, 
specialmente quelli più recenti, potrebbe essere necessario scaricare un driver utilizzando le informazioni disponibili 
in Informazioni rapide sul sistema > Rete.

A volte sono disponibili più driver. Potrebbe essere utile confrontarli in termini di velocità e connettività e 
potrebbe essere necessario inserire nella lista nera o rimuovere quello che non si utilizza per evitare conflitti. Le 
schede wireless possono essere interne o esterne. I modem USB (dongle wireless) di solito vengono visualizzati 
sull'interfaccia wlan, ma in caso contrario controllare gli altri nell'elenco.

NOTA: il metodo efficace varia a seconda degli utenti a causa delle complesse interazioni tra il kernel Linux, gli 
strumenti wireless, il chipset della scheda wireless locale e il router.

Passaggi di base per il wireless

Fare clic sul menu Start > Impostazioni > Connessioni di rete (KDE: Menu Start > Connessioni) oppure fare 
semplicemente clic sull'icona Gestione rete nell'area di notifica, quindi sulla scheda Wireless. Si verificherà una 
delle 3 situazioni seguenti.

–È stata trovata una rete wireless.

• Fare clic sul nome della rete per utilizzarla.

• Fare clic con il pulsante destro del mouse sull'icona per accedere ad altre opzioni.

• Al termine, clicca su OK.

–La rete trovata non funziona.



Se le reti wireless sono visibili ma il computer non riesce a connettersi, significa che 1) la scheda wireless è gestita 
correttamente dal driver giusto ma ci sono problemi relativi alla connessione al modem/router, al firewall, al 
provider, al DNS, ecc.; oppure 2) la scheda wireless è gestita in modo anomalo perché il driver non è quello più 
adatto a quella scheda o ci sono problemi di conflitto con un altro driver. In questo caso è necessario raccogliere 
informazioni sulla scheda wireless per verificare se i driver della scheda potrebbero avere dei problemi, quindi 
provare a testare la rete con una serie di strumenti diagnostici.

• Scopri le informazioni di base aprendo un terminale e inserendo una alla volta:

inxi -n

lsusb | grep -i net 

lspci | grep -i net E 

come root:

iwconfig

L'output di questi comandi fornirà il nome, il modello e la versione (se presente) della scheda wireless (esempio 
sotto), nonché il driver associato e l'indirizzo MAC della scheda wireless. L'output del quarto comando fornirà il 
nome dell'Access Point (AP) a cui si è collegati e altre informazioni sulla connessione. Ad esempio:

Rete
Scheda-2: Qualcomm Atheros AR9462 Wireless Network Adapter driver: ath9k IF: wlan0 
stato: attivo mac: 00:21:6a:81:8c:5a

A volte è necessario il numero MAC del chipset oltre a quello della scheda wireless. Il modo più semplice per 
ottenerlo è fare clic sul menu Start > Sistema > MX Network Assistant, scheda Introduzione. Ad esempio:

Qualcomm Atheros AR9485 Wireless Network Adapter [168c:0032](rev 01)

Il numero tra parentesi identifica il tipo di chipset della scheda wireless. I numeri prima dei due punti identificano 
il produttore, quelli dopo il prodotto.

Utilizza le informazioni raccolte in uno dei seguenti modi:

• Effettuare una ricerca sul web utilizzando tali informazioni. Alcuni esempi che utilizzano l'output lspci sopra riportato.

linux Qualcomm Atheros AR9462
linux 168c:0032
debian stable 0x168c 0x0034

• Consulta i siti Linux Wireless e Linux Wireless LAN Support riportati di seguito per 
scoprire di quale driver ha bisogno il tuo chipset, quali conflitti potrebbero esserci e se è 
necessario installare separatamente il firmware. Pubblica le tue informazioni sul forum MX 
Linux e chiedi aiuto.



• Disattiva il firewall, se presente, fino a quando non si stabilisce il collegamento tra il 
computer e il router.

• Prova a riavviare il router.

• Utilizza la sezione Diagnostica in MX Network Assistant per eseguire il ping del router 
utilizzando l'indirizzo MAC, esegui il ping di qualsiasi sito web come Google o esegui il 
traceroute. Se riesci a eseguire il ping di un sito utilizzando il suo IP (ottenuto da una ricerca 
sul web) ma non riesci a raggiungerlo con il suo nome di dominio, il problema potrebbe 
essere nella configurazione del DNS. Se non sai come interpretare i risultati di ping e 
traceroute, fai una ricerca sul web o pubblica i risultati sul forum MX Linux.

• A volte l'utilizzo dell'applicazione terminale Ceni (nei repository) può rivelare punti di accesso 
nascosti e altri fattori difficili da individuare. NOTA: l'utilizzo di Ceni per configurare 
l'interfaccia di rete in MX Linux interferirà e/o disabiliterà la gestione di tale interfaccia da 
parte del Network Manager predefinito. Ceni memorizza le informazioni di configurazione in 
/etc/network/interfaces. Qualsiasi interfaccia definita in /etc/network/interfaces verrà ignorata 
dal Network Manager, poiché il Network Manager presume che, se esiste una definizione, si 
desideri che un'altra applicazione gestisca il dispositivo.

–Non è stata trovata alcuna interfaccia wireless.

• Apri un terminale e digita i 4 comandi elencati all'inizio della sezione precedente. Identifica la 
scheda, il chipset e il driver necessari effettuando una ricerca sul web e consultando i siti 
segnalati, secondo la procedura descritta sopra.

• Cerca la voce relativa alla rete e prendi nota delle informazioni dettagliate sul tuo hardware 
specifico, quindi cerca ulteriori informazioni al riguardo sul sito LinuxWireless elencato di 
seguito o chiedi sul forum.

• Se hai un dispositivo wifi esterno e non vengono trovate informazioni sulla scheda di rete, 
scollega il dispositivo, attendi qualche secondo, quindi ricollegalo. Apri un terminale e 
digita:

dmesg | tail

Esamina l'output per trovare informazioni sul dispositivo (come l'indirizzo MAC) che puoi 
utilizzare per approfondire il tuo problema sul web o sul forum MX Linux.

• Un esempio comune di questa situazione è quello dei chipset wireless Broadcom; 
consultate il Wiki MX/antiX.

Firmware

Per alcune schede è necessario installare il firmware (ad esempio, firmware-ti-connectivity per Texas Instruments 
WL1251). MX Linux viene fornito con una buona quantità di firmware già

https://en.wikipedia.org/wiki/Traceroute
https://en.wikipedia.org/wiki/Traceroute
https://mxlinux.org/wiki/hardware-networking/broadcom-wireless


, sia installato che nei repository, ma potrebbe essere necessario individuare quello specifico per le proprie esigenze 
o controllare il forum MX.

Sicurezza

La sicurezza wireless è gestita da Network Manager. Ecco i passaggi di base da seguire (i passaggi sono simili in 
KDE con piccole differenze nella terminologia e nella posizione che sono evidenti):

• Fare clic con il tasto destro sull'icona di Network Manager nell'area di notifica > Modifica 
connessioni (KDE: Configura connessioni di rete).

• Fare clic sulla scheda Wireless ed evidenziare il nome del punto di accesso a cui si desidera 
connettersi (ad esempio, "linksys" o "starbucks 2345").

• Fare clic sul pulsante Modifica e quindi sulla scheda Sicurezza wireless.

• Utilizza il menu a tendina per selezionare la sicurezza desiderata (ad esempio: WPA e WPA2 Personal).

• Inserisci la password e clicca su Salva.

Figura 3-35: Sicurezza wireless in Network Manager (sinistra: Xfce, destra: KDE/Plasma).

È anche possibile utilizzare Ceni per gestire la sicurezza wireless, purché successivamente non si utilizzi Network 
Manager, con cui interferisce.

Collegamenti

• Linux Wireless

https://wireless.wiki.kernel.org/


• Supporto LAN wireless Linux

• Debian Wiki: Wifi

• Arch Wiki: Wireless

3.4.3 Banda larga mobile

Per l'accesso wireless a Internet tramite modem 3G/4G, consultare le pagine 3G del Debian Wiki collegate di 
seguito per informazioni sulla compatibilità. Molti modem 3G/4G saranno riconosciuti su MX Linux da Network 
Manager.

3.4.4 Tethering
Il tethering si riferisce all'uso di un dispositivo come un telefono cellulare o un hotspot WiFi mobile per fornire 
l'accesso mobile a Internet ad altri dispositivi, come un laptop. È necessario creare un "hotspot" sul dispositivo con 
accesso per l'utilizzo da parte dell'altro dispositivo. È facile configurare un telefono Android come hotspot
: Impostazioni > Connessioni > Hotspot mobile e tethering > Hotspot mobile. Per rendere il laptop un hotspot, 
consulta questo video.

Risoluzione dei problemi

Su alcuni sistemi, le connessioni modem non funzionano a causa di un aggiornamento dei pacchetti udev e 
libudev1. Per risolvere il problema, apri Synaptic, evidenzia i pacchetti, quindi fai clic su Pacchetto > Forza 
versione... Utilizza il menu a tendina per passare a una versione precedente e fai clic sull'icona Applica.

In alcuni casi questa soluzione non ha funzionato in modo coerente per gli utenti, ma hanno scoperto che la 
rimozione completa di Network Manager ha risolto i problemi.

ALTRO: Debian Wiki: Modem 3G

3.4.5 Utilità della riga di comando

Le utilità della riga di comando sono utili per visualizzare informazioni dettagliate e sono comunemente utilizzate 
anche nella risoluzione dei problemi. La documentazione dettagliata è disponibile nelle pagine man. Quelle più 
comuni riportate di seguito devono essere eseguite come root.

Tabella 4: Utilità wireless.

Comando Commento
ip Utilità di configurazione principale per le interfacce di rete.

ifup <interfaccia> Attiva l'interfaccia specificata. Ad esempio:
ifup eth0 attiverà la porta ethernet eth0

ifdown <interfaccia> L'opposto di ifup

iwconfig Utilità di connessione alla rete wireless. Utilizzato da solo, visualizza lo stato della 
connessione wireless. Può essere applicato a un'interfaccia specifica, ad esempio per 
selezionare un particolare

http://linux-wless.passys.nl/
http://wiki.debian.org/WiFi
https://wiki.archlinux.org/index.php/Wireless
https://www.youtube.com/watch?v=WeKcWTQc7mY&feature=youtu.be
http://wiki.debian.org/Modem/3G


punto di accesso

rfkill Disabilita il softblock per le interfacce di rete wireless (ad esempio, wlan).

depmod -a Controlla tutti i moduli e, se sono stati modificati, abilita la nuova 
configurazione.

3.4.6 DNS statico

A volte è preferibile modificare la configurazione Internet passando dalla configurazione DNS automatica 
predefinita (Dynamic Name Service) a una configurazione statica manuale. I motivi per farlo possono includere una 
maggiore stabilità, una migliore velocità, il controllo parentale, ecc. È possibile apportare tale modifica all'intero 
sistema o ai singoli dispositivi. In entrambi i casi, prima di iniziare, procurarsi le impostazioni DNS statiche che si 
intende utilizzare da OpenDNS, Google Public DNS, ecc.

DNS a livello di sistema

È possibile apportare la modifica per tutti gli utenti del router utilizzando un browser. Sarà necessario:

• l'URL del router (elencato qui se lo avete dimenticato).

• la sua password, se ne avete impostata una.

Trova e modifica il pannello di configurazione del router, seguendo le istruzioni specifiche per il tuo router 
(elenco delle guide qui).

DNS individuale

Per la modifica di un singolo utente, puoi utilizzare Network Manager.

• Fai clic con il pulsante destro del mouse sull'icona della connessione nell'area di notifica > Modifica connessioni...

• Evidenzia la tua connessione e fai clic sul pulsante Modifica.

• Nella scheda IPv4, utilizza il menu a tendina per modificare il Metodo in "Solo indirizzi 
automatici (DHCP)".

• Nella casella "Server DNS" inserire le impostazioni DNS statiche che si intende utilizzare.

• Fare clic su Salva per uscire.

3.5 Gestione dei file 

La gestione dei file in MX Linux viene effettuata tramite Thunar su Xfce e Dolphin su KDE / Plasma. Gran parte 
del loro utilizzo di base è intuitivo, ma ecco alcune cose utili da sapere:

https://en.wikipedia.org/wiki/Domain_Name_System
http://www.techspot.com/guides/287-default-router-ip-addresses/
https://support.opendns.com/forums/21618374


• I file nascosti sono invisibili per impostazione predefinita, ma possono essere resi visibili tramite il 
menu (Visualizza > Mostra file nascosti) o premendo Ctrl-H.

• Il pannello laterale può essere nascosto e i collegamenti alle directory (cartelle) possono essere 
inseriti lì facendo clic con il tasto destro del mouse > Invia a (KDE: Aggiungi a luoghi) o 
trascinandoli.

• Il menu contestuale è stato popolato con procedure comuni ("Azioni personalizzate" su Xfce e "Azioni" 
e "Azioni root" su KDE / Plasma) che variano a seconda di ciò che è presente o in primo piano.

• L'azione principale è disponibile tramite il menu contestuale per aprire un terminale, modificare 
come root o aprire un'istanza di File Manager con privilegi di root.

• I File Manager gestiscono facilmente i trasferimenti FTP, vedi sotto.

• Le azioni personalizzate aumentano notevolmente la potenza e l'utilità dei File Manager. MX Linux 
ne include molti preinstallati, ma ce ne sono altri disponibili da copiare e l'utente può crearne di 
nuovi in base alle proprie esigenze. Vedi Suggerimenti e trucchi (Sezione 3.5.1) di seguito e il Wiki 
MX/antiX.

Figura 3-36: A sinistra: azioni personalizzate impostate in Thunar. A destra: servizi personalizzati in Dolphin.

3.5.1 Suggerimenti e trucchi

• Quando si lavora in una directory che richiede privilegi di superutente, è possibile fare clic con il tasto 
destro del mouse > Apri Thunar root qui (o File > Apri Thunar root qui) o l'azione simile "Azione root" in 
Dolphin.

http://docs.xfce.org/xfce/thunar/custom-actions
https://mxlinux.org/wiki/applications/thunar-custom-actions
https://mxlinux.org/wiki/applications/thunar-custom-actions


• I privilegi di superutente possono essere modificati in MX Tweak > scheda Altro utilizzando la password 
dell'utente (impostazione predefinita) o una password amministrativa, se è stata impostata.

• È possibile impostare le schede con File > Nuova scheda (o Ctrl-T), quindi spostare gli elementi da una 
posizione all'altra trascinandoli su una scheda e rilasciandoli.

• È possibile dividere lo schermo e navigare in un'altra directory in uno dei pannelli. Quindi spostare 
o copiare i file da uno all'altro.

• In Xfce 4.20 e versioni successive, è possibile impostare una visualizzazione a più schede per 
impostazione predefinita; il modo più semplice per farlo è utilizzare MX Tweak > scheda Opzioni di 
configurazione.

È possibile assegnare un tasto di scelta rapida all'azione personalizzata "Apri terminale qui".

▪ Thunar/Xfce

• Abilitare gli acceleratori modificabili in Tutte le impostazioni > Aspetto > Impostazioni.

• In Thunar, passa con il mouse sulla voce di menu File > Apri nel terminale e premi la 
combinazione di tasti che desideri utilizzare per quell'azione.

• Quindi, durante la navigazione in Thunar, utilizzare la combinazione di tasti per aprire 
una finestra di terminale nella directory attiva.

• Questo vale anche per altre voci del menu File di Thunar; ad esempio, è possibile 
assegnare Alt-S per creare un collegamento simbolico per un file evidenziato, ecc.

• Le azioni elencate nel menu contestuale possono essere modificate/eliminate e se ne 
possono aggiungere di nuove facendo clic su Modifica > Configura azioni 
personalizzate...

• Dolphin / KDE Plasma: seleziona Impostazioni > Configura scorciatoie da tastiera e trova la 
voce Terminale.

• Sono visibili anche varie opzioni e comandi nascosti, vedere i collegamenti riportati di seguito.

• Sia Java che Python sono talvolta utilizzati per sviluppare applicazioni, con estensione
*.jar e *.py, rispettivamente. Questi file possono essere aperti con un solo clic, come qualsiasi altro file; 
non è più necessario aprire un terminale, capire quale sia il comando, ecc. ATTENZIONE: prestare 
attenzione ai potenziali problemi di sicurezza.

• I file compressi (zip, tar, gz, xz, ecc...) possono essere gestiti facendo clic con il tasto destro del mouse sul file.

• Per trovare i file:



--Thunar/Xfce: apri Thunar e fai clic con il tasto destro su qualsiasi cartella > Trova file qui. 
Apparirà una finestra di dialogo con diverse opzioni. In background è in esecuzione Catfish 
(menu Start > Accessori > Catfish).

--Dolphin / KDE Plasma: utilizzare Modifica > Cerca nella barra degli strumenti di Dolphin.

• Collegamenti/Collegamenti simbolici

--Thunar/Xfce: per impostare un collegamento simbolico (noto anche come symlink), ovvero un 
file che punta a un altro file o directory, clicca con il tasto destro del mouse sul target (file o 
cartella a cui vuoi che il collegamento punti)
> Crea collegamento simbolico. Quindi trascina (o fai clic con il tasto destro del mouse, taglia e 
incolla) il nuovo collegamento simbolico nella posizione desiderata.

--Dolphin / KDE Plasma: clicca con il tasto destro su un punto vuoto nella finestra Dolphin e usa 
Crea nuovo > Collegamento di base a file o directory.

• Azioni personalizzate di Thunar. Si tratta di un potente strumento per espandere le funzioni del file 
manager. Per vedere quelle predefinite durante lo sviluppo di MX Linux, clicca su Modifica > Configura 
azioni personalizzate. La finestra di dialogo che apparirà ti mostrerà ciò che è predefinito e ti darà un'idea 
di ciò che puoi fare tu stesso. Per creare una nuova azione personalizzata, clicca sul pulsante "+" a destra. 
Dettagli nel wiki MX/antiX.

• Le cartelle possono essere visualizzate con immagini inserendo un'immagine con estensione *.jpg o *.png 
nella cartella e rinominandola "cartella".

Figura 3-37: utilizzo di immagini per etichettare le cartelle.

https://mxlinux.org/wiki/applications/thunar-custom-actions


3.5.2 FTP

Figura 3-38: Utilizzo di Thunar per accedere a un sito FTP.

Il protocollo di condivisione file (FTP) e il più sicuro protocollo di condivisione file protetta (SFTP) sono 
utilizzati per trasferire file da un host a un altro host su una rete o localmente. Esistono app dedicate a questo 
scopo, come FileZilla, ma è anche possibile utilizzare semplicemente il proprio file manager.

Xfce FTP

• Aprire Thunar File Manager e fare clic su Sfoglia rete nella parte inferiore del riquadro sinistro. 
Quindi fare clic sulla barra degli indirizzi nella parte superiore del browser (o utilizzare Ctrl+L).

• Premere il tasto Backspace nel campo dell'indirizzo per cancellare ciò che è presente (network:///), 
quindi digitare il nome del server con il prefisso ftp://. È possibile utilizzare il sito di prova per 
verificare se funziona: ftp://ftp.dlptest.com/

• Apparirà una finestra di dialogo di autorizzazione. Inserisci nome utente e password e, se lo 
desideri, salva la password.

• Il gioco è fatto. Una volta individuata la cartella che utilizzerai sempre, puoi fare clic con il tasto destro 
del mouse sulla cartella e in Thunar > Invia a > Riquadro laterale per creare un modo molto semplice 
per connettersi.

• Puoi sfruttare i riquadri divisi di Thunar (Visualizza > Divisione vista; abilita in modo permanente in 
Modifica > Opzioni di configurazione) per mostrare il tuo sistema locale in una scheda e il sistema 
remoto nell'altra, il che è molto comodo.

KDE FTP

• Consultare la base utenti KDE.

È possibile utilizzare anche applicazioni FTP dedicate come Filezilla. Per una discussione sul funzionamento di 
FTP, consultare questa pagina.

https://filezilla-project.org/
https://userbase.kde.org/File_transfers
http://www.ncftp.com/libncftp/doc/ftp_overview.html


3.5.3 Condivisione di file

Esistono varie possibilità per condividere file tra computer o tra un computer e un dispositivo

• Samba. SAMBA è la soluzione più completa per condividere file con i PC della tua rete. 
Principalmente per PC Windows, ma SAMBA può essere utilizzato anche da molti lettori 
multimediali di rete e dispositivi NAS (Network-Attached Storage).

• NFS. Questo è il protocollo Unix standard per la condivisione di file. Molti ritengono che sia migliore 
di Samba per la condivisione di file e può essere utilizzato con macchine Windows. Dettagli: 
consultare MX Linux/antiX Wiki.

• Bluetooth: per lo scambio di file, installare blueman dai repository, riavviare, accoppiare il 
dispositivo, quindi fare clic con il tasto destro sull'icona Bluetooth nell'area di notifica > Invia file 
al dispositivo. Non sempre affidabile.

A partire da MX Linux 23, il firewall Uncomplicated Firewall è abilitato di default. Questo firewall è 
impostato su "ignora tutto" per le connessioni in entrata. Questo potrebbe anche bloccare Samba, NFS e CIFS. 
Vedere la Sezione 4.5.1 per sapere come configurare una regola di "consentito" nel firewall Samba 3 (porta TCP 
445).

3.5.4 Condivisioni (Samba)

Figura 3-39: Navigazione nelle condivisioni di rete A sinistra: Thunar, a destra: Dolphin.

I file manager possono connettersi a cartelle condivise (note anche come condivisioni Samba) su computer 
Windows, Mac, Linux e dispositivi NAS (Network Attached Storage). Per la stampa con Samba, consultare la 
Sezione 3.1.2.

• Fare clic su Sfoglia rete nel riquadro sinistro per visualizzare le varie reti.

• Fare clic sulla rete per visualizzare i server disponibili. Ora approfondire la ricerca per trovare ciò che 
si sta cercando.

https://mxlinux.org/wiki/networking/nfs


• Seleziona un server per le condivisioni Samba disponibili.

• Seleziona una condivisione Samba per visualizzare tutte le cartelle disponibili.

• Verrà creato un collegamento alla condivisione selezionata nella sezione della barra laterale Rete.

• La navigazione non funziona più sui PC Windows. È tuttavia possibile accedere direttamente 
a una condivisione Windows utilizzando la barra degli indirizzi di File Manager (Ctrl+L) e 
digitando:

smb://nomeserver/nomeshare

Questi percorsi possono essere aggiunti ai segnalibri nei pannelli laterali della maggior parte dei File Manager.

È presente una cartella denominata "Rete Windows", ma è sempre vuota. Gli host Windows, se presenti (KDE), 
saranno insieme agli host Linux. Ciò è dovuto alle recenti modifiche alla sicurezza di Samba.

3.5.5 Creazione di condivisioni

Su MX Linux, Samba può anche essere utilizzato per creare condivisioni accessibili da altri computer (Windows, 
Mac, Linux). La creazione di condivisioni con MX Samba Config è piuttosto semplice. Con questo strumento gli 
utenti possono creare e modificare le condivisioni di loro proprietà, nonché gestire i permessi di accesso degli utenti 
a tali condivisioni.

Note tecniche:

• smb.conf non viene modificato da questo strumento e le condivisioni definite in smb.conf non saranno 
gestite da questo strumento.

• Le definizioni delle condivisioni di file si trovano in /var/lib/samba/usershares, ogni 
condivisione in un file individuale. I file sono di proprietà dell'utente che li crea.

Collegamenti:

3.6 Audio 

 VIDEO: Come abilitare l'audio HDMI con Linux

L'audio di MX Linux dipende a livello di kernel dall'Advanced Linux Sound Architecture (ALSA) e a livello di 
utente da PipeWire e PulseAudio. Nella maggior parte dei casi l'audio funzionerà immediatamente, anche se 
potrebbe essere necessaria una piccola regolazione. Fare clic sull'icona dell'altoparlante per disattivare tutto 
l'audio, quindi fare nuovamente clic per ripristinarlo, se le preferenze sono impostate in questo modo. 
Posizionare il cursore sull'icona dell'altoparlante nell'area di notifica e utilizzare la rotellina del mouse per 
regolare il volume. Vedi anche le sezioni 3.6.4, 3.6.5 e 3.8.9.

https://mxlinux.org/wiki/help-files/help-mx-samba-config/
https://youtu.be/gjqcmZK5SnE
https://www.pipewire.org/
http://www.freedesktop.org/wiki/Software/PulseAudio/


3.6.1 Configurazione della scheda audio

Se si dispone di più schede audio, assicurarsi di selezionare quella che si desidera regolare utilizzando lo 
strumento MX Select Sound (Sezione 3.2). La scheda audio viene configurata e il volume delle tracce 
selezionate regolato facendo clic sull'icona dell'altoparlante nell'area di notifica > Mixer audio. Se i problemi 
persistono dopo aver effettuato il logout e il login, consultare la sezione Risoluzione dei problemi, di seguito.

3.6.2 Uso simultaneo delle schede

A volte potrebbe essere necessario utilizzare più di una scheda contemporaneamente; ad esempio, si potrebbe 
voler ascoltare la musica sia in cuffia che tramite altoparlanti in un'altra posizione. Questo non è facile da fare in 
Linux, ma consultare le Domande frequenti su PulseAudio. Inoltre, le soluzioni riportate in questa pagina Wiki 
MX/antiX potrebbero funzionare, se si ha cura di regolare i riferimenti alle schede in base alla propria situazione.

A volte è necessario cambiare scheda audio, ad esempio quando una è HDMI e l'altra analogica. Questo può 
essere fatto con Pulse Audio Volume Control > scheda Configurazione; assicurati di selezionare l'opzione 
Profilo che funziona per il tuo sistema. Per rendere automatico questo cambio, consulta lo script su questo sito 
GitHub.

3.6.3 Risoluzione dei problemi 

• L'audio non funziona

• Nessun suono, anche se l'icona dell'altoparlante è presente nell'area di notifica.

• Prova ad alzare tutti i controlli a un livello più alto. Per un suono di sistema come il login, 
usa la scheda Riproduzione in PulseAudio.

• Modificare direttamente il file di configurazione: vedere la Sezione 7.4.

• Nessun suono e nessuna icona dell'altoparlante nell'area di notifica. Potrebbe essere che la scheda 
audio manchi o non sia riconosciuta, ma il problema più comune è quello delle schede audio 
multiple, che affrontiamo qui.

• Soluzione 1: clicca sul menu Start > Impostazioni > Scheda audio MX (KDE: 
Impostazioni di sistema > Hardware > Audio) e segui le istruzioni sullo schermo per 
selezionare e testare la scheda che desideri utilizzare.

• Soluzione 2: utilizzare il controllo del volume di PulseAudio (pavucontrol) per selezionare 
la scheda audio corretta

• Soluzione 3: entra nel BIOS e disattiva l'HDMI.

• Controllare la matrice delle schede audio ALSA elencata di seguito.

http://www.freedesktop.org/wiki/Software/PulseAudio/FAQ/
https://mxlinux.org/wiki/sound-not-working
https://mxlinux.org/wiki/sound-not-working
https://gist.github.com/3v1n0/ad3ad73e0bdd466d7f4a95b3aa376285
https://gist.github.com/3v1n0/ad3ad73e0bdd466d7f4a95b3aa376285
https://mxlinux.org/wiki/sound-not-working


3.6.4 Server audio

Mentre la scheda audio è un componente hardware accessibile all'utente, il server audio è un software che funziona 
principalmente in background. Consente la gestione generale delle schede audio e offre la possibilità di eseguire 
operazioni avanzate sul suono. Quello più comunemente utilizzato dai singoli utenti è PulseAudio. Questo server 
audio open source avanzato può funzionare con diversi sistemi operativi ed è installato di default. Dispone di un 
proprio mixer che consente all'utente di controllare il volume e la destinazione del segnale audio. Per uso 
professionale, Jack audio è forse il più conosciuto.

Figura 3-40: Utilizzo del mixer PulseAudio. A sinistra: Pavucontrol A destra: Volume audio KDE.

Collegamenti

• MX/antiX Wiki: L'audio non funziona

• ALSA: Matrice scheda audio

• Wiki ArchLinux: Informazioni su PulseAudio

• Documentazione PulseAudio: Desktop libero

3.7 Localizzazione 

MX Linux è gestito da un team di sviluppo internazionale che lavora costantemente per migliorare ed espandere 
le opzioni di localizzazione. Ci sono molte lingue in cui i nostri documenti non sono ancora stati tradotti, e se 
puoi aiutare in questo sforzo, registrati su Transifex e/o pubblica un post sul forum di traduzione.

3.7.1 Installazione

L'atto principale di localizzazione avviene durante l'uso del LiveMedium USB.

http://jackaudio.org/
https://mxlinux.org/wiki/sound-not-working
https://wiki.archlinux.org/index.php/PulseAudio
http://www.freedesktop.org/wiki/Software/PulseAudio/Documentation/User/
https://forum.mxlinux.org/viewtopic.php?f=96&t=38671
https://forum.mxlinux.org/viewforum.php?f=96


• Quando viene visualizzata la schermata di avvio, assicurati di utilizzare i tasti funzione per impostare 
le tue preferenze.

• F2. Seleziona la lingua.

• F3. Seleziona il fuso orario che desideri utilizzare.

• Se si dispone di una configurazione complessa o alternativa, è possibile utilizzare i cheat 
code di avvio. Ecco un esempio per impostare una tastiera Tartar per il russo: lang=ru 
kbvar=tt . Un elenco completo dei parametri di avvio (=cheat code) è disponibile nel Wiki 
MX/antiX.

• Se si impostano i valori locali nella schermata di avvio, la schermata 7 dovrebbe mostrarli durante 
l'installazione. In caso contrario, o se si desidera modificarli, selezionare la lingua e il fuso orario 
desiderati.

Dopo la schermata di avvio sono disponibili altri due metodi.

• La prima schermata dell'installatore consente all'utente di selezionare una tastiera specifica da utilizzare.

• La schermata di login presenta dei menu a tendina nell'angolo in alto a destra dove è possibile 
selezionare sia la tastiera che le impostazioni locali.

3.7.2 Post-installazione
MX Tools include due strumenti per modificare la tastiera e le impostazioni locali. Vedere le sezioni 3.2.15 e 
3.2.16 sopra.

Anche Xfce4 e KDE/Plasma hanno i propri metodi:

Figura 3-41: Aggiunta di un altro layout di tastiera. A sinistra: Xfce, a destra: KDE.

Ecco i passaggi di configurazione che è possibile seguire per localizzare MX Linux dopo l'installazione. Per 

cambiare la tastiera:

Xfce

https://mxlinux.org/wiki/system/boot-parameters
https://mxlinux.org/wiki/system/boot-parameters


• Fare clic su Menu Start > Impostazioni > Tastiera, scheda Layout.

• Deselezionare "Usa impostazioni predefinite di sistema", quindi fare clic sul pulsante 
+Aggiungi in basso e selezionare la tastiera o le tastiere che si desidera rendere disponibili.

• Esci, quindi fai clic su Cambia tastiera (bandierina) nell'area di notifica per selezionare la 
tastiera attiva.

KDE/Plasma

• Fai clic su Menu Start > Impostazioni > Impostazioni di sistema > Hardware > Tastiera > scheda 
Layout

• Seleziona "Configura layout" al centro della finestra di dialogo, quindi fai clic sul pulsante +Aggiungi
in basso e seleziona la tastiera o le tastiere che desideri rendere disponibili.

• Esci, quindi fai clic su Keyboard Switcher (bandierina) nell'area di notifica per 
selezionare la tastiera attiva.

• Ottieni i pacchetti lingua per le principali applicazioni: clicca sul menu Start > Sistema > MX 
Package Installer, inserisci la password di root, quindi clicca su Lingua per trovare e installare i 
pacchetti lingua per le applicazioni che utilizzi.

• La configurazione del pinyin cinese semplificato è un po' più complicata, vedi qui.

• Modifica le impostazioni dell'ora: (Xfce) clicca su Menu Start > Sistema > MX Data e ora, (KDE: 
clicca con il tasto destro sull'ora nel pannello > Regola data e ora) e seleziona le tue preferenze. Se 
utilizzi l'orologio digitale Data Ora, clicca con il tasto destro > Proprietà per scegliere 12h/24h e altre 
impostazioni locali.

• Ottieni un correttore ortografico per la tua lingua: installa il pacchetto aspell o myspell per la tua 
lingua (ad esempio, myspell-es).

• Ottieni informazioni meteo locali.

• Xfce: clicca con il tasto destro del mouse sul pannello > Pannello > Aggiungi nuovi elementi > 
Aggiornamento meteo. Clicca con il tasto destro del mouse > Proprietà e imposta la lingua che 
desideri visualizzare (verrà rilevata in base al tuo indirizzo IP).

• KDE: clicca con il tasto destro del mouse sul desktop o sul pannello a seconda di dove 
apparirà il widget, quindi clicca su Aggiungi widget. Cerca Meteo e aggiungi il widget

• Per la localizzazione di Firefox, Thunderbird o LibreOffice, usa MX Package Installer >
Language per installare il pacchetto appropriato per la lingua di tuo interesse.

https://mxlinux.org/wiki/other/chinese-simplified-input


• Potrebbe essere necessario o desiderabile modificare le informazioni di localizzazione (lingua 
predefinita, ecc.) disponibili nel sistema. Il metodo più semplice è utilizzare lo strumento MX Locale 
(Sezione 3.4), ma è anche possibile farlo dalla riga di comando. Aprire un terminale, diventare root e 
inserire:

dpkg-reconfigure locales

• Verrà visualizzato un elenco con tutte le impostazioni locali che è possibile scorrere 
utilizzando i tasti freccia su e giù.

• Abilita e disabilita ciò che desideri (o non desideri), utilizzando la barra spaziatrice per far 
apparire (o scomparire) l'asterisco davanti alla lingua.

• Al termine, clicca su OK per passare alla schermata successiva.

• Utilizza le frecce per selezionare la lingua predefinita che desideri utilizzare. Per gli utenti 
statunitensi, ad esempio, sarà in genere en_US.UTF-8.

• Fai clic su OK per salvare e uscire.

ALTRO: Documentazione Ubuntu

Figura 3-42: CLI che reimposta la lingua predefinita per il sistema installato.

3.7.3 Ulteriori note
• È possibile modificare temporaneamente la lingua di una particolare applicazione inserendo questo 

codice in un terminale (in questo esempio, per passare allo spagnolo):

LC_ALL=es_ES.UTF8 <comando per avviare>

Questo funzionerà per la maggior parte delle applicazioni già localizzate.

• Se durante l'installazione è stata selezionata la lingua sbagliata, è possibile modificarla una volta avviato il 
desktop installato, utilizzando MX Locale per correggerla. È anche possibile aprire un terminale e inserire 
questo comando:

sudo update-locale LANG=en_GB.utf8

https://help.ubuntu.com/community/Locale


Ovviamente dovrai cambiare la lingua con quella che desideri utilizzare.

• Può capitare che una singola applicazione non abbia una traduzione nella tua lingua; a meno che non si 
tratti di un'applicazione MX, non possiamo fare nulla al riguardo, quindi dovresti inviare un messaggio 
allo sviluppatore.

• Alcuni file desktop utilizzati per creare il menu Start potrebbero non avere un commento nella tua lingua, 
anche se l'applicazione stessa ha una traduzione in quella lingua; ti preghiamo di comunicarcelo con un 
post nel sottoforum Traduzioni che fornisce la traduzione corretta.

3.8 Personalizzazione 

I moderni desktop Linux come Xfce e KDE/Plasma rendono molto facile modificare le funzioni di base 
e l'aspetto della configurazione di un utente.

• Ma soprattutto, ricorda: il tasto destro del mouse è tuo amico!

• È possibile ottenere un ottimo controllo tramite (Xfce) Tutte le impostazioni e (KDE/Plasma) 
Impostazioni, Impostazioni di sistema (icone del pannello).

• Le modifiche dell'utente vengono memorizzate nei file di configurazione nella directory: 
~/.config/. Questi possono essere interrogati in un terminale, vedere il Wiki MX/antiX.

• La maggior parte dei file di configurazione a livello di sistema si trova in /etc/skel/ o /etc/xdg/

3.8.1 Temi predefiniti

Il tema predefinito è controllato da una serie di elementi personalizzati.

Xfce

• La schermata di login può essere modificata con Tutte le impostazioni > Impostazioni LightDM GTK+ Greeter.

• Desktop:

• Sfondo: Tutte le impostazioni > Desktop/ o clicca con il tasto destro sul desktop > 
Impostazioni desktop. Quando selezioni da un'altra posizione, tieni presente che dopo aver 
utilizzato la voce "Altro" devi navigare fino alla cartella desiderata, quindi fare clic su 
"Apri"; solo allora potrai selezionare un file specifico in quella posizione.

• Tutte le impostazioni > Aspetto. Imposta i temi GTK e le icone. Impostazioni raggruppate in 
MX Tweak > Temi.

• Tutte le impostazioni > Gestione finestre. Imposta i temi dei bordi delle finestre.

https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff#List%20configuration%20settings


KDE/Plasma

• Schermata di accesso (modificabile in Impostazioni di sistema > Avvio e spegnimento, quindi 
selezionare Schermata di accesso, configurazione SDDM)

• Breeze

• Desktop:

• Sfondo: clicca con il tasto destro sul desktop e seleziona "Configura desktop e 
sfondo"

• Aspetto: fare clic su Menu principale > Impostazioni > Impostazioni di sistema > Aspetto

1. Temi globali: combinazioni di temi in bundle

2. Stile Plasma: imposta il tema degli oggetti del desktop Plasma

1. Stile applicazione: configura gli elementi dell'applicazione

2. Decorazioni finestra: stili dei pulsanti di minimizzazione, 
massimizzazione e chiusura

3. È inoltre possibile configurare colori, caratteri, icone e cursori.

• Impostazioni del menu dell'applicazione

1. Fare clic con il pulsante destro del mouse sull'icona del menu per visualizzare le 
opzioni di configurazione. Il pannello predefinito si trova nel pannello applicazioni 
standard



3.8.3 Pannelli

3.8.3.1 Pannello Xfce

Figura 3-43: Schermata delle preferenze per la personalizzazione dei pannelli.

MX Linux viene fornito di default con la barra delle applicazioni Docklike Taskbar che sostituisce i pulsanti delle 
finestre Xfce utilizzati nelle precedenti versioni di MX. Questa barra delle applicazioni leggera, moderna e 
minimalista per Xfce offre le stesse funzionalità dei pulsanti delle finestre Xfce, ma fornisce anche funzioni "dock" 
più avanzate.

Per visualizzare le proprietà della barra delle applicazioni Docklike: Ctrl + clic 
destro su qualsiasi icona. Oppure: MX Tweak > Pannello, clicca sul pulsante 
"Opzioni" sotto Docklike.

I pulsanti finestra possono essere ripristinati facendo clic con il tasto destro su uno 
spazio vuoto > Pannello > Aggiungi nuovi elementi.

Trucchi per la personalizzazione del pannello:

• Per spostare il pannello, sbloccarlo facendo clic con il tasto destro 
del mouse su un pannello > Pannello > Preferenze pannello.

• Utilizza MX Tweak per modificare la posizione del pannello: verticale 
o orizzontale, in alto o in basso.

Figura 3-44: La barra delle 
applicazioni docklike con icone 
e menu contestuale.

• Per modificare la modalità di visualizzazione all'interno delle impostazioni del pannello, 
selezionare dal menu a tendina: Orizzontale, Verticale o Deskbar.

https://mxlinux.org/wiki/docklike-taskbar/


• Per nascondere automaticamente il pannello, scegli dal menu a tendina: Mai, Sempre o In modo 
intelligente (nasconde il pannello quando una finestra lo sovrappone).

• Installare nuovi elementi del pannello facendo clic con il tasto destro del mouse su uno spazio vuoto 
nel pannello > Pannello > Aggiungi nuovi elementi. Sono quindi disponibili 3 opzioni:

• Seleziona uno degli elementi nell'elenco principale che appare

• Se quello che desideri non è presente, seleziona Avvio. Una volta posizionato, fai clic con il 
pulsante destro del mouse > Proprietà, fai clic sul segno più e seleziona un elemento 
dall'elenco che appare.

• Se desideri aggiungere un elemento che non è presente in nessuno dei due elenchi, 
seleziona l'icona dell'elemento vuoto sotto il segno più e compila la finestra di dialogo che 
appare.

• Le nuove icone vengono visualizzate nella parte inferiore del pannello verticale; per spostarle, fai 
clic con il pulsante destro del mouse > Sposta

• Modifica l'aspetto, l'orientamento, ecc. facendo clic con il tasto destro del mouse sul 
pannello > Pannello > Preferenze pannello.

• Fai clic con il pulsante destro del mouse sul plugin dell'orologio "Data e ora" per modificare il formato 
del layout, della data o dell'ora. Per un formato dell'ora personalizzato è necessario utilizzare i "codici 
strftime" (consulta questa pagina o apri un terminale e digita man strftime).

• Crea una doppia fila di icone nell'area di notifica facendo clic con il tasto destro del mouse su di essa > 
Proprietà e riducendo la dimensione massima delle icone fino a quando non cambia.

• Aggiungi o elimina un pannello in Preferenze pannello, facendo clic sul pulsante più o meno a destra 
del menu a discesa del pannello superiore.

• L'installazione del pannello orizzontale con un solo clic è disponibile da MX Tweak (Sezione 3.2).

ALTRO: Documentazione Xfce4: Pannello.

3.8.3.2 Pannello KDE/Plasma

Figura 3-45: Schermata delle preferenze per la personalizzazione dei pannelli.

Trucchi per la personalizzazione dei pannelli:

• Per spostare il pannello, fare clic con il tasto destro del mouse sul pannello > Modifica pannello. 
Passare con il mouse su "Bordo dello schermo" e spostarlo nella posizione desiderata.

https://mxlinux.org/wiki/other/time-formats-in-scripts/
http://docs.xfce.org/xfce/xfce4-panel/start


• Utilizza MX Tweak per modificare la posizione del pannello: verticale (sinistra), superiore o 
inferiore. Oppure utilizza il metodo precedente per trascinarlo su qualsiasi bordo dello schermo.

• Per modificare la modalità di visualizzazione all'interno del pannello, una volta aperta la finestra di 
dialogo Modifica pannello, selezionare Altre opzioni Allineamento pannello > sinistra, centro o 
destra.

• Per nascondere automaticamente il pannello, una volta aperta la finestra di dialogo Modifica pannello, 
fare clic su "Altre impostazioni" e selezionare "Nascondi automaticamente".

• Installa nuovi elementi del pannello facendo clic sul pannello > Aggiungi widget. Puoi selezionare 
il widget desiderato da aggiungere dalla finestra di dialogo.

• Crea una doppia fila di icone nell'area di notifica utilizzando la finestra di dialogo Configura pannello 
e selezionando Altezza per modificare l'altezza del pannello. Quindi, utilizzando MX-Tweak
> scheda Plasma e impostando la dimensione dell'icona della barra delle applicazioni più grande o più 
piccola a piacere per creare l'effetto a doppia riga. È anche possibile scalare automaticamente le icone 
della barra delle applicazioni in base all'altezza del pannello facendo clic con il tasto destro del mouse 
sulla freccia su della barra, Configurare la barra delle applicazioni e abilitando la scala con l'altezza del 
pannello.

• Per visualizzare tutte le applicazioni aperte, fare clic su MX Tweak > Plasma e abilitare "Mostra 
finestre da tutti gli spazi di lavoro nel pannello".

•

3.8.4 Desktop

 VIDEO: Personalizzazione del desktop  
VIDEO: Cose da fare dopo l'installazione di MX Linux

Il desktop predefinito (ovvero lo sfondo) può essere modificato in vari modi:

• Fare clic con il tasto destro su qualsiasi immagine > Imposta come sfondo

• Se si desidera che gli sfondi siano disponibili per tutti gli utenti, diventare root e inserirli nella cartella
cartella /usr/share/backgrounds

• Se si desidera ripristinare lo sfondo predefinito, esso si trova in /usr/share/backgrounds/. Sono 
disponibili anche collegamenti simbolici dei set di sfondi MX in /usr/share/wallpapers per un facile 
utilizzo con KDE.

Sono disponibili molte altre opzioni di personalizzazione.

https://www.youtube.com/watch?v=QWVd1-8xpYI
https://youtu.be/aESEb8lTvz4


• Per cambiare il tema:

• Xfce - Aspetto. Il tema predefinito ha bordi più grandi e specifica l'aspetto del menu 
Whisker. Seleziona un nuovo tema e un tema di icone che si vedano bene, specialmente 
nella versione scura.

• KDE/Plasma – Tema globale – Il tema MX è quello predefinito. È anche possibile 
impostare singoli elementi del tema in Stile Plasma, Stile applicazione, Colori, Caratteri, 
Icone e cursori.

• Quando è necessario rendere i bordi sottili più facili da afferrare:

• Xfce - Utilizzare uno dei temi Window Manager con "bordi spessi" o consultare il Wiki 
MX/antiX.

• KDE/Plasma – In Stile applicazione > Decorazioni finestra, impostare la "Dimensione 
bordo" desiderata dal menu a tendina fornito.

• Xfce - Aggiungere icone standard come Cestino o Home al desktop in Desktop > Icone.

• È possibile personalizzare il comportamento delle finestre, come il cambio, la disposizione affiancata e lo zoom

• Xfce - Modifiche al gestore delle finestre.

• Il cambio di finestra tramite Alt+Tab può essere personalizzato per utilizzare un 
elenco compatto invece delle icone tradizionali

• Il cambio di finestra tramite Alt+Tab può anche essere impostato per mostrare 
miniature invece di icone o un elenco, ma richiede l'attivazione del compositing, che 
alcuni computer meno recenti potrebbero avere difficoltà a supportare. Per abilitarlo, 
deselezionare prima l'opzione Ciclo su un elenco nella scheda "Ciclo", quindi fare 
clic sulla scheda "Compositore" e selezionare "Mostra anteprima delle finestre al 
posto delle icone" durante il ciclo.

• È possibile affiancare le finestre trascinandole su un angolo e rilasciandole lì.

• Se il compositing è attivato, è possibile ingrandire le finestre utilizzando la 
combinazione Alt + rotellina del mouse.

• KDE/Plasma – Impostazioni di sistema

• È possibile affiancare le finestre trascinandole su un angolo e rilasciandole lì.

• È possibile configurare una serie di comandi da tastiera e mouse come desiderato 
tramite la finestra di dialogo Area di lavoro > Comportamento finestre.

https://mxlinux.org/wiki/xfce/changing-border-size-with-xfce4-window-manager/
https://mxlinux.org/wiki/xfce/changing-border-size-with-xfce4-window-manager/
https://en.wikipedia.org/wiki/Compositing_window_manager


• La configurazione di Alt-tab, compreso il tema, può essere effettuata nella 
finestra di dialogo Cambia attività.

• Sfondo

• Xfce – Utilizzare le impostazioni del desktop per scegliere gli sfondi. Per selezionare uno sfondo 
diverso per ogni area di lavoro, andare su Sfondo e deselezionare l'opzione "Applica a tutte le aree 
di lavoro". Quindi selezionare uno sfondo e ripetere il processo per ogni area di lavoro trascinando 
la finestra di dialogo sull'area di lavoro successiva e selezionando un altro sfondo.

• KDE/plasma – Fare clic con il tasto destro del mouse sul desktop e selezionare "Configura 
desktop e sfondo".

Figura 3-46: Casella deselezionata per sfondi diversi. Sinistra: Xfce, destra: KDE.

3.8.5 Conky

È possibile visualizzare quasi ogni tipo di informazione sul desktop utilizzando un conky. MX Conky è stato 
riprogettato per MX-25 ed è installato di default.

AIUTO: file di aiuto di MX Conky

ALTRO: Pagina iniziale di Conky

Terminale a tendina

 VIDEO: Personalizzazione del terminale a tendina

https://mxlinux.org/wiki/help-files/help-mx-conky
http://conky.sourceforge.net/index.html
https://www.youtube.com/watch?v=_X4tVjO8uzo


MX Linux è dotato di un terminale a tendina molto pratico che si attiva con il tasto F4. Se si desidera disattivarlo:

• Xfce - Menu Start > Tutte le impostazioni > Scheda Tastiera, Scorciatoie applicazioni.

• KDE/plasma - Impostazioni di sistema > Avvio e spegnimento > Avvio e spegnimento elimina Yakuake.

I terminali a tendina sono altamente configurabili.

• Xfce - clicca con il tasto destro sulla finestra del terminale e seleziona Preferenze

• KDE/plasma - clicca con il tasto destro sulla finestra del terminale e scegli Crea nuovo profilo.

3.8.6 Touchpad

Xfce - Le opzioni generali per il touchpad su un laptop si trovano cliccando su Impostazioni > Mouse e touchpad. I 
sistemi più sensibili alle interferenze del touchpad hanno un paio di opzioni:

• Utilizzare MX-Tweak, scheda Altro per modificare il driver del touchpad.

• Installare touchpad-indicator per vedere il controllo preciso del comportamento. Fare clic con il tasto 
destro sull'icona nell'area di notifica per impostare opzioni importanti come l'avvio automatico.

KDE/Plasma – le opzioni del touchpad si trovano in Impostazioni di sistema > Hardware > Dispositivi di input. C'è 
anche un widget touchpad che può essere aggiunto al pannello (clicca con il tasto destro del mouse sul pannello > 
aggiungi widget)

È possibile apportare modifiche dettagliate manualmente modificando il file 20-synaptics.conf o 30-touchpad-
libinput.conf in /etc/X11/xorg.conf.d.

3.8.7 Personalizzazione del menu Start

Menu "Whisker"

 VIDEO: Personalizzazione del menu Whisker

 VIDEO: Divertirsi con il menu Whisker

MX Linux Xfce utilizza per impostazione predefinita il menu Whisker, anche se è possibile installare facilmente un 
menu classico facendo clic con il tasto destro del mouse su un pannello > Pannello > Aggiungi nuovi elementi > 
Menu Applicazioni.

Il menu Whisker è altamente flessibile.

• Fare clic con il tasto destro sull'icona del menu > Proprietà per impostare le preferenze, ad esempio

https://www.youtube.com/watch?v=QWVd1-8xpYI
https://www.youtube.com/watch?v=bgPn68jMqd0


• Spostare la colonna delle categorie accanto al pannello.

• Cambia la posizione della casella di ricerca dall'alto verso il basso.

• Decidere quali pulsanti di azione si desidera visualizzare.

• I preferiti sono facili da aggiungere: clicca con il tasto destro su qualsiasi voce del menu > Aggiungi ai preferiti.

• È sufficiente trascinare e rilasciare i Preferiti per disporli come desiderato. Fare clic con il tasto 
destro del mouse su qualsiasi voce per ordinarla o rimuoverla.

Il contenuto del menu può essere modificato in Xfce utilizzando Menu > Accessori > Editor di menu 
(menulibre). In KDE è possibile accedere all'editor di menu facendo clic con il tasto destro del mouse sull'icona 
del menu e selezionando Modifica applicazioni.

ALTRO: Funzionalità del menu Whisker

Menu Xfce

Le singole voci di menu possono essere modificate in diversi modi (i file delle voci di menu "desktop" si trovano 
in /usr/share/applications/ e possono anche essere modificati direttamente come root).

• Lo strumento di modifica predefinito è MenuLibre

• Fare clic con il tasto destro del mouse su una voce nel menu Whisker o nell'Application Finder per 
modificarla in base alle esigenze specifiche dell'utente. Il menu contestuale contiene le voci Modifica 
e Nascondi (quest'ultima può essere molto utile). Selezionando Modifica si apre una schermata in cui 
è possibile modificare nome, commento, comando e icona.

Figura 3-48: Schermata di modifica della voce di menu.

http://gottcode.org/xfce4-whiskermenu-plugin/
https://bluesabre.org/projects/menulibre


KDE/Plasma ("kicker")

MX Linux KDE/Plasma utilizza il menu Application Launcher come impostazione predefinita, anche se è possibile 
installare facilmente delle alternative facendo clic con il tasto destro del mouse sull'icona del menu e selezionando 
"Mostra alternative".
Le applicazioni "preferite" sono visualizzate come icone sulla sinistra del menu.

• Fare clic con il tasto destro sull'icona del menu > Configura menu Applicazioni per impostare le preferenze, ad esempio

• Mostra le applicazioni solo con il nome o con la combinazione Nome/Descrizione.

• Modifica la posizione dei risultati della ricerca.

• Mostra gli elementi recenti o utilizzati di frequente.

• Appiattisci i livelli secondari del menu.

• I preferiti sono facili da aggiungere: clicca con il tasto destro su qualsiasi voce del menu > Mostra nei preferiti.

• È sufficiente trascinare e rilasciare i Preferiti per disporli come desiderato. Fare clic con il pulsante 
destro del mouse su qualsiasi voce per ordinarla. Per rimuovere dai Preferiti, fare clic con il 
pulsante destro del mouse sull'icona, quindi su Mostra nei Preferiti e deselezionare il Desktop o 
l'Attività appropriati.

Le voci del menu possono essere modificate facendo clic con il tasto destro del mouse su una voce nel menu ed è 
possibile modificare un programma di avvio in base alle esigenze specifiche dell'utente. I file della voce di menu 
«desktop» si trovano in /usr/share/applications/ e possono anche essere modificati direttamente come root.

Figura 3-49: Schermata di modifica delle voci del menu (Plasma).



3.8.8 Schermata di benvenuto

L'utente ha a disposizione una serie di strumenti per personalizzare il Login Greeter. Le ISO Xfce utilizzano 
Lightdm Greeter, mentre le ISO KDE/Plasma utilizzano SDDM.

Lightdm

Figura 3-50: l'applicazione di configurazione Lightdm.

• Fare clic su Menu Start > Impostazioni > Tutte le impostazioni > Impostazioni LightDM GTK+ 
Greeter per regolare la posizione, lo sfondo, il carattere, ecc.

• Il login automatico può essere (dis)attivato da MX User Manager, scheda Opzioni.

• Alcune proprietà della finestra di login predefinita sono impostate nel codice del tema selezionato. 
Cambia tema per una scelta più ampia.

• È possibile impostare la schermata di login in modo che mostri un'immagine come segue:

• Menu Start > Impostazioni > Informazioni su di me (Foto)

• Inserisci i dettagli che desideri aggiungere.

• Fare clic sull'icona, quindi selezionare l'immagine che si desidera utilizzare.

• Chiudi

• Manuale



• Crea o seleziona un'immagine e utilizza nomacs o un altro editor di foto per 
ridimensionarla a circa 96x96 pixel

• Salva l'immagine nella tua cartella home come .face (assicurati di includere il punto e 
non aggiungere alcuna estensione come jpg o png).

• Clicca su Tutte le impostazioni > Impostazioni LightDM GTK+ Greeter, scheda 
Aspetto: attiva l'opzione Immagine utente.

• Qualunque sia la modalità scelta, esci dal sistema e vedrai l'immagine accanto alla casella di 
login; apparirà anche nel menu Whisker una volta effettuato nuovamente l'accesso.

SDDM

Figura 3-51: l'applicazione di configurazione SDDM.

• Le impostazioni SDDM si trovano tutte nelle Impostazioni di sistema del desktop Plasma. Un 
lanciatore di scorciatoie per le Impostazioni di sistema si trova sul pannello predefinito di MX, 
oppure è possibile cercarlo nel menu Applicazioni. Nelle Impostazioni, andare su Avvio e 
spegnimento
>> Schermata di login (SDDM).

• La pagina delle impostazioni di SDDM ti consentirà di:

■ scegliere tra diversi temi se ne hai installati più di uno

■ scegliere di personalizzare lo sfondo per il tema selezionato

■ rimuovere (cioè eliminare) un tema installato

■ ottenere/installare nuovi temi direttamente dal KDE Store online o da un file sul tuo disco 
rigido/supporto di memoria (vedi sotto)

• password di root richiesta: poiché il desktop manager è un programma di sistema, qualsiasi modifica 
ad esso o alla sua configurazione influirà sui file nella partizione root, motivo per cui ti verrà richiesta 
la password di root.

• Selezione dello sfondo: puoi modificare lo sfondo del tema SDDM selezionato. Alcuni temi sono 
dotati di un'immagine di sfondo predefinita preinstallata



che verrà visualizzata se non si apportano modifiche. Anche in questo caso sarà necessaria la 
password di root.

• I nuovi temi SDDM sono disponibili nel KDE Store. È anche possibile sfogliare i temi direttamente 
dalla pagina Impostazioni di sistema per SDDM.

• In Impostazioni di sistema > Avvio e spegnimento > Schermata di login (SDDM), scaricare nuove 
schermate di login nella parte inferiore della finestra.

• Per installare un tema:

■ da un file zip scaricato, cliccare sul pulsante «Installa da file» nella pagina Impostazioni di sistema 
per SDDM, quindi selezionare il file zip desiderato dal selettore di file che si apre.

■ Nel browser dei temi SDDM integrato nelle Impostazioni di sistema, è sufficiente fare clic sul 
pulsante «Installa» del tema selezionato.

NOTA: alcuni temi nel KDE Store potrebbero essere incompatibili. MX 25 utilizza la versione stabile di Plasma 
disponibile per Debian 13 (Trixie). Potresti quindi scoprire che alcuni dei temi SDDM più recenti, creati per 
utilizzare le ultime funzionalità di Plasma, potrebbero non funzionare con SSDM di Plasma 5.27. Fortunatamente 
SDDM è dotato di una schermata di login di fallback, quindi se un tema applicato non funziona, è comunque 
possibile accedere al desktop e da lì passare a un altro tema SDDM. Fate qualche prova: alcuni temi molto recenti 
funzionano, mentre altri no.

3.8.9 Bootloader

Il bootloader (GRUB) di MX Linux installato può essere modificato con opzioni comuni facendo clic su Menu 
Start > MX Tools > MX Boot Options (vedere la Sezione 3.2). Per altre funzioni, installare Grub Customizer. 
Questo strumento deve essere usato con cautela, ma consente agli utenti di configurare le impostazioni di Grub 
come la configurazione dell'elenco delle voci di avvio, i nomi delle partizioni, il colore delle voci di menu, ecc. 
Dettagli qui.

3.8.10 Suoni di sistema ed eventi

Xfce

I segnali acustici del computer sono disattivati per impostazione predefinita nelle righe della "lista nera" nel file 
/etc/modprobe.d/pc-speaker.conf. Commentare (# all'inizio) quelle righe come root se si desidera ripristinarle.

I suoni degli eventi possono essere attivati a livello di sistema facendo clic sul menu Start > Impostazioni > 
Aspetto, scheda Altro: selezionare Abilita suoni degli eventi e, se lo si desidera, Abilita suoni di feedback 
dell'input. Possono essere gestiti con MX System Sounds (Sezione 3.2). Se non si sentono piccoli suoni quando si 
chiude una finestra o si esce dal sistema, ad esempio, provare questi passaggi:

• Esci e rientra.

• Fai clic sul menu Start > Multimedia > Controllo volume PulseAudio, scheda Riproduzione, e regola il 
livello secondo necessità (inizia con il 100%).

https://store.kde.org/browse/cat/101/order/latest
https://answers.launchpad.net/grub-customizer/%2Bfaq/1355


• Fai clic sul menu Start, digita "!alsamixer" (non dimenticare il punto esclamativo). Apparirà una 
finestra di terminale con un unico controllo audio (Pulseaudio Master).

• Usa F6 per selezionare la tua scheda audio, quindi regola i canali che appaiono su volumi 
più alti.

• Cerca canali come "Surround", "PCM" "Altoparlanti", "Master_Surround", "Master_Mono" 
o "Master". I canali disponibili dipendono dal tuo hardware specifico.

Di default sono forniti tre file audio: Borealis, Freedesktop e Fresh and Clean. Tutti si trovano in /usr/share/sounds. 
Ne puoi trovare altri nei repository o con una ricerca sul web.

KDE

Per impostare i suoni di sistema, clicca su Impostazioni di sistema > Notifiche > Impostazioni applicazione > 
Plasma Workspace > Configura eventi.

3.8.11 Applicazioni predefinite

Generale

Le applicazioni predefinite da utilizzare per le operazioni generali vengono impostate facendo clic su Menu Applicazioni
> Impostazioni > Applicazioni predefinite (Xfce) o Impostazioni di sistema > Applicazioni > 
Applicazioni predefinite (KDE/Plasma). Qui è possibile impostare quattro preferenze (Xfce: schede 
separate per Internet e Utilità).

• Browser

• Lettore di posta

• Gestione file

• Emulatore di terminale

• Altro (Xfce)

• Mappa (KDE)

• Compositore numerico (KDE)

Applicazioni particolari

Molte impostazioni predefinite per tipi di file specifici vengono configurate durante l'installazione di 
un'applicazione. Tuttavia, spesso esistono più opzioni per un determinato tipo di file e l'utente desidera decidere 
quale applicazione avviare per aprire il file, ad esempio il lettore musicale per aprire un file *.mp3.

L'applicazione Applicazioni predefinite di Xfce ha una terza scheda, "Altri", in cui è possibile impostare questi tipi 
MIME utilizzando una comoda tabella ricercabile per trovare il tipo, quindi facendo doppio clic sullo spazio 
Applicazione predefinita per impostare l'applicazione desiderata.

Metodo generale



• Fai clic con il pulsante destro del mouse su un esempio del tipo di file che ti interessa

• Effettuare una delle seguenti selezioni:

• Apri con <applicazione elencata>. In questo modo il file verrà aperto con l'applicazione 
selezionata per questo caso specifico, ma non influirà sull'applicazione predefinita.

• Apri con altra applicazione. Scorri l'elenco per evidenziare quella desiderata (inclusa «Usa un 
comando personalizzato»), quindi seleziona Apri. La casella in basso «Usa come predefinita per 
questo tipo di file» è deselezionata per impostazione predefinita, quindi selezionala se desideri che 
la tua selezione diventi la nuova applicazione predefinita che viene avviata quando fai clic su 
qualsiasi file di quel particolare tipo. Lasciala deselezionata per un utilizzo una tantum.

Figura 3-52: Modifica dell'applicazione predefinita Sinistra: Thunar Destra: Dolphin.

3.8.12 Account limitati

Per alcuni scopi, potrebbe essere opportuno bloccare un'applicazione o un sistema per proteggerlo dagli utenti. Ne 
sono un esempio i computer in una scuola o in un luogo pubblico ad uso generale, dove è necessario chiudere il 
file system, il desktop e l'accesso a Internet. Sono disponibili diverse opzioni.

• Alcuni componenti di Xfce che supportano la modalità kiosk. Dettagli nella Wiki di Xfce.

• KDE ha una modalità amministrativa, consultare la KDE Userbase.

• Controlla il browser che utilizzi per vedere se dispone di una modalità kiosk.

• La distribuzione dedicata ai chioschi Porteus.

https://wiki.xfce.org/howto/kiosk_mode
https://userbase.kde.org/KDE_System_Administration
http://porteus-kiosk.org/index.html




4.1 Internet 

4.1.1 Browser web

• MX Linux viene fornito con il popolare browser Firefox già installato, che dispone di un'ampia 
gamma di componenti aggiuntivi per migliorare l'esperienza dell'utente.

Home page di Firefox

Componenti aggiuntivi di Firefox

• Gli aggiornamenti di Firefox vengono forniti tramite i repository MX Linux e sono solitamente 
disponibili per gli utenti entro 24 ore dal rilascio. Per il download diretto, vedere la Sezione 5.5.5.

• I file di localizzazione per Firefox possono essere installati facilmente con MX Package Installer.

• Firefox dispone di un servizio di sincronizzazione che facilita il trasferimento di segnalibri, cookie, ecc. 
da un'installazione Firefox esistente.

• Altri browser sono disponibili per il download e l'installazione tramite MX Package Installer. 
Consulta il Wiki MX/antiX per suggerimenti e trucchi di configurazione.

4.1.2 Posta elettronica

• Thunderbird è installato di default in MX Linux. Questo popolare client di posta elettronica si integra 
bene con Google Calendar e Google Contacts. Le versioni più recenti disponibili si trovano in MX 
Package Installer > MX Test Repo.

• File di localizzazione per Thunderbird: MX Package Installer > Lingua.

• Per assistenza con i link che non aprono più il browser, consulta il Wiki MX/antiX.

• Altri client di posta elettronica leggeri sono disponibili dall'MX Package Installer.

4.1.3 Chat

• HexChat. Questo programma di chat IRC facilita lo scambio di messaggi di testo.

Home page di HexChat

• Pidgin. Questo client di messaggistica istantanea grafico e modulare è in grado di utilizzare più reti 
contemporaneamente. MX Package Installer.

4 Utilizzo di base

https://www.mozilla.org/
https://addons.mozilla.org/en-US/firefox/
https://mxlinux.org/wiki/applications/
https://www.thunderbird.net/
https://mxlinux.org/wiki/applications/thunderbird/
https://hexchat.github.io/


Home page di Pidgin

Chat video

• Zoom. Questo programma di videochat molto popolare si installa facilmente su MX Linux e 
si integra automaticamente con PulseAudio. MX Package Installer.

• Gmail ha una funzione di chat integrata, ora chiamata Google Meet. Vedi Sezione 4.10.6

• Skype. Un popolare programma proprietario per la messaggistica istantanea e la chat vocale e 
video. MX Package Installer.

Risoluzione dei problemi Pagina iniziale di Skype

• Se la tua voce non viene rilevata anche dopo aver utilizzato gli strumenti dell'app, prova 
questo:

• Accedi alla tua app di chat video, clicca su Opzioni e vai alla scheda Dispositivi 
audio.

• Fai clic sul pulsante per avviare una chiamata di prova. Durante la chiamata, apri 
PulseAudio Volume Control e vai alla scheda Registrazione.

• Sempre mentre la chiamata di prova è in corso, cambia Skype con il microfono 
della webcam.

4.2 Multimedia 

Di seguito sono elencate alcune delle numerose applicazioni multimediali disponibili in MX Linux. Esistono 
anche applicazioni professionali avanzate, che possono essere trovate tramite ricerche mirate in Synaptic.

4.2.1 Musica

Figura 4-1: Riproduzione di un brano da CD con Strawberry.

• Lettori

http://pidgin.im/
https://zoom.us/
https://meet.google.com/
https://www.skype.com/en/


• Strawberry. Un moderno lettore musicale e organizzatore di librerie in grado di riprodurre 
qualsiasi fonte, dai CD ai servizi cloud. Installato di default.

Home page di Strawberry

• Audacious. Un lettore musicale completo e un gestore. MX Package Installer.

Home page di Audacious

• DeaDBeeF. Un lettore leggero con un ingombro di memoria ridotto, un solido set di funzioni 
di base e un'attenzione particolare alla riproduzione musicale. MX Package Installer.

Home page di DeaDBeeF

• Ripper ed editor

• Asunder. Un ripper e codificatore grafico di CD audio che può essere utilizzato per salvare 
brani da CD audio. Installato di default.

Home page di Asunder

• EasyTAG. Una semplice applicazione per visualizzare e modificare i tag nei file audio.

Home page di EasyTAG

4.2.2 Video

 VIDEO: AGGIORNAMENTO: Netflix su Linux a 32 bit

• Lettori

• VLC. Riproduce un'ampia gamma di formati video e audio, DVD, VCD, podcast e flussi 
multimediali da varie fonti di rete. Installato di default.

Home page di VLC

• Un browser YouTube per SM Player (non installato di default).

Home page di SMplayer

• Netflix. La funzionalità desktop di streaming Netflix per i titolari di account è disponibile per 
Firefox e Google Chrome.

Home page di Netflix

https://github.com/strawberrymusicplayer/strawberry
http://audacious-media-player.org/
http://deadbeef.sourceforge.net/
http://littlesvr.ca/asunder/
https://wiki.gnome.org/Apps/EasyTAG
https://www.youtube.com/watch?v=fY_PqMJ5kG4
http://www.videolan.org/vlc/
http://smplayer.sourceforge.net/
https://www.netflix.com/us/


Figura 4-2: Esecuzione di Netflix desktop in Firefox.

• Ripper ed editor

• HandBrake. Un ripper video facile da usare, veloce e semplice. Installalo con MX 
Package Installer.

Home page di HandBrake

• DeVeDe. Questa utility converte automaticamente il materiale in formati compatibili con 
gli standard dei CD audio e dei DVD video.

Home page di DeVeDe

• DVDStyler. Un'altra ottima utility di authoring. MX Package Installer.

Home page di DVDStyler

• OpenShot. Un editor video semplice da usare e ricco di funzionalità. MX Package 
Installer.

Home page di OpenShot

https://handbrake.fr/
http://www.rastersoft.com/programas/devede.html
http://www.dvdstyler.org/en/
http://www.openshot.org/


4.2.3 Foto

Figura 4-3: Utilizzo dello strumento di ritaglio in Nomacs.

• Nomacs. Un visualizzatore di immagini veloce e potente installato di default.

Home page di Nomacs

• Mirage. Questa applicazione veloce è facile da usare e consente di visualizzare e modificare foto 
digitali. MX Package Installer.

Pagina del progetto Mirage

• Fotoxx. Questa applicazione veloce consente di modificare facilmente le foto e gestire le raccolte, 
soddisfacendo al contempo le esigenze dei fotografi professionisti. MX Package Installer > MX 
Test Repo.

Home page di Fotoxx

• GIMP. Il miglior pacchetto di manipolazione delle immagini per Linux. La guida (gimp-help) deve 
essere installata separatamente ed è disponibile in molte lingue. Pacchetto base installato di default, 
versione completa disponibile da MX Package Installer.

Home page di GIMP

• gThumb. Un visualizzatore di immagini e browser degli sviluppatori GNOME che include anche uno 
strumento di importazione per trasferire le foto dalle fotocamere.

Wiki di gThumb

• LazPaint, un editor di immagini leggero e multipiattaforma con livelli raster e vettoriali.

https://nomacs.org/
http://sourceforge.net/projects/mirageiv.berlios/
http://www.kornelix.net/fotoxx/fotoxx.html
http://www.gimp.org/
http://gthumb.sourceforge.net/features.html


Documentazione di LazPaint

• Gwenview, il visualizzatore di immagini del progetto KDE

Figura 4-4: Gwenview.

4.2.4 Screencasting

Figura 4-5: Schermata principale di SimpleScreenRecorder.

• SimpleScreenRecorder. Un programma semplice ma potente per registrare programmi e 
giochi. Installabile tramite MX Package Installer.

Home page di SimpleScreenRecorder

• RecordMyDesktop. Cattura i dati audio-video di una sessione desktop Linux. Installabile tramite MX 
Package Installer.

Home page di RecordMyDesktop.

https://wiki.freepascal.org/LazPaint
http://www.maartenbaert.be/simplescreenrecorder/
http://recordmydesktop.sourceforge.net/about.php


4.2.5 Illustrazioni

• mtPaint. Un'applicazione facile da imparare per creare pixel art e manipolare foto digitali. 
Installabile tramite MX Package Installer.

Home page di mtPaint

• LibreOffice Draw. Con questa applicazione è possibile creare e modificare diagrammi, disegni e 
immagini.

Home page di LO Draw

• Inkscape. Questo editor di illustrazioni ha tutto il necessario per creare grafica computerizzata di 
qualità professionale. MX Package Installer.

Home page di Inkscape

4.3 Office 

4.3.1 Suite per ufficio

Desktop

LibreOffice

MX Linux include un'ottima suite per ufficio gratuita chiamata LibreOffice, che è l'equivalente Linux e quasi un 

sostituto diretto di Microsoft Office®. La suite è disponibile nel menu Applicazioni > Ufficio > LibreOffice. 

LibreOffice supporta i formati di file .docx, .xlsx e .pptx di Microsoft Office. È installata l'ultima versione stabile 

disponibile nei repository predefiniti, ma è possibile installare versioni più recenti

• Scaricare direttamente da LibreOffice. Per ulteriori dettagli, consultare il Wiki MX/antiX.

• Scaricare da MX Package Installer, scheda Debian Backports (se disponibile).

• Scaricare Flatpak (MX Package Installer) o Appimage (se disponibile).

http://mtpaint.sourceforge.net/
http://www.libreoffice.org/discover/draw/
https://inkscape.org/en/
https://mxlinux.org/wiki/applications/libreoffice/
https://www.libreoffice.org/download/appimage/


Figura 4-6: Dashboard principale in LibreOffice 7.4.5.1.

• Elaboratore di testi: LibreOffice Writer. Un elaboratore di testi avanzato compatibile con i 
file .doc e .docx.

• Foglio di calcolo: LibreOffice Calc. Un foglio di calcolo avanzato compatibile con i file .xls 
e .xlsx.

• Presentazioni: LibreOffice Impress. Presentazioni compatibili con i file .ppt e .pptx.

• Draw: LibreOffice Draw. Utilizzato per creare grafici e diagrammi.

• Matematica: LibreOffice Math. Utilizzato per equazioni matematiche.

• Base: LibreOffice Base. Utilizzato per creare e manipolare database. Se si utilizza questa 
applicazione per creare o utilizzare database nel formato nativo LibreOffice, è necessario 
verificare che libreoffice-sdbc-hsqldb e libreoffice-base-drivers corrispondenti alla 
versione siano stati installati.

LINK

• Home page di LibreOffice.

• Wiki MX/antiX.

https://www.libreoffice.org/
https://mxlinux.org/wiki/applications/libreoffice


Sono disponibili anche altre suite desktop.

• Softmaker Free Office -- MX Package Installer: Applicazioni popolari

• Calligra Suite (parte del progetto KDE) -- MX Package Installer: Test Repo

Nel cloud

Google Docs e Office Suite

Google Docs offre eccellenti applicazioni online che includono tre componenti standard per l'ufficio: Docs, 
Sheets e Slides. È facile condividere i file e le opzioni di esportazione sono molto pratiche.

Microsoft 365

I prodotti Microsoft non sono FOSS, ma molti utenti hanno bisogno o desiderano accedervi, soprattutto in 
contesti aziendali, istituzionali e simili. Sebbene le applicazioni della suite Microsoft Office non possano essere 
installate in modo nativo su Linux, Microsoft Office365 (servizio a pagamento) o On-line Office (gratuito) 
sono semplici pagine web che funzionano bene con qualsiasi browser moderno su MX Linux. Dettagli nella 
MX/antiX Wiki.

Altre opzioni

• OnlyOffice (servizio a pagamento per le imprese)

4.3.2 Finanze aziendali

• KMyMoney. Un gestore finanziario KDE per ambienti desktop e notebook. Consente agli utenti di 
tenere traccia delle proprie finanze personali fornendo un'ampia gamma di funzioni e strumenti 
finanziari. Può essere installato su Xfce. MX Package Installer.

Figura 4-7: Dashboard principale

Home page di KMyMoney

https://www.freeoffice.com/
https://www.calligra.org/
https://www.google.com/docs/about/
https://www.office.com/
https://products.office.com/en-us/office-online/documents-spreadsheets-presentations-office-online
https://mxlinux.org/wiki/applications/microsoft-office/
https://mxlinux.org/wiki/applications/microsoft-office/
https://www.onlyoffice.com/
https://kmymoney.org/


• GnuCash. Software finanziario per uso ufficio. È facile da imparare e consente di tenere traccia di 
conti bancari, azioni, entrate e uscite. Può importare dati in formato QIF, QFX e altri formati e 
supporta la contabilità a partita doppia. MX Package Installer. Il pacchetto di aiuto (gnucash-docs) 
deve essere installato separatamente.

Home page di GnuCash

Figura 4-8: Nuovo conto in GnuCash.

4.3.3 PDF

• QPDFview. Un visualizzatore veloce e leggero che include una serie di strumenti di base. Installato di 
default.

Home page di QpdfView

• Okular, il lettore di PDF e documenti del progetto KDE 

Documentazione di Okular

• Document Scanner (precedentemente SimpleScan) è un software di scansione minimale che funziona 
molto bene per le attività quotidiane. Installato di default su MX-25.

Home page di Document Scanner

• PDFArranger semplifica il riordino, l'eliminazione e l'aggiunta di pagine PDF. Installato di default.

PDF Arranger ReadMe

• gscan2pdf è un'applicazione tecnica per esigenze di scansione generiche. MX Package 

Installer. Pagina iniziale di gscan2pdf

• Per altre funzioni (ad esempio, la creazione di un modulo PDF), consultare MX/antiX Wiki.

http://gnucash.org/
https://launchpad.net/qpdfview
https://okular.kde.org/
https://gitlab.gnome.org/GNOME/simple-scan
https://github.com/pdfarranger/pdfarranger/blob/main/README.md
http://gscan2pdf.sourceforge.net/
https://mxlinux.org/wiki/applications/pdf


4.3.4 Pubblicazione desktop

• Scribus. Impaginazione professionale che produce output pronti per la stampa. MX Package 
Installer.

Home page di Scribus

4.3.5 Monitoraggio dei tempi di progetto

• Kapow punch clock. App semplice ma ricca di funzionalità per registrare il tempo dedicato al 
progetto. MX Package Installer.

Home page di Kapow

Figura 4.9 Kapow impostato per monitorare il lavoro su un progetto.

• Altre opzioni

4.3.6 Videochiamate e desktop remoto

• AnyDesk. Consente un facile accesso remoto. MX Package Installer, insieme ad altre opzioni.

Home page di AnyDesk

• TeamViewer. Applicazione multipiattaforma per assistenza remota e riunioni online. Gratuita per uso 
privato. MX Package Installer.

Home page di TeamViewer

• Zoom. Per installarlo: MX Package Installer > Messaggistica.

4.4 Home 

https://www.scribus.net/
https://gottcode.org/kapow/
https://www.linuxlinks.com/timetracking/
https://anydesk.com/en
https://anydesk.com/en
https://www.teamviewer.us/
https://zoom.us/


4.4.1 Finanze

• HomeBank. Gestione semplificata della contabilità personale, del budget e delle finanze.

Homepage di HomeBank

• Grisbi è in grado di importare file QIF/QFX e ha un'interfaccia intuitiva. Adatto alle banche al 
di fuori degli Stati Uniti.

Home page di Grisbi

• KMyMoney

Home page di KMyMoney

4.4.2 Media Center

• Plex Mediaserver. Consente di riunire tutti i tuoi file multimediali e visualizzarli in un unico posto. 
MX Package Installer.

Home page di Plex

• Kodi Entertainment Center (precedentemente XBMC) consente agli utenti di riprodurre e 
visualizzare video, musica, podcast e file multimediali da supporti di archiviazione locali e di rete. MX 
Package Installer.

Home page di Kodi

4.4.3 Organizzazione

• Note. Questo pratico plugin Xfce (xfce4-notes-plugin) consente di creare e organizzare note adesive 
per il desktop.

Home page di Notes

• KDE Pim Application, una suite di applicazioni per la gestione delle informazioni personali. 

https://community.kde.org/KDE_PIM

• Osmo. Graziosa applicazione Xfce compatta che include calendario, attività, contatti e note.

Home page di Osmo

http://homebank.free.fr/en/
http://www.grisbi.org/
https://kmymoney.org/
https://www.plex.tv/
http://kodi.tv/
http://goodies.xfce.org/projects/panel-plugins/xfce4-notes-plugin
https://community.kde.org/KDE_PIM
https://osmo-pim.sourceforge.net/


Figura 4-10: Il gestore di informazioni personali Osmo.

4.5 Sicurezza 

4.5.1 Firewall

Un firewall controlla il traffico in entrata e in uscita dal sistema. In MX Linux 25 è installato un firewall, abilitato e 
impostato per ignorare tutte le connessioni in entrata per impostazione predefinita.

Un firewall ben configurato è fondamentale per la sicurezza dei server. Ma cosa succede agli utenti desktop 
normali? È necessario un firewall sul sistema Linux? Probabilmente si è connessi a Internet tramite un 
router collegato al proprio provider di servizi Internet (ISP). Alcuni router dispongono già di un firewall 
integrato. Inoltre, il sistema effettivo è nascosto dietro NAT. In altre parole, probabilmente si dispone già di 
un livello di sicurezza quando si è sulla rete domestica. (Fonte, modificata)

Potreste voler o dover modificare questa configurazione predefinita:

• Potrebbe bloccare servizi come Samba, SSH, VNC, KDE Connect o stampanti di rete.

• Potresti essere in viaggio e avere preoccupazioni riguardo alla sicurezza locale.

• Potresti voler impostare una configurazione particolare per un ambiente di lavoro.

Figura 4-11: Schermata iniziale (a sinistra), aggiunta di un'eccezione per Samba (a destra)

https://en.wikipedia.org/wiki/Network_address_translation
https://itsfoss.com/set-up-firewall-gufw/#do-you-really-need-a-firewall-for-desktop


È facile modificare la configurazione del firewall personale con Firewall Configuration (gufw), installato di default 
in Xfce e Fluxbox (gli utenti KDE possono cercare gufw nel Package Installer):

• Seleziona un profilo (Casa, Ufficio o Pubblico)

• Fai clic sulla scheda "Regole" per aprire una finestra di dialogo con la scheda "Preconfigurato" selezionata

• Utilizza il menu a tendina per selezionare la configurazione dell'applicazione che desideri modificare

• Rivedere le modifiche suggerite e fare clic sul pulsante "Aggiungi" per abilitarle.

NOTA: la versione 4.7.x e successive di Samba utilizzano TCP sulla porta 445. Questo è tutto ciò che serve per le 
versioni più recenti di Windows

Documentazione della comunità Ubuntu

4.5.2 Antivirus

• ClamAV. Utile per impedire agli utenti Linux di trasmettere inconsapevolmente e-mail e altri 
documenti infetti da virus agli utenti Windows vulnerabili.

Home page di ClamAV

4.5.3 AntiRootkit

• chkrootkit. Questa applicazione esegue la scansione dei sistemi alla ricerca di rootkit, 
backdoor, sniffer ed exploit noti e sconosciuti.

Home page di chkrootkit

4.5.4 Protezione con password 

• Password e chiavi. Un gestore di password e chiavi installato di default. Dettagli sull'utilizzo nel 
Wiki MX/antiX.

Aiuto per password e chiavi

• KeePassX. Un gestore di password o cassaforte che ti aiuta a gestire le tue password in modo sicuro. 
MX Package Installer.

Home page di KeePassX

4.5.5 Accesso web
La maggior parte dei browser moderni dispone di componenti aggiuntivi che consentono un facile filtraggio web. 
FoxFilter è un esempio consolidato che per Firefox, Chrome e Opera consente di limitare i contenuti.

https://help.ubuntu.com/community/Gufw
https://sourceforge.net/projects/clamav/
http://www.chkrootkit.org/
https://mxlinux.org/wiki/applications/passwords-and-keys
https://help.gnome.org/users/seahorse/stable/
http://www.keepassx.org/


Figura 4-12: La scheda delle preferenze di FoxFilter.

4.6 Accessibilità 

Esistono varie utility open source per gli utenti MX Linux con disabilità.

• Tastiera su schermo. Onboard è installato di default e Florence è disponibile nei repository.

• Lente di ingrandimento dello schermo. Magnus (Xfce) e KTTS (KDE) sono installati di default. 
Scorciatoia (Xfce): Shift+Ctrl+M

• Dimensione del cursore. MX Tweak > Tema.

• Lettore di testo. Orca. Al momento, a causa del pacchetto Debian, Orca non compare nei menu ma può 
essere avviato manualmente. In KDE è configurabile nelle impostazioni di accessibilità integrate ed è 
disponibile una scorciatoia: Meta+Alt+S. Per l'utilizzo, consultare questo tutorial.

• Applicazioni assistive

• Xfce. Fare clic su Menu Applicazioni > Impostazioni > Accessibilità e selezionare 
Abilita tecnologie assistive. Modificare le opzioni disponibili in base alle proprie 
preferenze.

Documentazione Xfce4: Accessibilità

• KDE mantiene una vasta collezione di ausili per l'accessibilità.

Applicazioni di accessibilità KDE

• Debian. Molti altri strumenti sono disponibili all'interno di Debian stesso.

Wiki Debian

https://techblog.wikimedia.org/2020/07/02/an-orca-screen-reader-tutorial/
http://docs.xfce.org/xfce/xfce4-settings/accessibility
https://userbase.kde.org/Applications/Accessibility
https://wiki.debian.org/accessibility


4.7 Sistema 

4.7.1 Privilegi di root

Esistono due comandi comuni per ottenere i privilegi di root (ovvero amministratore, superutente) necessari per 
apportare modifiche al sistema (ad esempio, installare software) utilizzando un terminale.

• su: richiede la password di root e concede i privilegi per l'intera sessione del terminale

• sudo: richiede la password utente e concede i privilegi per un breve periodo di tempo

In altre parole, su consente di cambiare utente in modo da essere effettivamente connessi come root, mentre sudo 
consente di eseguire comandi nel proprio account utente con privilegi di root. Inoltre, su utilizza l'ambiente 
(configurazione specifica dell'utente) dell'utente root, mentre sudo consente modifiche a livello di root ma 
mantiene l'ambiente dell'utente che esegue il comando. A partire da MX-21, MX Linux utilizza sudo come 
impostazione predefinita.

L'utente può scegliere se utilizzare "Root" o "Utente" nella scheda "Altro" di MX Tweak.

ALTRO: clicca su Menu Applicazioni > inserisci "#su" o "#sudo" (senza virgolette) nello spazio di ricerca e torna 
indietro per vedere le pagine man dettagliate.

Esecuzione di un'applicazione root

Alcune applicazioni che si trovano nel menu Applicazioni richiedono che l'utente disponga dei privilegi di root: 
gparted, lightdm gtk+ greeter, ecc. A seconda di come è scritto il comando di avvio, la finestra di dialogo che 
appare potrebbe indicare che l'accesso root sarà memorizzato (impostazione predefinita) per tutta la durata della 
sessione (cioè fino al logout).

Figura 4-13: Finestra di dialogo quando si utilizza il comando pkexec (nessuna memorizzazione).



4.7.2 Ottenere le specifiche hardware 

• Fare clic su Menu Applicazioni > Sistema > Profilo di sistema e benchmark per visualizzare 
un'accattivante rappresentazione grafica che include i risultati di vari test.

• Fare clic su Menu Applicazioni > MX Tools > Informazioni rapide sul sistema. Il risultato viene 
copiato automaticamente negli appunti e può essere incollato in un post sul forum completo di tag di 
codice.

• Installare e utilizzare HardInfo. MX Package Installer.

Vedere la Sezione 6.5 per le molte altre funzionalità di inxi, il programma sottostante.

4.7.3 Creare collegamenti simbolici

Un collegamento simbolico (anche chiamato soft link o symlink) è un tipo speciale di file che punta a un altro file 
o cartella, molto simile a un collegamento in Windows o a un alias in Macintosh. Un collegamento simbolico non 
contiene dati effettivi (come invece fa un collegamento fisico), ma punta semplicemente a un'altra posizione nel 
sistema.

Esistono due modi per creare un collegamento simbolico: File Manager o la riga di comando.

• Thunar

• Passa al file o alla cartella (destinazione del collegamento) a cui desideri puntare da un'altra 
posizione o con un altro nome

• Fare clic con il tasto destro del mouse su ciò che si desidera collegare > Creare 
collegamento simbolico, e verrà creato un collegamento simbolico nella posizione corrente

• Fare clic con il tasto destro del mouse sul nuovo collegamento simbolico > Taglia

• Passa alla posizione in cui desideri inserire il collegamento, fai clic con il tasto destro del 
mouse su un'area libera > Incolla. Se lo desideri, modifica il nome del collegamento.

• Dolphin/KDE-Plasma

• Utilizza Crea nuovo > Collegamento di base a file o directory

• Riga di comando: apri un terminale e digita:

ln -s FileOCartellaDestinazione NomeCollegamento

• Ad esempio, per creare un collegamento simbolico a un file denominato "foo" nella cartella 
Download alla cartella Documenti, inserisci questo comando:

ln -s ~/Downloads/foo ~/Documents/foo



4.7.4 Trova file e cartelle

GUI
Xfce - Thunar

Figura 4-14: Schermata di ricerca di Catfish che cerca "MX-" nella cartella Download.

Catfish è installato di default in MX Linux Xfce e può essere avviato dal Menu Applicazioni > Accessori, o 
semplicemente digitando "search" nel campo di ricerca in alto. È anche integrato in Thunar, quindi l'utente può 
cliccare con il tasto destro su una cartella > Trova file qui.

Home page di Catfish

Gli utenti KDE/Plasma possono accedere alla finestra di dialogo Trova integrata nella barra degli strumenti del File Manager 
Dolphin.

Figura 4-15: Risultati della ricerca Trova di Dolphin.

Altri software di ricerca più avanzati come recoll sono disponibili nei repository.

http://www.twotoasts.de/index.php/catfish/
https://www.lesbonscomptes.com/recoll/


CLI

Esistono alcuni comandi molto utili da utilizzare in un terminale.

• locate. Per ogni modello specificato, locate cerca in uno o più database di nomi di file e visualizza 
quelli che contengono il modello. Ad esempio, digitando:

locate firefox

restituirà un elenco estremamente lungo con ogni singolo file che contiene la parola "firefox" nel nome o 
nel percorso. Questo comando è simile a find ed è più indicato quando si conosce il nome esatto del file.

Esempi di locate

• whereis. Un altro strumento da riga di comando, installato di default. Per ogni modello specificato, 
whereis cerca in uno o più database di nomi di file e visualizza i nomi dei file che contengono il 
modello, ma ignora i percorsi, quindi l'elenco restituito è molto più breve. Ad esempio, digitando:

whereis firefox

restituirà un elenco molto più breve simile a questo:

firefox: /usr/bin/firefox /etc/firefox /usr/lib/firefox
/usr/bin/X11/firefox /usr/share/firefox
/usr/share/man/man1/firefox.1.gz

Esempi di whereis

• which: Probabilmente lo strumento più comodo di tutti, questo comando cerca di identificare 
l'eseguibile. Ad esempio, digitando:

restituisce un unico 
elemento:

Quali esempi

which firefox

/usr/bin/firefox

4.7.5 Eliminare i programmi in esecuzione

• Desktop

1. Premere Ctrl-Alt-Esc per trasformare il cursore in una "x". Fare clic su qualsiasi schermata 
aperta per terminarla, fare clic con il tasto destro per annullare. Fare attenzione a non fare 
clic sul desktop, altrimenti la sessione terminerà bruscamente.

2. Xfce - Task Manager: Menu Applicazioni > Sistema > Task Manager. Seleziona il 
processo desiderato e fai clic con il tasto destro del mouse per arrestarlo, terminarlo o 
ucciderlo.

3. KDE/Plasma – Menu Applicazioni > Preferiti, oppure clicca su Menu Applicazioni > 
Sistema > Monitor di sistema

http://www.tecmint.com/35-practical-examples-of-linux-find-command/
http://www.thegeekstuff.com/2012/03/locate-command-examples/
http://www.cyberciti.biz/faq/unix-linux-whereis-command-examples-to-locate-binary/
http://www.thegeekstuff.com/2013/04/linux-which-whatis-whereis/


4. È disponibile anche uno strumento tradizionale: clicca su Menu Applicazioni > Sistema > 
Htop, che apre un terminale che mostra tutti i processi in esecuzione. Individua il programma 
che desideri arrestare, evidenzialo, premi F9, quindi Invio.

• Terminale: premi Ctrl-C, che di solito arresta un programma/comando avviato in una sessione 
terminale.

• Se le soluzioni sopra indicate non funzionano, prova questi metodi più estremi (elencati in ordine 
crescente di gravità).

1. Riavvia X. Premi Ctrl-Alt-Bksp per terminare tutti i processi della sessione, tornando alla 
schermata di login. Qualsiasi lavoro non salvato andrà perso.

2. Usa il tasto magico SysRq (REISUB). Tieni premuto il tasto Alt (a volte funziona solo il tasto 
Alt sinistro) insieme al tasto SysRq (che può anche essere etichettato come Print Screen o 
PrtScrn) con l'altra mano, quindi lentamente, senza rilasciare Alt-SysRq, premi i tasti R-E-I-
S-U-B uno dopo l'altro. Tieni premuto ogni tasto della sequenza REISUB per circa 1 o 2 
secondi prima di passare al tasto successivo; il sistema dovrebbe spegnersi correttamente e 
riavviarsi. Lo scopo di questo tasto magico è quello di passare attraverso diverse fasi che 
consentono al sistema di uscire in modo sicuro da un guasto di qualche tipo, e spesso sono 
sufficienti solo le prime 2 lettere. Ecco cosa succede quando si passano le lettere:

• R - cambia la modalità della tastiera. Si dice che questo comando "cambi la tastiera 
dalla modalità raw, utilizzata da programmi come X11 e svgalib, alla modalità XLATE" 
(da Wikipedia), ma non è chiaro se questo abbia normalmente un effetto significativo.

• E - Termina in modo corretto tutti i programmi in esecuzione. Questo invia il 
segnale SIGTERM a tutti i processi tranne init e quindi chiede loro di terminare in 
modo corretto, dando loro la possibilità di riordinare e liberare le loro risorse, salvare i 
dati, ecc...

• I - Termina forzatamente tutti i programmi in esecuzione. È simile a E, ma invia il 
segnale SIGKILL a tutti i processi tranne init, che li termina immediatamente e 
forzatamente.

• S - sincronizza tutti i dischi e svuota le loro cache. Tutti i dischi hanno normalmente 
una cache di scrittura, un pezzo di RAM in cui il sistema memorizza i dati che vuole 
salvare sul dispositivo, per velocizzare l'accesso. La sincronizzazione dice al sistema di 
svuotare queste cache e di eseguire tutte le scritture rimanenti. In questo modo non si 
perdono i dati che sono già stati memorizzati nella cache ma non ancora scritti, e si evita 
di lasciare il file system in uno stato incoerente.

https://en.wikipedia.org/wiki/Magic_SysRq_key


• U - smonta tutti i dischi e li rimonta in sola lettura. Anche in questo caso si tratta di 
un'operazione piuttosto banale, che semplicemente rende tutti i dischi montati di sola 
lettura per impedire ulteriori scritture (parziali).

• B - riavvia il sistema. Questo riavvia il sistema. Tuttavia, non esegue uno 
spegnimento pulito, ma un hard reset.

Wikipedia: REISUB

3. Se non funziona nient'altro, tenere premuto il pulsante di accensione del computer per 
circa 10 secondi fino allo spegnimento.

Figura 4-16: Task Manager, pronto per terminare un processo. A destra: KDE/Plasma A sinistra: Xfce.

4.7.6 Monitorare le prestazioni 

Generale

• GUI

• Fare clic su Menu Applicazioni > Sistema > Profiler di sistema e benchmark, dove è 
possibile non solo visualizzare numerose specifiche, ma anche eseguire test delle 
prestazioni.

• Molti conkies mostrano alcune prestazioni del sistema; usa MX Conky per visualizzarne 
l'anteprima in base alle tue esigenze e preferenze. Vedi la Sezione 3.8.3.

• Plugin Xfce. Una varietà di plugin per il monitoraggio del sistema può essere inserita nel 
pannello, tra cui Monitor batteria, Monitor frequenza CPU, Grafico CPU, Monitor 
prestazioni disco, Controllo spazio libero, Monitor di rete, Plugin sensore, Monitor carico di 
sistema e Wavelan. Tutti possono essere installati con il metapacchetto xfce4-goodies. 
KDE/plasma ha un set simile di widget per il pannello e il desktop.

Home page di Xfce4 Goodies

https://en.wikipedia.org/wiki/Magic_SysRq_key
http://goodies.xfce.org/projects/panel-plugins/start


• CLI

• lm-sensors. Questo pacchetto per il monitoraggio dello stato dell'hardware è installato di 
default in MX Linux. Apri un terminale e inserisci con su o sudo:

sensors-detect

Fare clic su Invio per rispondere sì a tutte le domande. Al termine, sarà possibile ottenere 
informazioni dettagliate sulle letture dei sensori disponibili nel sistema aprendo un terminale e 
digitando: sensors.

Home page di Lm-sensors

Batteria

Il livello della batteria è monitorato dal plugin Power Manager (Xfce) sul pannello. È disponibile anche un plugin 
dedicato chiamato Battery Monitor, accessibile facendo clic con il tasto destro del mouse sul pannello > Pannello > 
Aggiungi nuovi elementi ...

KDE ha un widget del pannello Battery Monitor installato di default.

4.7.7 Pianificazione delle attività

• GUI

• MX Job Scheduler, vedere la Sezione 3.2.

• Attività pianificate (gnome-schedule). Un modo molto pratico per pianificare le attività di 
sistema senza dover modificare direttamente i file di sistema. Pagina iniziale di Gnome-
schedule.

• KDE dispone di un Task Scheduler con funzionalità simili.

Figura 4-17: Schermata principale del Task Scheduler di KDE.

• CLI

• È possibile modificare direttamente crontab, un file di testo contenente un elenco di 
comandi da eseguire in momenti specifici.

https://wiki.archlinux.org/index.php/Lm_sensors
http://gnome-schedule.sourceforge.net/
http://gnome-schedule.sourceforge.net/
https://userbase.kde.org/System_Settings/Task_Scheduler


Panoramica di crontab

Generatore di crontab facile da usare

4.7.8 Ora corretta

L'impostazione dell'ora corretta viene normalmente effettuata all'avvio di Live o durante l'installazione. Se l'ora 
dell'orologio è sempre sbagliata, ci sono 4 possibili problemi:

• fuso orario errato

• selezione errata tra UTC e ora locale

• Orologio BIOS impostato in modo errato

• deriva temporale

Questi problemi possono essere risolti facilmente utilizzando MX Date & Time > Menu Applicazioni > Sistema 
(Sezione 3.4); per le tecniche da riga di comando, consultare il Wiki MX/antiX.

4.7.9 Mostra blocco tasti
Su molti laptop non è presente alcuna spia luminosa che indichi l'attivazione dei tasti CapsLock o NumLock, il che 
può essere molto fastidioso. Per risolvere questo problema con un avviso sullo schermo, installare indicator-
keylock dai repository.

4.8 Buone pratiche 

4.8.1 Backup
La pratica più importante è eseguire regolarmente il backup dei dati e dei file di configurazione, un processo facile 
in MX Linux. Si consiglia vivamente di eseguire il backup su un'unità diversa da quella su cui si trovano i dati! 
L'utente medio troverà comodo uno dei seguenti strumenti grafici.

Figura 4-18: Schermata principale di Lucky Backup.

https://mxlinux.org/wiki/system/crontab/
http://crontab-generator.org/
https://mxlinux.org/wiki/system/time-settings
https://wiki.archlinux.org/index.php/Backup_programs


• MX Snapshot, uno strumento MX. Vedere la Sezione 3.4.

Panoramica

• gRsync, un'interfaccia grafica per rsync.

Panoramica di gRsync

• LuckyBackup. Un programma facile da usare per eseguire il backup e la sincronizzazione dei file. Installato di default.

Manuale di LuckyBackup

• Déjà Dup. Uno strumento di backup semplice ma molto efficace.

Home page di Déjà Dup

• BackInTime. Un'applicazione ben collaudata disponibile da MX Package Installer > MX Test Repo 
(preinstallata su MX KDE).

• Servizio cloud. Esistono molti servizi cloud che possono essere utilizzati per il backup o la 
sincronizzazione dei dati. DropBox e Google Drive sono probabilmente i più conosciuti, ma ne 
esistono molti altri.

• Clonazione. Crea un'immagine completa del disco rigido.

• Clonezilla. Scarica Clonezilla Live dalla home page di Clonezilla, quindi riavvia il sistema.

• Timeshift. Backup/ripristino completo del sistema; nei repository. La home page di 
Timeshift include una panoramica dettagliata e le istruzioni per l'uso.

• Salvare il sistema su un ISO live (Sezione 6.6.3).

• Strumenti CLI. Vedi la discussione nell'Arch Wiki: Clonazione

• Comandi CLI per eseguire backup (rsync, rdiff, cp, dd, tar, ecc.).

Dati

Assicurati di eseguire il backup dei tuoi dati, inclusi documenti, grafica, musica e posta. Per impostazione 
predefinita, la maggior parte di questi dati è memorizzata nella directory /home; ti consigliamo, se possibile, di 
avere una partizione dati separata, preferibilmente in una posizione dati esterna.

File di configurazione

Ecco un elenco di elementi da considerare per il backup.

https://mxlinux.org/wiki/help-files/help-mx-save-system-to-iso-snapshot/
https://en.wikipedia.org/wiki/Rsync
https://www.dedoimedo.com/computers/grsync.html
http://luckybackup.sourceforge.net/manual.html
https://launchpad.net/deja-dup
http://clonezilla.org/
http://clonezilla.org/
https://github.com/teejee2008/timeshift
https://github.com/teejee2008/timeshift
https://wiki.archlinux.org/index.php/disk_cloning


• /home. Contiene la maggior parte dei file di configurazione personali.

• /root. Contiene le modifiche apportate come root.

• /etc/X11/xorg.conf. File di configurazione X, se presente.

• I file GRUB2 /etc/grub.d/ e /etc/default/grub.

Elenco dei pacchetti di programmi installati

È anche una buona idea salvare nella directory /home o nel cloud (Dropbox, Google Drive, ecc.) un file che 
contenga l'elenco dei programmi che hai installato con Synaptic, apt o Deb Installer. Se in futuro dovessi 
reinstallare il sistema, potrai recuperare i nomi dei file per la reinstallazione.

• Il modo più semplice è utilizzare MX User Installed Packages. Vedere la Sezione 3.4.

• Puoi creare un inventario di tutti i pacchetti installati sul tuo sistema dall'installazione copiando questo 
lungo comando ed eseguendolo in un terminale:

dpkg -l | awk '/^[i|h]i/{ print $2 }' | grep -v -e ^lib[0-q\|s-z] -e ^libr[0-d\|f-z] -e ^libre[0-n\|p-z] -e -dev$ -e -dev: -e linux-image -e linux-
headers | awk '{print $1" installed"}' | column -t > apps_installed.txt

Questo comando creerà un file di testo nella tua directory home chiamato "apps_installed.txt" che contiene 
tutti i nomi dei pacchetti.

Per reinstallare TUTTI questi pacchetti contemporaneamente: assicurati che tutti i repository necessari 
siano abilitati, quindi esegui questi comandi uno alla volta:

sudo dpkg \SpecialChar nobreakdash\SpecialChar nobreakdashset-selections < 
apps_installed.txt
apt-get update
apt-get dselect-upgrade

NOTA: questa operazione non deve essere eseguita tra versioni MX basate su versioni Debian diverse (ad 
esempio, da MX-19.4 a MX-21).

4.8.2 Manutenzione del disco
Con il passare del tempo, il sistema accumula spesso dati che non vengono più utilizzati e che riempiono 
gradualmente il disco. Questi problemi possono essere alleviati utilizzando periodicamente MX Cleanup.

Vediamo un esempio. Quando la sua macchina stava rallentando, un utente ha controllato lo spazio libero sul disco 
utilizzando inxi -D ed è rimasto sorpreso nel vedere che il disco era pieno al 96%. Disk Usage Analyzer ha fornito 
una buona analisi grafica. Dopo averlo pulito utilizzando MX User Manager, la percentuale è scesa a circa il 63% e 
la lentezza è scomparsa.



Figura 4-19. A sinistra: Disk Usage Analyzer mostra una directory root quasi piena. A destra: 
risultato della pulizia della cache come rappresentato da Disk Usage Analyzer.

Deframmentazione
Gli utenti provenienti da Windows potrebbero chiedersi se sia necessario deframmentare periodicamente l'unità. La 
deframmentazione non è probabilmente necessaria sul file system ext4 predefinito di MX, ma se è quasi pieno e non 
ha un'area contigua abbastanza grande da allocare il file, si finirà con la frammentazione. Se necessario, è possibile 
controllare lo stato con questo comando:

sudo e4defrag -c /

Dopo pochi secondi verrà visualizzato un punteggio e una semplice indicazione sulla necessità o meno di 
deframmentazione.

4.8.3 Controllo degli errori
Molti messaggi di errore vengono scritti nel file appropriato in /var/log/ che copre i problemi relativi ad 
applicazioni, eventi, servizi e sistema. Alcuni dei più importanti includono:

• /var/log/boot

• /var/log/dmesg

• /var/log/kern.log

• /var/log/messages

• /var/log/Xorg.0.log

È possibile visualizzare questi log comodamente utilizzando Quick System Info.

4.9 Giochi 
Sfogliando l'ampio elenco di giochi disponibili tramite Synaptic (fare clic su Sezioni > Giochi nella parte inferiore 
del pannello di sinistra) o seguendo i collegamenti riportati di seguito, è possibile trovare molti altri titoli con cui 
divertirsi.

Il seguente elenco contiene alcuni esempi per stuzzicare il tuo appetito.

4.9.1 Giochi di avventura e sparatutto
• Chromium B.S.U.: uno sparatutto spaziale a scorrimento verticale in stile arcade dal ritmo serrato.



Home page di Chromium B.S.U.

• Beneath A Steel Sky: un thriller fantascientifico ambientato in un cupo futuro post-apocalittico. 

Home page di Beneath a Steel Sky

• Kq: un gioco di ruolo in stile console, simile a Final Fantasy. Pagina iniziale 

di Kq

• Mars. "Uno sparatutto assurdo." Proteggi il pianeta dai tuoi vicini invidiosi! Pagina 

iniziale di Mars

Figura 4-20: Navi da guerra nemiche in attacco in Chromium B.S.U.

4.9.2 Giochi arcade
• Defendguin: un clone di Defender, dove la tua missione è difendere i piccoli pinguini. Pagina 

iniziale di Defendguin

• Frozen Bubble: le bolle colorate sono congelate nella parte superiore dello schermo di gioco. Man mano 
che la pressa di ghiaccio scende, devi far scoppiare gruppi di bolle congelate prima che la pressa 
raggiunga il tuo tiratore.

Home page di Frozen Bubble

• Planet Penguin Racer: un divertente gioco di corse con il tuo pinguino preferito.

• Home page di Tuxracer

• Ri-li: un gioco con trenini 

giocattolo. Home page di 

Ri-li

• Supertux: un classico gioco 2D a scorrimento laterale in stile simile ai giochi originali di SuperMario.

Home page di Supertux

http://chromium-bsu.sourceforge.net/
https://en.wikipedia.org/wiki/Beneath_a_Steel_Sky
http://kqlives.sourceforge.net/
http://kqlives.sourceforge.net/
http://mars-game.sourceforge.net/?page_id=972
http://mars-game.sourceforge.net/?page_id=972
http://www.newbreedsoftware.com/defendguin
http://www.newbreedsoftware.com/defendguin
http://www.frozen-bubble.org/
http://tuxracer.sourceforge.net/
http://ri-li.sourceforge.net/
http://ri-li.sourceforge.net/
http://supertux.lethargik.org/


• Supertuxkart: una versione molto migliorata di tuxkart. 

Home page di Supertuxcart

Figura 4-21: Il trenino Ri-li deve svoltare presto.

4.9.3 Giochi da tavolo

• I giochi Gottcode sono intelligenti e divertenti.

Home page di Gottcode

• Mines (gnomines): un gioco di campo minato per 1 giocatore.

Home page di Mines

• Do’SSi Zo’la: l'obiettivo del gioco base Isola è bloccare l'avversario distruggendo i quadrati che lo 
circondano.

Home page di Do'SSi Zo'la

• Gnuchess: un gioco di scacchi.

Home page di Gnuchess

http://supertuxkart.sourceforge.net/
http://gottcode.org/
https://wiki.gnome.org/Apps/Mines
http://dossizola.sourceforge.net/
http://www.gnu.org/software/chess


Figura 4-22: Momento di alta tensione in Mines.

4.9.4 Giochi di carte

Ecco alcuni divertenti giochi di carte disponibili nei repository.

• AisleRiot offre oltre 80 giochi di solitario.

Home page di AisleRiot

• Pysolfc: oltre 1.000 giochi di solitario da un'unica applicazione.

Home page di Pysolfc

4.9.5 Divertimento sul desktop

• Xpenguins. I pinguini camminano sullo schermo. Può essere personalizzato con altri 
personaggi come Lemmings e Pooh Bear (è necessario consentire l'esecuzione dei programmi 
nella finestra root).

Home page di Xpenguins

• Oneko. Un gatto (neko) segue il cursore (il mouse) sullo schermo. Può essere personalizzato 
con un cane o un altro animale.

Wikipedia: Neko

https://wiki.gnome.org/Apps/Aisleriot
http://pysolfc.sourceforge.net/
http://xpenguins.seul.org/
https://en.wikipedia.org/wiki/Neko_(software)


• Algodoo. Questo gioco gratuito presenta un sandbox fisico in 2D dove puoi giocare con la fisica come 
mai prima d'ora. La sinergia giocosa tra scienza e arte è innovativa e lo rende tanto educativo quanto 
divertente.

Home page di Algodoo

• Xteddy. Mette un simpatico orsacchiotto sul tuo desktop. In alternativa puoi aggiungere una tua immagine.

Home page di Xteddy

• Tuxpaint. Un programma di disegno per bambini di tutte le età.

Home page di Tuxpaint

Figura 4-23: Un genio in erba al lavoro con Tuxpaint.

4.9.6 Bambini
• Tre pacchetti di giochi e applicazioni educative sono disponibili su MX Package Installer.

• Scratch è un linguaggio di programmazione visivo gratuito di alto livello basato su blocchi e un sito web 
destinato principalmente ai bambini come strumento didattico. L'utente può creare storie interattive, giochi 
e animazioni. MX Package Installer.

Home page

http://www.algodoo.com/
http://staffwww.itn.liu.se/~stegu/xteddy/index.html
http://www.tuxpaint.org/
https://scratch.mit.edu/


Figura 4-24: Schermata di codifica per Dance Party utilizzando Scratch.

4.9.7 Giochi di tattica e strategia

• Freeciv: un clone di Sid Meyer's Civilization© (versione I), un gioco di strategia multiplayer a turni, in cui 
ogni giocatore diventa il leader di una civiltà dell'età della pietra, cercando di ottenere il predominio con il 
passare dei secoli.

Home page di Freeciv

• Lbreakout2: LBreakout2 è un gioco arcade in stile breakout in cui si usa una racchetta per colpire dei 
mattoni con una pallina fino a distruggerli tutti. Molti livelli e sorprese. Installato di default.

Home page di Lgames

• Lincity: un clone dell'originale Simcity. Devi costruire e mantenere una città e soddisfare i suoi abitanti 
in modo che la popolazione cresca.

Home page di Lincity

• Battle for Wesnoth: un gioco di strategia a turni molto apprezzato con un tema fantasy. Costruisci il tuo 
esercito e combatti per riconquistare il trono.

Home page di Battle for Wesnoth

http://www.freeciv.org/
http://lgames.sourceforge.net/
http://lincity.sourceforge.net/
http://www.wesnoth.org/


Figura 4-25: Tentativo di sfondare il primo muro in Lbreakout.

4.9.8 Giochi Windows

È possibile giocare a numerosi giochi Windows in MX Linux utilizzando un emulatore Windows come Cedega o 
DOSBox, mentre alcuni possono essere eseguiti anche con Wine: vedere la Sezione 6.1.

4.9.9 Servizi di gioco

Figura 4-26: Sins of a Solar Empire: Rebellion in esecuzione su Steam con Proton.

Esistono varie raccolte e servizi per gli utenti che desiderano giocare su MX Linux. Due dei più noti sono 
facilmente installabili con MX Package Installer.

• PlayOnLinux. Un'interfaccia grafica per Wine (Sezione 6.1) che consente agli utenti Linux di 
installare e utilizzare facilmente numerosi giochi e applicazioni progettati per funzionare con 
Microsoft® Windows®.



Homepage di PlayOnLinux.

• Steam. Una piattaforma di distribuzione digitale proprietaria per l'acquisto e la riproduzione di 
videogiochi che fornisce l'installazione e l'aggiornamento automatico dei giochi. Include Proton, una 
distribuzione modificata di Wine.

Homepage di Steam

4.10 Strumenti Google 

4.10.1 Gmail

Gmail può essere facilmente configurato in Thunderbird seguendo le istruzioni. È inoltre facilmente accessibile da 
qualsiasi browser.

4.10.2 Contatti Google

I contatti di Google possono essere collegati a Thunderbird utilizzando il componente aggiuntivo gContactSync. 

Home page di gContactSync

4.10.3 Google Cal

Gcal può essere configurato in una scheda in Thunderbird con i componenti aggiuntivi Lightning e Google Calendar 

Tab. Home page del calendario Lightning

4.10.4 Attività di Google

Gtasks può essere incluso in Thunderbird selezionando la voce Attività del calendario.

4.10.5 Google Earth

Il metodo più semplice per installare Google Earth è utilizzare MX Package Installer, dove si trova nella sezione 
"Misc".

Esiste anche un metodo manuale che può essere utile in alcune installazioni.

• Installare googleearth.package dai repository o direttamente dal repository di Google.

• Apri un terminale e inserisci:

make-googleearth-package

• Una volta terminato, diventa root e digita:

dpkg -i googleearth*.deb

https://www.playonlinux.com/en/
https://store.steampowered.com/
http://www.pirules.org/addons/gcontactsync/
https://www.mozilla.org/en-US/projects/calendar/
https://www.google.co.uk/earth/download/gep/agree.html


• Sullo schermo apparirà un messaggio di errore relativo a problemi di dipendenza. Correggilo 
inserendo quest'ultimo comando (sempre come root):

apt-get -f install

Ora Google Earth apparirà finalmente nel menu Applicazioni > Internet.

4.10.6 Google Talk

Google Duo può essere eseguito direttamente da Gmail.

4.10.7 Google Drive
Esistono strumenti pratici che consentono l'accesso locale al tuo account GDrive.

• Un'app semplice e gratuita chiamata Odrive si installa e funziona bene.

• L'app multipiattaforma proprietaria Insync consente la sincronizzazione selettiva e l'installazione su più 
computer.

4.11 Bug, problemi e richieste 

I bug sono errori in un programma o sistema informatico che producono risultati errati o comportamenti anomali. 
Le "richieste" o "migliorie" sono aggiunte richieste dagli utenti, sotto forma di nuove applicazioni o nuove 
funzionalità per applicazioni esistenti.

• Pubblica un "problema" nel repository GitHub di MX Linux.

• Le richieste possono essere effettuate con un post nel forum Bugs and Request, avendo cura di 
fornire informazioni sull'hardware, sul sistema e altri dettagli. Gli sviluppatori e i membri della 
comunità risponderanno a questi post con domande, suggerimenti, ecc.

https://duo.google.com/
https://www.omgubuntu.co.uk/2019/02/odrive-google-drive-linux-client
https://www.insynchq.com/google-drive-linux
https://github.com/MX-Linux
https://forum.mxlinux.org/viewforum.php?f=97


5.1 Introduzione

5.1.1 Metodi

MX Linux offre due metodi GUI complementari per la gestione del software per CLI (vedere 5.5.4):

• MX Package Installer (MXPI) per l'installazione/rimozione con un solo clic delle applicazioni più diffuse. 
Ciò include le applicazioni presenti nei repository Debian Stable, MX Test, Debian Backports e Flatpaks (Sezione 
3.2.11).

• Synaptic Package Manager, uno strumento grafico completo per una vasta gamma di azioni con i 
pacchetti Debian.

MXPI è consigliato e presenta i seguenti vantaggi rispetto a Synaptic:

• È molto più veloce!
• La scheda Applicazioni popolari è limitata ai pacchetti più utilizzati, quindi è facile trovare tutto.
• Installa correttamente alcuni pacchetti complicati che sono difficili per i nuovi utenti (ad esempio 

Wine).
• È un'unica fonte che include i repository sopra menzionati e dispone di pacchetti più recenti rispetto a 

quelli che Synaptic ha di default.
• I Flatpak sono disponibili con la possibilità di visualizzare solo le app "verificate da flathub" come opzioni.

Synaptic ha i suoi vantaggi:

• Dispone di un gran numero di filtri avanzati impostati come Sezioni (categorie), Stato, ecc.
• Offre informazioni dettagliate su pacchetti specifici.
• Rende molto facile aggiungere nuovi repository software.

Questa Sezione 5 si concentra su Synaptic, che è il metodo consigliato per gli utenti di livello intermedio e avanzato 
per gestire i pacchetti software oltre le capacità di MX Package Installer. Esaminerà anche altri metodi disponibili e 
che potrebbero essere necessari in determinate situazioni.

5.1.2 Pacchetti

Le operazioni software in MX vengono eseguite in background tramite il sistema Advanced Package Tool (APT). 
Il software viene fornito sotto forma di pacchetto: un insieme discreto e non eseguibile di dati che include le 
istruzioni per il gestore di pacchetti relative all'installazione. I pacchetti sono memorizzati su server chiamati 
repository (repos) e possono essere sfogliati, scaricati e installati tramite uno speciale software client chiamato 
Ppackage Manager.

La maggior parte dei pacchetti ha una o più dipendenze, il che significa che hanno uno o più pacchetti che devono 
essere installati affinché funzionino. Il sistema APT è progettato per gestire automaticamente le dipendenze per 
voi; in altre parole, quando provate a installare un pacchetto le cui dipendenze non sono già installate, il vostro 
gestore di pacchetti APT contrassegnerà automaticamente anche quelle dipendenze per l'installazione. Può 
accadere che queste dipendenze non possano
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essere soddisfatte, impedendo l'installazione di un pacchetto. Se hai bisogno di aiuto con le dipendenze, pubblica 
una richiesta di aiuto nel forum MX Linux.

5.2 Repository

I repository APT sono molto più che semplici siti web con software scaricabile. I pacchetti sui siti dei repository 
sono organizzati e indicizzati in modo speciale per essere accessibili tramite un gestore di pacchetti, piuttosto che 
essere sfogliati direttamente.

ATTENZIONE: è molto probabile che l'installazione risulti irreparabilmente danneggiata.

Siate estremamente cauti quando aggiungete repository Ubuntu o Mint a MX Linux! Ciò vale in 

particolare per: Debian Sid (instabile) e Testing o PPA non ufficiali.

5.2.1 Repository standard

MX Linux viene fornito con una serie di repository abilitati che offrono sia sicurezza che scelta. Se siete nuovi a 
MX Linux (e soprattutto se siete nuovi a Linux), si consiglia in generale di attenersi inizialmente ai repository 
predefiniti. Per motivi di sicurezza, questi repository sono firmati digitalmente, il che significa che i pacchetti sono 
autenticati con una chiave di crittografia per garantire la loro autenticità. Se installi pacchetti da repository non 
Debian senza la chiave, riceverai un avviso che non è stato possibile autenticarli. Per eliminare questo avviso e 
garantire la sicurezza delle tue installazioni, devi installare le chiavi mancanti utilizzando MX Fix GPG keys.

I repository possono essere aggiunti, abilitati/disabilitati, rimossi o modificati più facilmente tramite Synaptic, anche se 
possono essere modificati manualmente modificando i file in /etc/apt/ in un terminale root. In Synaptic, clicca su 
Impostazioni > repository, quindi clicca sul pulsante Nuovo e aggiungi le informazioni. Le informazioni sul 
repository sono spesso fornite in una singola riga, come questa:

deb http://mxrepo.com/mx/testrepo/ Trixie test
Prestare attenzione alla posizione degli spazi, che separano le informazioni in quattro blocchi che vengono poi 
inseriti in righe separate in Synaptic.

https://forum.mxlinux.org/
https://mxlinux.org/wiki/help-files/help-mx-check-apt-gpg
http://mxrepo.com/mx/testrepo/


Figura 5-1: Repository.

Alcuni repository hanno etichette speciali:

• contrib, che dipendono da o sono accessori a pacchetti non liberi.

• non-free, che non soddisfano le linee guida Debian per il software libero (DFSG).

• security, che contengono solo aggiornamenti relativi alla sicurezza.

• backports, che contengono pacchetti delle versioni più recenti di Debian che sono stati resi 

retrocompatibili per mantenere aggiornato il sistema operativo.

• MX, che contengono i pacchetti speciali che rendono MX Linux quello che è.

L'elenco attuale dei repository MX standard è conservato nel Wiki MX/antiX.

5.2.2 Repository della comunità

MX Linux ha i propri repository della community con pacchetti creati e gestiti dai nostri packager. Questi 
pacchetti sono distinti dai pacchetti MX ufficiali provenienti da Debian Stable e contengono pacchetti provenienti 
da altre fonti:

• Debian Backports, da Debian Testing o anche Debian Experimental.

• La nostra distribuzione gemella antiX Linux.

• Progetti indipendenti.

• Host open source come GitHub.

• Codice sorgente compilato dai nostri packager MX.

I repository della comunità sono fondamentali per MX Linux, poiché consentono a un sistema operativo 
basato su Debian Stable di rimanere al passo con importanti sviluppi software, patch di sicurezza e correzioni 
di bug critici.

Oltre al repository MX Enabled ("Main"), il repository MX Test ha lo scopo di ottenere feedback dagli utenti 
prima che i nuovi pacchetti vengano spostati in Main. Il modo più semplice per installare da MX Test è con il 
Package Installer (Sezione 3.2), poiché gestisce automaticamente molti passaggi.

Per saperne di più su ciò che è disponibile, chi sono i packager e anche come partecipare, consulta MX Community 
Packaging Project.

5.2.3 Repository dedicati

Oltre ai repository generali come Debian, MX e Community, esistono anche un certo numero di repository dedicati 
associati a una singola applicazione. Quando ne aggiungi uno, direttamente o tramite Synaptic, riceverai gli 
aggiornamenti. Alcuni sono precaricati ma non abilitati, altri dovrai aggiungerli tu stesso.

Ecco un esempio comune (browser Vivaldi):

https://mxlinux.org/wiki/


deb http://repo.vivaldi.com/stable/deb/ stable main

Repository PPA: i nuovi utenti provenienti da Ubuntu o da uno dei suoi derivati spesso chiedono informazioni su 
tali fonti. Ubuntu si discosta dallo standard Debian, quindi tali repository devono essere trattati con cautela. 
Consultare il Wiki MX/antiX.

5.2.4 Repository di sviluppo

Esiste un'ultima categoria di repository per acquisire la build più recente (e quindi meno stabile) di un'applicazione. 
Ciò avviene tramite un sistema di controllo della versione come Git, che può essere consultato dall'utente finale per 
rimanere aggiornato sullo sviluppo. Una copia del codice sorgente dell'applicazione può essere scaricata in una 
directory su una macchina locale. I repository software sono un metodo conveniente per gestire i progetti 
utilizzando Git, e MX Linux conserva la maggior parte del suo codice nel proprio repository GitHub.

Altro: Wikipedia: Repository software

5.2.5 Mirror

I repository MX Linux sia per i pacchetti che per le ISO (file immagine) sono "mirrorati" su server in diversi siti in 
tutto il mondo; lo stesso vale per i repository Debian. Questi siti mirror forniscono più fonti delle stesse 
informazioni e hanno la funzione di ridurre i tempi di download, migliorare l'affidabilità e fornire una certa 
resilienza in caso di guasto del server. Durante l'installazione, il mirror più probabile verrà selezionato 
automaticamente in base alla posizione e alla lingua. Tuttavia, l'utente potrebbe avere motivi per preferirne un 
altro:

• L'assegnazione automatica durante l'installazione potrebbe essere errata in alcuni casi.

• L'utente potrebbe cambiare residenza.

• Potrebbe diventare disponibile un nuovo mirror molto più vicino, veloce o affidabile.

• Un mirror esistente potrebbe cambiare il proprio URL.

• Il mirror utilizzato potrebbe diventare inaffidabile o andare offline.

MX Repo Manager (Sezione 3.2) semplifica il cambio di mirror, consentendoti di scegliere quello più adatto 
alle tue esigenze. Nota: presta attenzione al pulsante che seleziona il mirror più veloce per la tua posizione.

5.3 Gestore pacchetti Synaptic

La sezione seguente intende fornire una panoramica aggiornata sull'uso di Synaptic. Si noti che è richiesta la 
password di root e, naturalmente, è necessario essere connessi a Internet.

http://repo.vivaldi.com/stable/deb/
https://mxlinux.org/wiki/system/add-ppa-repository/
https://en.wikipedia.org/wiki/Software_repository


5.3.1 Installazione e rimozione dei pacchetti

Installazione

• Ecco i passaggi fondamentali per installare software in Synaptic:

• Fare clic sul menu Start > Sistema > Gestione pacchetti Synaptic, digitare la password di root se 

richiesta.

• Premere il pulsante Ricarica. Questo pulsante indica a Synaptic di contattare i server dei repository 

online e scaricare un nuovo file di indice con informazioni su:

◦ Quali pacchetti sono disponibili.

◦ Quali sono le loro versioni.

◦ Quali altri pacchetti sono necessari per la loro installazione.

• Se viene visualizzato un messaggio che indica che alcuni repository non sono stati contattati, attendere un 

minuto e riprovare.

• Se conosci già il nome del pacchetto che stai cercando, clicca sul riquadro a destra e inizia a digitare; 

Synaptic effettuerà una ricerca incrementale man mano che digiti.

• Se non conosci il nome del pacchetto, utilizza la casella di ricerca nell'angolo in alto a destra per 

individuare il software in base al nome o alle parole chiave. Questo è uno dei maggiori vantaggi di 

Synaptic rispetto ad altri metodi.

• In alternativa, usa uno dei pulsanti di filtro nell'angolo in basso a sinistra:

◦ Sezioni fornisce sottoaree come Editor, Giochi e intrattenimento, Utilità, ecc.

Nel riquadro inferiore vedrai una descrizione di ciascun pacchetto e potrai utilizzare le schede per 

scoprire ulteriori informazioni al riguardo.

◦ Stato raggruppa i pacchetti in base alla loro situazione di installazione.

◦ Origine mostra i pacchetti provenienti da un repository specifico.

◦ Filtri personalizzati fornisce varie opzioni di filtro.

◦ Risultati della ricerca mostrerà un elenco delle ricerche precedenti per la sessione Synaptic in cui ti 

trovi.



• Fai clic sulla casella vuota all'estrema sinistra del pacchetto desiderato e seleziona "Contrassegna per 

l'installazione" nella finestra pop-up. Se il pacchetto ha delle dipendenze, riceverai una notifica e anche 

queste saranno automaticamente contrassegnate per l'installazione. Puoi anche semplicemente fare 

doppio clic sul pacchetto se è l'unico che stai installando.

• Alcuni pacchetti hanno anche pacchetti "Consigliati" e "Suggeriti" che possono essere visualizzati 

facendo clic con il tasto destro del mouse sul nome del pacchetto. Si tratta di pacchetti aggiuntivi che 

aggiungono funzionalità al pacchetto selezionato, ed è una buona idea darci un'occhiata.

• Fare clic su Applica per avviare l'installazione. È possibile ignorare tranquillamente qualsiasi messaggio 

di avviso: "Stai per installare un software che non può essere autenticato!".

• Potrebbero esserci ulteriori passaggi: basta seguire le istruzioni visualizzate fino al completamento 

dell'installazione.

Figura 5-2: Controllo dei pacchetti consigliati durante l'installazione dei pacchetti.

Rimozione di software
La rimozione di software dal sistema con Synaptic sembra semplice quanto l'installazione, ma in realtà è più 
complessa di quanto sembri:

• Per rimuovere un pacchetto, è sufficiente fare clic sulla stessa casella utilizzata per l'installazione e 

selezionare Contrassegna per la rimozione o Contrassegna per la rimozione completa.



◦ La rimozione disinstalla il software, ma lascia i file di configurazione del sistema nel caso in cui 

si desideri mantenere le impostazioni.

◦ La rimozione completa rimuove il software e anche i file di configurazione di sistema (pulizia). I file 

di configurazione personali relativi al pacchetto non verranno rimossi. Controllare anche la presenza 

di altri file di configurazione residui nella categoria Non installati (configurazione residua) di 

Synaptic.

• Se sono presenti altri programmi che dipendono dal pacchetto da rimuovere, anche questi pacchetti 

dovranno essere rimossi. Questo accade solitamente quando si rimuovono librerie software, servizi o 

applicazioni da riga di comando che fungono da back-end per altre applicazioni. Assicurarsi di leggere 

attentamente il riepilogo fornito da Synaptic prima di fare clic su OK.

• La rimozione di applicazioni di grandi dimensioni composte da molti pacchetti può comportare 

complicazioni. Molte volte questi pacchetti vengono installati utilizzando un meta-pacchetto, che è un 

pacchetto vuoto che dipende semplicemente da tutti i pacchetti necessari per l'applicazione. Il modo 

migliore per rimuovere un pacchetto complicato come questo è ispezionare l'elenco delle dipendenze del 

meta-pacchetto e rimuovere i pacchetti elencati. Fai attenzione, tuttavia, a non disinstallare una 

dipendenza di un'altra applicazione che desideri conservare!

• Potresti notare che la categoria di stato Rimuovibile automaticamente inizia ad accumulare pacchetti.

Questi sono stati installati da altri pacchetti e non sono più necessari, quindi puoi cliccare su quella 

categoria di stato, evidenziare tutti i pacchetti nel riquadro di destra e poi cliccare con il tasto destro del 

mouse per rimuoverli. Assicurati di esaminare attentamente l'elenco quando appare la finestra di verifica, 

perché a volte potresti scoprire che le dipendenze elencate per la rimozione includono pacchetti che in 

realtà desideri conservare. Se non sei sicuro, usa apt -s autoremove per eseguire una simulazione (= 

opzione -s).



Figura 5-3: Preparazione alla rimozione dei pacchetti rimovibili automaticamente.

5.3.2 Aggiornamento e downgrade del software

Synaptic consente di mantenere il sistema aggiornato in modo rapido e comodo.

Aggiornamento

A meno che non si utilizzi un metodo manuale in Synaptic o in un terminale, l'aggiornamento viene in genere 
attivato da una modifica dell'icona MX Updater nell'area di notifica (impostazione predefinita: il riquadro verde 
vuoto diventa verde pieno). Quando ciò accade, è possibile procedere in due modi.

• Fare clic con il tasto sinistro sull'icona. Questo è il metodo più veloce perché non è necessario attendere 

il caricamento e l'esecuzione del software, ecc. Viene visualizzata una finestra di terminale con i 

pacchetti da aggiornare; esaminarli attentamente, quindi fare clic su OK per completare il processo.

• Fare clic con il tasto destro sull'icona per utilizzare invece Synaptic.

• Fare clic sull'icona Contrassegna tutti gli aggiornamenti sotto la barra dei menu per selezionare tutti i 

pacchetti disponibili per l'aggiornamento, oppure fare clic sul collegamento Installati (aggiornabili) nel 

pannello di sinistra per esaminare i pacchetti o selezionare gli aggiornamenti singolarmente.

• Fare clic su Applica per avviare l'aggiornamento, ignorando il messaggio di avviso. All'avvio del processo 

di installazione, è possibile visualizzare i dettagli in un terminale all'interno di Synaptic.

• Con alcuni aggiornamenti dei pacchetti, potrebbe essere richiesto di confermare una finestra di dialogo, 

inserire informazioni di configurazione o decidere se sovrascrivere o meno un file di configurazione che è 

stato modificato. Prestare attenzione e seguire le istruzioni fino al completamento dell'aggiornamento.



Downgrade

A volte potresti voler eseguire il downgrade di un'applicazione a una versione precedente, ad esempio a causa di 
problemi sorti con quella nuova. Questo è facile da fare in Synaptic:

1. Aprire Synaptic, inserire la password di root e fare clic su Ricarica.

2. Fai clic su Installati nel pannello a sinistra, quindi individua ed evidenzia il pacchetto che desideri 

downgradare nel pannello a destra.

3. Nella barra dei menu, clicca su Pacchetto > Forza versione...

4. Seleziona una delle versioni disponibili dall'elenco a discesa. Potrebbero non esserci opzioni 

disponibili.

5. Fare clic su Forza versione, quindi installare come di consueto.

6. Per evitare che la versione precedente venga immediatamente aggiornata di nuovo, è necessario bloccarla.

Figura 5-4: Utilizzo di Forza versione per eseguire il downgrade di un pacchetto.

Blocco di una versione
A volte potresti voler bloccare un'applicazione su una versione specifica per evitare che venga aggiornata, al fine 
di evitare problemi con quelle più recenti. È facile da fare:

1. Aprire Synaptic, inserire la password di root e fare clic su Ricarica.

2. Fare clic su Installati nel pannello a sinistra, quindi individuare ed evidenziare il pacchetto che si desidera 

bloccare nel pannello a destra.

3. Nella barra dei menu, clicca su Pacchetto > Blocca versione...

4. Synaptic evidenzierà il pacchetto in rosso e aggiungerà un'icona di blocco alla prima colonna.



5. Per sbloccarlo, evidenziare nuovamente il pacchetto e fare clic su Pacchetto > Blocca versione (che 

avrà un segno di spunta).

6. Si noti che il blocco tramite Synaptic non impedisce l'aggiornamento del pacchetto quando si utilizza la 

riga di comando.

5.4 Risoluzione dei problemi di Synaptic

Synaptic è molto affidabile, ma a volte è possibile che venga visualizzato un messaggio di errore. Una discussione 
completa su tali messaggi è disponibile nel Wiki MX/antiX, quindi qui ne menzioneremo solo alcuni tra i più 
comuni.

• Viene visualizzato un messaggio che indica che alcuni repository non sono riusciti a scaricare le 

informazioni del repository. Si tratta solitamente di un evento transitorio ed è sufficiente attendere e 

ricaricare; in alternativa, è possibile utilizzare MX Repo Manger per cambiare repository.

• Se l'installazione di un pacchetto mostra che il software che si desidera conservare verrà rimosso, fare 

clic su Annulla per annullare l'operazione.

• Con un nuovo repository, dopo il ricaricamento potrebbe essere visualizzato un messaggio di errore 

simile al seguente: W: Errore GPG: [URL di un repository] Release: Impossibile verificare le seguenti 

firme. Questo messaggio viene visualizzato perché apt include l'autenticazione dei pacchetti al fine di 

migliorare la sicurezza e la chiave non è presente. Per risolvere il problema, clicca sul menu Start > 

Sistema > MX Fix GPG keys e segui le istruzioni. Se non viene trovata alcuna chiave, chiedi sul Forum.

• A volte i pacchetti non vengono installati perché i loro script di installazione non superano uno o più 

controlli di sicurezza; ad esempio, un pacchetto potrebbe tentare di sovrascrivere un file che fa parte di un 

altro pacchetto o richiedere il downgrade di un altro pacchetto a causa delle dipendenze. Se l'installazione 

o l'aggiornamento si blocca a causa di uno di questi errori, il pacchetto viene definito "danneggiato". Per 

risolvere il problema, fare clic sulla voce Pacchetti danneggiati nel pannello di sinistra. Evidenziare il 

pacchetto e provare innanzitutto a risolvere il problema facendo clic su Modifica > Ripara pacchetti 

danneggiati. Se l'operazione non ha esito positivo, fare clic con il pulsante destro del mouse sul pacchetto 

per deselezionarlo o disinstallarlo.

• Durante l'installazione o la rimozione, a volte vengono visualizzati messaggi importanti relativi al processo:

◦ Disinstallare? Occasionalmente, i conflitti nelle dipendenze dei pacchetti possono causare la 

disinstallazione da parte del sistema APT di un gran numero di pacchetti importanti al fine di 

installarne altri

https://mxlinux.org/wiki/


. Questo è raro con la configurazione predefinita, ma diventa sempre più probabile man mano che si 

aggiungono repository non supportati. FAI MOLTA ATTENZIONE ogni volta che l'installazione 

di un pacchetto richiede la rimozione di altri pacchetti! Se sta per essere rimosso un gran numero di 

pacchetti, potresti voler cercare un altro metodo per installare questa applicazione.

◦ Mantenere? Durante l'aggiornamento, a volte potrebbe essere comunicato che è disponibile un 

nuovo file di configurazione per un determinato pacchetto e potrebbe essere chiesto se si desidera 

installare la nuova versione o mantenere quella attuale.

▪ Se il pacchetto in questione proviene da un repository MX, si consiglia di "installare la 

versione dei manutentori".

▪ Altrimenti, rispondere "mantenere la versione attuale" (N), che è anche la scelta predefinita.

5.5 Altri metodi

5.5.1 Aptitude

Aptitude è un gestore di pacchetti che può essere utilizzato al posto di apt o Synaptic. È disponibile nei repository 
ed è particolarmente utile quando sorgono problemi di dipendenza. Può essere eseguito come CLI o GUI.

Figura 5-5: Schermata iniziale di Aptitude (GUI), che mostra il risolutore di dipendenze.



Per i dettagli su questa opzione, consultare il Wiki MX/antiX.

5.5.2 Pacchetti Deb

I pacchetti software installati tramite Synaptic (e APT alle sue spalle) sono in un formato chiamato Deb 
(abbreviazione di Debian, la distribuzione Linux che ha ideato APT). È possibile installare manualmente i pacchetti 
deb scaricati utilizzando lo strumento grafico Deb Installer (sezione 3.2.28) o lo strumento da riga di comando 
dpkg. Si tratta di strumenti semplici per installare pacchetti deb locali.

Figura 5.6: Deb Installer

NOTA: se le dipendenze non possono essere soddisfatte, verrà visualizzato un avviso e il programma si interromperà.

Installazione di file *.deb con dpkg

1. Passare alla cartella contenente il pacchetto deb che si desidera installare.

2. Fare clic con il tasto destro su uno spazio vuoto per aprire un terminale e diventare root. In alternativa, 

fare clic sulla freccia per salire di un livello e fare clic con il tasto destro sulla cartella con il pacchetto 

deb > Apri Thunar root qui.

3. Installare il pacchetto con il comando (sostituendo ovviamente il nome reale del pacchetto):

dpkg -i nomepacchetto.deb

4. Se stai installando più pacchetti nella stessa directory contemporaneamente (ad esempio se 

installi manualmente Libre Office), puoi farlo tutto in una volta utilizzando:

dpkg -i *.deb

https://mxlinux.org/wiki/


NOTA: in un comando della shell, l'asterisco è un carattere jolly nell'argomento. In questo caso, il 

programma applicherà il comando a qualsiasi file il cui nome termina con .deb.

5. Se le dipendenze richieste non sono già installate sul sistema, verranno visualizzati errori di dipendenze 

non soddisfatte poiché dpkg non se ne occupa automaticamente. Per correggere questi errori e 

completare l'installazione, eseguire questo codice per forzare l'installazione:

apt -f install

6. apt tenterà di correggere la situazione installando le dipendenze necessarie (se disponibili dai 

repository) o rimuovendo i file .deb (se le dipendenze non possono essere installate).

NOTA: il comando è cambiato dal nome precedente apt-get a semplicemente apt

5.5.3 Pacchetti autonomi

 VIDEO: Launcher e Appimage

Appimages, Flatpaks e Snaps sono pacchetti autonomi che non devono essere installati nel senso tradizionale del 
termine. Si prega di notare che questi pacchetti non sono stati testati da Debian o MX Linux, quindi 
potrebbero non funzionare come previsto.

1. Appimage: basta scaricarle, spostarle in /opt (consigliato) e renderle eseguibili facendo clic con il 

tasto destro del mouse e selezionando Permessi.

2. Flatpak: utilizzare Package Installer per ottenere le app da Flathub.

3. Snaps. MX Linux deve essere avviato in systemd. Soluzione alternativa e dettagli nel

MX/antiX Wiki.

Uno dei grandi vantaggi dei pacchetti autonomi è che includono tutto il software aggiuntivo necessario, quindi 
non hanno alcun impatto negativo sul software già installato. Questo li rende anche molto più grandi dei 
pacchetti installati tradizionali.

AIUTO: il Wiki MX/antiX

5.5.4 Metodi CLI

https://www.youtube.com/watch?v=RIvEMLWnkAU&t=3s
https://mxlinux.org/wiki/applications/flatpaks/
https://mxlinux.org/wiki/applications/snap-packages-and-mx-linux/
https://mxlinux.org/wiki/applications/snap-packages-and-mx-linux/
https://mxlinux.org/category/wiki/applications/


È anche possibile utilizzare la riga di comando come root per installare, rimuovere, aggiornare, cambiare repository 
e, in generale, gestire i pacchetti. Invece di avviare Synaptic per eseguire le operazioni comuni.

Tabella 5: Comandi comuni per gestire i pacchetti.

Comando Azione

apt install nome_pacchetto Installa un determinato pacchetto

apt remove nome_pacchetto Rimuovere un determinato pacchetto

apt purge nome_pacchetto Rimuovere completamente un pacchetto (ma non la configurazione/i dati in
/home)

apt autoremove Eliminare i pacchetti residui dopo una rimozione

apt update Aggiorna l'elenco dei pacchetti dai repository

apt upgrade Installa tutti gli aggiornamenti disponibili

apt dist-upgrade Gestisci in modo intelligente le dipendenze che cambiano con le nuove 
versioni dei pacchetti

I processi e i risultati di Apt vengono visualizzati in un terminale utilizzando la visualizzazione predefinita che 
molti utenti trovano poco attraente e difficile da leggere.

Nala
Esiste un formato di visualizzazione alternativo chiamato nala, i cui colori e organizzazione lo rendono 
un'alternativa molto intuitiva che molti preferiscono. Per abilitarlo, avvia Updater dalla barra delle applicazioni e 
seleziona la casella "Usa nala".

5.5.5 Altri metodi di installazione

Prima o poi alcuni software che desideri installare non saranno disponibili nei repository e potresti dover utilizzare 
altri metodi di installazione. Questi metodi includono:

• Blob. A volte ciò che desideri non è in realtà un pacchetto installabile, ma un "blob" o una raccolta 

precompilata di dati binari memorizzati come singola entità, in particolare closed-source. Tali blob si 

trovano in genere nella directory /opt. Esempi comuni includono Firefox, Thunderbird e LibreOffice.

• Pacchetti RPM: alcune distribuzioni di Linux utilizzano il sistema di pacchetti RPM. I pacchetti RPM 

sono simili ai pacchetti deb sotto molti aspetti ed esiste un programma a riga di comando disponibile su 

MX Linux per convertire i pacchetti RPM in deb chiamato alien. Non è installato con MX Linux, ma è 

disponibile nei repository predefiniti. Dopo averlo installato sul sistema, è possibile utilizzarlo per 

installare un pacchetto rpm con questo comando



(come root): alien -i packagename.rpm. Questo posizionerà un file deb con lo stesso nome nella 

posizione del file rpm, che potrai quindi installare come descritto sopra. Per informazioni più dettagliate su 

alien, consulta la versione Internet della sua pagina man nella sezione Link in fondo a questa pagina.

• Codice sorgente: qualsiasi programma open source può essere compilato dal codice sorgente originale del 

programmatore se non ci sono altre opzioni. In circostanze ideali, si tratta in realtà di un'operazione 

piuttosto semplice, ma a volte si possono verificare errori che richiedono maggiori competenze per essere 

risolti. Il codice sorgente è solitamente distribuito come tarball (file tar.gz o tar.bz2). L'opzione migliore è 

solitamente quella di richiedere un pacchetto sul forum, ma consultare i link per un tutorial sulla 

compilazione dei programmi.

• Varie: molti sviluppatori di software creano pacchetti software personalizzati, solitamente distribuiti 

come tarball o file zip. Questi possono contenere script di installazione, file binari pronti all'uso o 

programmi di installazione binari simili ai programmi setup.exe di Windows. In Linux, il programma di 

installazione termina spesso con .bin. Google Earth, ad esempio, viene spesso distribuito in questo 

modo. In caso di dubbi, consultare le istruzioni di installazione fornite con il software.

5.5.6 Link

MX/antiX Wiki: Errori Synaptic

MX/antiX Wiki: Installazione del software

MX/antiX Wiki: Compilazione

Strumenti di gestione dei pacchetti Debian

Guida APT Debian

Wikipedia: Alien

https://mxlinux.org/wiki/applications-system/synaptic-errors
https://mxlinux.org/wiki/system/installing-software
https://mxlinux.org/wiki/system/compiling
https://www.debian.org/doc/manuals/apt-guide/ch2.en.html
https://en.wikipedia.org/wiki/Alien_(software)


6.1 Programmi Windows su MX Linux

Esistono diverse applicazioni, sia open source che commerciali, che consentono di eseguire applicazioni Windows 
su MX Linux. Sono denominate emulatori, ovvero replicano le funzioni di Windows su una piattaforma Linux. 
Molte applicazioni MS Office, giochi e altri programmi possono essere eseguiti utilizzando un emulatore con vari 
gradi di successo, che vanno da velocità e funzionalità quasi native a prestazioni solo di base.

6.1.1 Open source

Wine è il principale emulatore Windows open source per MX Linux. Si tratta di una sorta di livello di 
compatibilità per l'esecuzione di programmi Windows, ma non richiede Microsoft Windows per eseguire le 
applicazioni. Si installa al meglio tramite MX Package Installer > Misc; se si installa con Synaptic Package 
Manager, selezionare "winehq-staging" per ottenere tutti i pacchetti wine-staging. Le versioni di Wine vengono 
rapidamente impacchettate dai membri del Community Repository e messe a disposizione degli utenti, con l'ultima 
versione proveniente dal MX Test Repo.

NOTA: per eseguire Wine in una sessione Live, è necessario utilizzare la persistenza home (Sezione 6.6.3).

• Home page di Wine

• MX Linux/antiX Wiki: Wine

DOSBox crea un ambiente simile al DOS destinato all'esecuzione di programmi basati su MS-DOS, in particolare 
giochi per computer.

• Homepage di DOSBox

• Wiki di DOSBox

DOSEMU è un software disponibile nei repository che consente di avviare DOS in una macchina virtuale, 
rendendo possibile l'esecuzione di Windows 3.1, Word Perfect per DOS, DOOM, ecc.

• Home page di DOSEMU

• Wiki MX Linux/antiX: DOSEMU

6 Uso avanzato

https://wine-staging.com/
http://www.winehq.org/
https://mxlinux.org/wiki/system/wine
http://dosbox.sourceforge.net/
http://dosbox.sourceforge.net/wiki
http://www.dosemu.org/
https://mxlinux.org/wiki/system/dosemu


Figura 6-1: Photoshop 5.5 in esecuzione su Wine.

6.1.2 Commerciale

CrossOver Office consente di installare molte applicazioni, plugin e giochi Windows di produttività in Linux, 
senza bisogno di una licenza del sistema operativo Microsoft. Supporta particolarmente bene Microsoft Word, 
Excel e PowerPoint (fino a Office 2003).

• Home page di CrossOver Linux

• Wikipedia: Crossover

• Compatibilità delle applicazioni

Link

• Wikipedia: Emulatore

• Emulatori DOS

6.2 Macchine virtuali

Le applicazioni per macchine virtuali sono una classe di programmi che simulano un computer virtuale nella 
memoria, consentendo di eseguire qualsiasi sistema operativo sulla macchina. Sono utili per eseguire test, eseguire 
applicazioni non native e fornire agli utenti la sensazione di avere una macchina tutta loro. Molti utenti MX Linux 
utilizzano software per macchine virtuali per eseguire Microsoft Windows "in una finestra" e fornire così un accesso 
senza soluzione di continuità al software scritto per Windows sul proprio desktop. Vengono utilizzati anche per 
eseguire test ed evitare l'installazione.

http://www.codeweavers.com/products/cxoffice
http://en.wikipedia.org/wiki/CrossOver
http://www.codeweavers.com/compatibility/browse/rank
http://en.wikipedia.org/wiki/Emulator
https://en.wikipedia.org/wiki/DOSEMU


6.2.1 Configurazione di VirtualBox

 VIDEO: Virtual Box: configurazione di una cartella condivisa (14.4)

Esistono numerose applicazioni software di macchine virtuali per Linux, sia open source che proprietarie. MX 
Linux rende particolarmente facile l'uso di Oracle VirtualBox (VB), quindi ci concentreremo su questo. Per i 
dettagli e gli sviluppi più recenti, consultare la sezione Link qui sotto. Ecco una panoramica dei passaggi di base 
per configurare ed eseguire VirtualBox:

• Installazione. È preferibile eseguire l'installazione tramite MX Package Installer, dove VB appare nella 
sezione Misc. Ciò abiliterà il repository VB, scaricherà e installerà l'ultima versione di VB. Il repository 
rimarrà abilitato, consentendo gli aggiornamenti automatici tramite MX Updater.

• 64 bit. VB richiede il supporto della virtualizzazione hardware per eseguire un guest a 64 bit, le cui 
impostazioni (se presenti) si trovano nel firmware UEFI/BIOS. Dettagli nel manuale di VirtualBox.

• Riavvio. È consigliabile lasciare che VB si configuri completamente riavviando il sistema dopo l'installazione.

• Post-installazione. Verificare che l'utente appartenga al gruppo vboxusers. Aprire MX User Manager > 
scheda Group Membership. Selezionare il nome utente e assicurarsi che "vboxusers" nell'elenco Groups 
sia selezionato. Confermare e uscire.

• Pacchetto di estensione. Se si installa VB dal programma di installazione dei pacchetti MX, il pacchetto di 
estensione verrà incluso automaticamente. In caso contrario, è necessario scaricare la versione 
corrispondente e installarla dal sito web di Oracle (vedere Collegamenti). Dopo aver scaricato il file, 
individuarlo con Thunar e fare clic sull'icona del file. Il pacchetto di estensione aprirà VB e si installerà 
automaticamente.

• Posizione. I file della macchina virtuale sono memorizzati per impostazione predefinita nella cartella 
/home/VirtualBox VMs. Possono essere piuttosto grandi e, se si dispone di una partizione dati separata, si 
può considerare di impostare la cartella predefinita in quella posizione. Vai su File > Preferenze > scheda 
Generale e modifica la posizione della cartella.

https://www.youtube.com/watch?v=adpalUl4LqI
https://www.virtualbox.org/wiki/VirtualBox
https://www.virtualbox.org/manual/ch03.html#intro-64bitguests


Figura 6-2: Windows 2000 in esecuzione su VirtualBox.

6.2.2 Utilizzo di VirtualBox

• Creare una macchina virtuale. Per creare una macchina virtuale, avviare VB e fare clic sull'icona 
Nuovo nella barra degli strumenti. Sarà necessario un ISO Windows o un ISO Linux. Seguire la 
procedura guidata, accettando tutte le impostazioni suggerite a meno che non si conosca meglio: è 
sempre possibile modificarle in un secondo momento. Potrebbe essere necessario aumentare la memoria 
allocata al Guest al di sopra del valore minimo predefinito, lasciando comunque memoria sufficiente per 
il sistema operativo Host. Per i Guest Windows, considera la possibilità di creare un HD virtuale più 
grande di quello predefinito da 10 GB: sebbene sia possibile aumentare le dimensioni in un secondo 
momento, non si tratta di un processo semplice. Per Windows 11 è necessario un disco rigido da 60 GB 
(50 GB per Windows 10). Seleziona un'unità host o un file disco CD/DVD virtuale.

• Selezionare un punto di montaggio. Una volta configurata la macchina, è possibile selezionare il punto di 
montaggio come unità host o file disco CD/DVD virtuale (ISO). Fare clic su Impostazioni > 
Archiviazione: verrà visualizzata una finestra di dialogo in cui al centro è presente una struttura ad albero 
dell'archiviazione con un controller IDE e un controller SATA sotto di esso. Facendo clic sull'icona Unità 
CD/DVD nella struttura ad albero di archiviazione, l'icona Unità CD/DVD apparirà nella sezione Attributi 
sul lato destro della finestra. Fare clic sull'icona Unità CD/DVD nella sezione Attributi per aprire un menu 
a discesa in cui è possibile assegnare l'unità host o un file disco CD/DVD virtuale (ISO) da montare 
sull'unità CD/DVD. (È possibile selezionare un file ISO diverso facendo clic su Scegli un file disco 
CD/DVD virtuale e navigando fino al file). Avviare la macchina. Il dispositivo selezionato (ISO o 
CD/DVD) verrà montato all'avvio della macchina virtuale e sarà possibile installare il sistema operativo.

• GuestAdditions. Una volta installato il sistema operativo guest, assicurarsi di installare VB 
GuestAdditions avviando il sistema operativo guest, quindi facendo clic su Dispositivi > Inserisci 
GuestAdditions e indicando l'ISO che verrà individuato automaticamente. Ciò consentirà di abilitare la 
condivisione di file tra guest e host e di regolare la visualizzazione in vari modi in modo che si adatti al 
proprio ambiente e alle proprie abitudini. Se l'app non è in grado di individuarlo, potrebbe essere necessario 
installare il pacchetto virtualbox-guest-additions (operazione eseguita automaticamente se si utilizza MX 
Package Installer).



• Spostamento. Il modo più sicuro per spostare o modificare le impostazioni di una macchina virtuale 
esistente è clonarla: fai clic con il pulsante destro del mouse sul nome di una macchina esistente > Clona e 
inserisci le informazioni. Per utilizzare il nuovo clone, crea una nuova macchina virtuale e nella procedura 
guidata, quando selezioni il disco rigido, scegli "Usa disco rigido esistente" e seleziona il nuovo clone
.

• Documentazione. La documentazione dettagliata per VB è disponibile tramite la Guida nella barra dei 
menu o come Manuale utente dal sito Web Oracle VirtualBox.

Link

• Wikipedia: Macchina virtuale

• Wikipedia: Confronto tra software di macchine virtuali

• Home page di VirtualBox

• Pacchetto di estensioni VirtualBox

6.3 Ambienti desktop alternativi e gestori di finestre

Figura 6-3: MATE in esecuzione su MX Linux, con YouTube Browser aperto.

Un gestore di finestre (originariamente WIMP: Window, Icon, Menu e Pointing device) in Linux è essenzialmente 
il componente che controlla l'aspetto delle interfacce grafiche utente (GUI) e fornisce i mezzi con cui l'utente può 
interagire con esse. Il termine "ambiente desktop" si riferisce a un insieme di programmi che include un gestore di 
finestre.

Le tre versioni di MX Linux utilizzano Xfce, KDE o Fluxbox per definizione. Ma esistono altre possibilità per gli 
utenti. MX Linux semplifica l'installazione di molte alternative popolari tramite MX Package Installer, come 
descritto di seguito.

https://www.virtualbox.org/manual/
http://en.wikipedia.org/wiki/Virtual_machine
http://en.wikipedia.org/wiki/Comparison_of_platform_virtualization_software
https://www.virtualbox.org/
http://www.virtualbox.org/wiki/Downloads
http://en.wikipedia.org/wiki/Window_manager


• Budgie Desktop, un desktop semplice ed elegante che utilizza GTK+

• Budgie Desktop

• Gnome Base, un gestore di display e desktop basato su GTK+ che fornisce un ambiente desktop 
ultraleggero.

• Gnome Ultra (GOULD), un ambiente desktop ultraleggero

• LXDE qt è un ambiente desktop veloce e leggero i cui componenti possono essere installati 
separatamente.

• Home page di LXQT

• MATE è la continuazione di GNOME 2 e offre un ambiente desktop intuitivo e accattivante.

• Home page di MATE

• IceWM è un ambiente desktop all-in-one molto leggero e un gestore di finestre a stack.

• Home page di IceWM

Una volta installato, puoi scegliere ciò che desideri dal pulsante Sessione al centro della barra superiore nella 
schermata di accesso predefinita; accedi come faresti normalmente. Se sostituisci il gestore di accesso con un altro 
dai repository, assicurati di averne sempre almeno uno disponibile al riavvio.

ALTRO: Wikipedia: Gestori di finestre X

6.4 Riga di comando

Sebbene MX Linux offra una serie completa di strumenti grafici per l'installazione, la configurazione e l'utilizzo del 
sistema, la riga di comando (chiamata anche console, terminale, BASH o shell) rimane uno strumento utile e talvolta 
indispensabile. Ecco alcuni usi comuni:

• Avvia un'applicazione GUI per visualizzare il suo output di errore.

• Accelerare le attività di amministrazione del sistema.

• Configurare o installare applicazioni software avanzate.

• Eseguire più attività in modo rapido e semplice.

• Risolvere i problemi dei dispositivi hardware.

https://en.wikipedia.org/wiki/Budgie_(desktop_environment)
http://sourceforge.net/projects/gould
https://lxqt-project.org/
http://mate-desktop.org/
https://ice-wm.org/
http://en.wikipedia.org/wiki/Comparison_of_X_Window_System_desktop_environments


Il programma predefinito per eseguire un terminale in una finestra desktop MX è Xfce Terminal; quello 
predefinito di KDE è Konsole. Alcuni comandi sono riconosciuti solo dal Super User (root), mentre altri possono 
variare l'output a seconda dell'utente.

Per ottenere permessi root temporanei, utilizzare uno dei metodi descritti nella Sezione 4.7.1. È possibile 
riconoscere quando il terminale è in esecuzione con privilegi root osservando la riga del prompt immediatamente 
prima dello spazio in cui si digita. Invece di un $, si vedrà un #; inoltre, il nome utente cambia in root e potrebbe 
essere scritto in rosso.

NOTA: se si tenta di eseguire come utente normale un comando che richiede privilegi di root come iwconfig, è 
possibile che venga visualizzato un messaggio di errore che indica che il comando non è stato trovato, un 
messaggio che indica che il programma deve essere eseguito come root o semplicemente ci si ritrova nuovamente al 
prompt senza alcun messaggio di errore.

Figura 6-4: L'utente dispone ora dei privilegi amministrativi (root).

6.4.1 Primi passi

• Per ulteriori informazioni sull'esecuzione di un terminale per risolvere i problemi di sistema, fare 
riferimento all'argomento Risoluzione dei problemi alla fine di questa sezione. Inoltre, è consigliabile 
eseguire il backup dei file su cui si sta lavorando come utente root con i comandi cp e mv (vedere sotto).

• Sebbene i comandi del terminale possano essere piuttosto complessi, comprendere la riga di comando è 
solo questione di mettere insieme cose semplici. Per vedere quanto può essere facile, apri un terminale e 
prova alcuni comandi di base. Tutto questo avrà più senso se lo fai come esercizio tutorial piuttosto che 
limitarti a leggerlo. Iniziamo con un comando semplice: ls, che elenca il contenuto di una directory. Il 
comando di base elenca il contenuto della directory in cui ti trovi attualmente:

ls

• Si tratta di un comando utile, ma mostra solo alcune brevi colonne di nomi stampate sullo schermo. 
Supponiamo di volere maggiori informazioni sui file presenti in questa directory. Possiamo aggiungere 
un'opzione al comando per ottenere maggiori informazioni. Un'opzione è un modificatore che 
aggiungiamo a un comando per cambiarne il comportamento. In questo caso, l'opzione che ci serve è:

ls -l

• Come potete vedere sul vostro schermo se state seguendo, questo switch fornisce informazioni più 
dettagliate (in particolare sui permessi) sui file presenti in qualsiasi directory.

• Naturalmente, potremmo voler vedere il contenuto di un'altra directory (senza prima andarci). Per farlo, 
aggiungiamo un argomento al comando, specificando quale file vogliamo vedere. Un argomento è un 
valore o un riferimento che aggiungiamo a un comando per indirizzarne l'operazione.



Ad esempio, specificando l'argomento /usr/bin/, possiamo elencare il contenuto di quella directory anziché 
quello della directory in cui ci troviamo attualmente.

ls -l /usr/bin

• Ci sono molti file in /usr/bin/! Sarebbe utile poter filtrare questo output in modo che vengano elencate solo 
le voci che contengono, ad esempio, la parola "fire". Possiamo farlo convogliando l'output del comando ls 
in un altro comando, grep. Il carattere pipe, o │, viene utilizzato per inviare l'output di un comando 
all'input di un altro. Il comando grep cerca il pattern specificato e restituisce tutti i risultati corrispondenti, 
quindi convogliando l'output del comando precedente verso di esso si filtra l'output.

ls -l /usr/bin | grep fire

• Infine, supponiamo di voler salvare questi risultati in un file di testo per utilizzarli in un secondo momento. 
Quando si eseguono i comandi, l'output viene solitamente indirizzato al display della console, ma è 
possibile reindirizzarlo altrove, ad esempio in un file, utilizzando il simbolo > (reindirizzamento) per 
istruire il computer a creare un elenco dettagliato di tutti i file che contengono la parola "fire" in una 
directory specifica (per impostazione predefinita la directory Home) e a creare un file di testo contenente 
tale elenco, in questo caso denominato "FilesOfFire".

ls -l /usr/bin | grep fire > FilesOfFire.txt

• Come puoi vedere, la riga di comando può essere utilizzata per eseguire operazioni complesse in modo 
molto semplice, combinando comandi semplici in modi diversi.

6.4.2 Comandi comuni

Navigazione nel filesystem

Tabella 6: Comandi di navigazione nel filesystem.

Comando Commento
cd /usr/share Cambia la directory corrente al percorso specificato: "/usr/share". Senza argomenti, cd

ti porta alla tua directory home.

pwd Stampa il percorso della directory di lavoro corrente

ls Elenca il contenuto della directory corrente. Utilizza l'opzione -a per visualizzare anche i file 
nascosti e l'opzione -l per visualizzare i dettagli di tutti i file. Spesso combinato con altri termini. 

lsusb elenca tutti i dispositivi USB, lsmod tutti i moduli, ecc.

Gestione dei file

Tabella 7: Comandi di gestione dei file.

Comando Commento
cp <file sorgente>

<file_destinazione>
Copia un file con un altro nome o in un'altra posizione. Utilizza l'opzione -R 

("ricorsivo") per copiare intere directory.

mv <file sorgente>
<file_destinazione>

Sposta un file o una directory da una posizione a un'altra. Utilizzato anche per rinominare 
file o directory e per eseguire un backup: ad esempio, prima di modificare un file critico 
come xorg.conf, è possibile utilizzare questo comando per spostarlo in qualcosa come 

xorg.conf_bak.

rm <qualchefile> Elimina un file. Utilizza l'opzione -R per eliminare una directory e l'opzione -f



("force") se non si desidera che venga richiesta la conferma per ogni eliminazione.

cat somefile.txt Stampa il contenuto di un file sullo schermo. Utilizzabile solo su file di testo.

grep Trova una determinata stringa di caratteri in un determinato testo e visualizza l'intera 
riga in cui si trova. Di solito viene utilizzato con un pipe, ad esempio cat somefile.txt Ⅰ 

grep
/somestring/ visualizzerà la riga di somefile.txt che contiene

somestring. Per trovare una scheda USB di rete, ad esempio, è possibile digitare: 
lsusb | grep -i Network. Il comando grep distingue automaticamente tra maiuscole e 

minuscole, quindi l'uso dell'opzione -i lo rende insensibile alle maiuscole.

dd Copia qualsiasi cosa bit per bit, quindi può essere utilizzato per directory, partizioni e 
interi dischi. La sintassi di base è dd if=<somefile> of=<some other file>

Simboli

Tabella 8: Simboli.

Comando Commento
| Il simbolo della barra verticale viene utilizzato per inviare l'output di un comando all'input di un altro 

comando.
Alcune tastiere mostrano invece due brevi barre verticali

> Il simbolo di reindirizzamento, utilizzato per inviare l'output di un comando a un file o a un 
dispositivo. Raddoppiando il simbolo di reindirizzamento, l'output di un comando verrà aggiunto a 

un file esistente anziché sostituirlo.

& Aggiungendo il simbolo & alla fine di un comando (preceduto da uno spazio) lo si esegue in 
background, in modo da non dover attendere il completamento per eseguire il comando successivo. Il 
doppio simbolo & indica che il secondo comando deve essere eseguito solo se il primo ha avuto esito 

positivo.

Risoluzione dei problemi

Per la maggior parte dei nuovi utenti Linux, la riga di comando viene utilizzata principalmente come strumento di 
risoluzione dei problemi. I comandi del terminale forniscono informazioni rapide e dettagliate che possono essere 
facilmente incollate in un post su un forum, in una casella di ricerca o in un'e-mail quando si cerca aiuto sul web. Si 
consiglia vivamente di tenere queste informazioni a portata di mano quando si chiede aiuto. La possibilità di fare 
riferimento alla propria configurazione hardware specifica non solo accelererà il processo di ottenimento dell'aiuto, 
ma consentirà anche agli altri di offrire soluzioni più accurate. Di seguito sono riportati alcuni comandi comuni per 
la risoluzione dei problemi (vedere anche la Sezione 3.4.4). Alcuni di essi potrebbero non fornire informazioni o 
fornirne in quantità limitata, a meno che non si sia effettuato l'accesso come root.

Tabella 9: Comandi di risoluzione dei problemi.

Comando Commento
lspci Mostra un breve riepilogo dei dispositivi hardware interni rilevati. Se un dispositivo viene 

visualizzato come
/unknown/, solitamente si tratta di un problema di driver. L'opzione -v consente di visualizzare 

informazioni più dettagliate.
lsusb Elenca i dispositivi USB collegati.

dmesg Mostra il log di sistema per la sessione corrente (cioè dall'ultimo avvio). L'output è piuttosto lungo 
e solitamente viene convogliato tramite grep, less (simile alla maggior parte) o tail (per vedere 
cosa è successo più di recente). Ad esempio, per trovare potenziali errori relativi all'hardware di 

rete, provare dmesg | grep -i net.



top Fornisce un elenco in tempo reale dei processi in esecuzione e varie statistiche su di essi. Disponibile 
anche come Htop insieme a una versione grafica del Task Manager.

Accesso alla documentazione dei comandi

• Molti comandi stampano un semplice messaggio di "informazioni sull'uso" quando si utilizza l'opzione
--help o -h. Questo può essere utile per richiamare rapidamente la sintassi di un comando.

Ad esempio:

cp --help

• Per informazioni più dettagliate su come utilizzare un comando, consultare la pagina man del comando. 
Per impostazione predefinita, le pagine man vengono visualizzate nel pager less del terminale, il che 
significa che viene visualizzata solo una schermata del file alla volta. Tenere a mente questi trucchi per 
navigare nella schermata risultante:

• La barra spaziatrice (o il tasto Pagina giù) fa avanzare la schermata.

• La lettera b (o il tasto Pagina su) fa scorrere la schermata all'indietro.

• La lettera q chiude il documento di aiuto.

In alternativa, è possibile trovare online pagine man ben formattate e di facile lettura, come https://www.mankier.com.

Alias

È possibile creare un alias (nome di comando personale) per qualsiasi comando, breve o lungo, desiderato; 
l'operazione è semplice con lo strumento MX Bash Config. Dettagli nella MX Linux/antiX Wiki.

Link

• Guida per principianti BASH

• Nozioni di base sulla riga di comando

6.5 Script

Uno script è un semplice file di testo che può essere scritto direttamente dalla tastiera e consiste in una serie di 
comandi del sistema operativo in sequenza logica. I comandi vengono gestiti uno alla volta da un interprete di 
comandi che a sua volta richiede servizi al sistema operativo. L'interprete di comandi predefinito in MX Linux è 
Bash. I comandi devono essere comprensibili a Bash e sono stati creati elenchi di comandi per l'uso nella 
programmazione. Uno script di shell è l'equivalente Linux dei programmi batch nel mondo Windows.

Gli script sono utilizzati in tutto il sistema operativo MX Linux e nelle applicazioni che vi girano come metodo 
economico per eseguire più comandi in modo facile da creare e modificare. Durante l'avvio,

https://www.mankier.com/
http://mxlinux.org/wiki/system/alias
http://tldp.org/LDP/Bash-Beginners-Guide/html/index.html
http://www.linuxcommand.org/


ad esempio, vengono richiamati molti script per avviare processi specifici come la stampa, la rete, ecc. Gli script 
vengono utilizzati anche per processi automatizzati, amministrazione di sistema, estensioni di applicazioni, controlli 
utente, ecc. Infine, gli utenti di ogni tipo possono utilizzare gli script per i propri scopi.

6.5.1 Uno script semplice

Creiamo uno script molto semplice (e famoso) per capire l'idea di base.

1. Apri il tuo editor di testo (Menu Start > Accessori) e digita:

#!/bin/bash clear
echo Buongiorno, mondo!

2. Salvate il file nella vostra directory home con il nome SimpleScript.sh

3. Fai clic con il pulsante destro del mouse sul nome del file, seleziona Proprietà e seleziona 
"Consenti l'esecuzione di questo file come programma" nella scheda Autorizzazioni.

4. Apri un terminale e digita:

sh /home/<nome utente>/SimpleScript.sh

5. Sullo schermo apparirà la riga "Buongiorno, mondo!". Questo semplice script non fa molto, ma stabilisce il 
principio secondo cui un semplice file di testo può essere utilizzato per inviare comandi per controllare il 
comportamento del sistema.

NOTA: tutti gli script si aprono con uno shebang all'inizio della prima riga: si tratta di una combinazione di un 
cancelletto (#), un punto esclamativo e il percorso dell'interprete di comandi. In questo caso, Bash è l'interprete e si 
trova nella posizione standard per le applicazioni utente.

LINK

• Guida per principianti a Bash

• Tutorial sugli script di shell Linux

• Comandi Linux

6.5.2 Tipi di script speciali

Alcuni script richiedono un software speciale (linguaggio di scripting) per essere eseguiti, invece di essere 
semplicemente avviati in Bash. I più comuni per gli utenti regolari sono gli script Python, che hanno estensione 
*.py.

Per eseguirli, è necessario richiamare python per eseguire l'esecuzione fornendo il percorso corretto. Se avete 
scaricato "<somefile>.py" sul vostro desktop, ad esempio, potete fare una delle tre cose seguenti:

https://en.wikipedia.org/wiki/Shebang_(Unix)
http://www.tldp.org/LDP/Bash-Beginners-Guide/html/Bash-Beginners-Guide.html
http://www.freeos.com/guides/lsst
http://www.linuxcommand.org/
https://en.wikipedia.org/wiki/Scripting_language


◦ Basta cliccarci sopra. MX Linux ha un piccolo programma chiamato Py-Loader che lo avvierà 
utilizzando python.

◦ Aprire un terminale e digitare:

python ~/Desktop/<somefile.py

◦ In alternativa, puoi aprire un terminale all'interno della cartella stessa, nel qual caso dovrai 
digitare:

python ./<somefile>.py

I linguaggi di scripting sono molto avanzati e esulano dall'ambito di questo manuale utente.

6.5.3 Script utente preinstallati

inxi
Inxi è un comodo script di informazioni di sistema da riga di comando scritto da un programmatore noto come "h2". 
Digita inxi -h in un terminale per vedere tutte le opzioni disponibili, che includono una gamma completa che va 
dall'output dei sensori al meteo. Questo è il comando che gira dietro MX Quick System Info.

ALTRO: MX Linux/antiX Wiki

6.5.4 Suggerimenti e trucchi

• Facendo doppio clic su uno script di shell, questo viene aperto nell'editor Featherpad invece di essere 
eseguito. Si tratta di una misura di sicurezza progettata per impedire l'esecuzione accidentale di script 
quando non lo si desidera. Per modificare questo comportamento, fare clic su Impostazioni > Editor tipi 
MIME. Individuare x-application/x-shellscript e modificare l'applicazione predefinita in bash.

• Un editor più avanzato per la programmazione di script è Geany, installato di default. Si tratta di un 
IDE/editor flessibile e potente, leggero e multipiattaforma.

6.6 Strumenti MX avanzati

Oltre alla configurazione delle app MX discussa nella Sezione 3.2, MX Linux include utilità per utenti avanzati 
disponibili da MX Tools.

6.6.1 Scansione di ripristino chroot (CLI)

Una serie di comandi che consentono di accedere a un sistema anche se il suo initrd.img è danneggiato. Consente 
inoltre di accedere a più sistemi operativi installati senza dover riavviare il sistema. Dettagli e immagini nel file 
HELP.

http://smxi.org/
https://mxlinux.org/wiki/antix-faqs-applications/guide-smxisgfxiinxi
https://www.geany.org/


HELP: qui.

6.6.2 Live-USB Kernel Updater (CLI)

 VIDEO: Modifica il tuo kernel su un live-USB antiX o MX

ATTENZIONE: da utilizzare solo in una sessione Live!

Questa applicazione da riga di comando può aggiornare il kernel su un MX LiveUSB con qualsiasi kernel 
installato. Questa applicazione verrà visualizzata in MX Tools solo durante l'esecuzione di una sessione Live.

Figura 6-5: Lo strumento live-usb kernel updater pronto per passare a un nuovo kernel.

AIUTO: qui.

6.6.3 Live Remaster (MX Snapshot e RemasterCC) 

 VIDEO: Creare uno snapshot di un sistema installato

 VIDEO: Creare un live-USB con persistenza  
VIDEO: Installare applicazioni su un live-USB con persistenza

NOTA: Live Remaster sarà visibile solo in MX Tools e sarà eseguibile solo durante una sessione live.

https://mxlinux.org/wiki/system/chroot-rescue-scan/
https://www.youtube.com/watch?v=UWvwbwTGOZ8&t=2s
https://mxlinux.org/wiki/help-files/help-live-usb-kernel-updater
https://www.youtube.com/watch?v=ExVkxXcVDAw
https://www.youtube.com/watch?v=2vF_dw6Kpo8
https://www.youtube.com/watch?v=6BsCx1-v3Ro


Lo scopo principale di Live Remastering è quello di rendere il più sicuro, facile e conveniente possibile per gli 
utenti la creazione della propria versione personalizzata di MX Linux che può essere distribuita ad altri computer. 
L'idea è quella di utilizzare una LiveUSB (o una LiveHD, una "installazione frugale"; vedere il Wiki MX 
Linux/antiX) su una partizione del disco rigido come ambiente di sviluppo e test. Aggiungere o sottrarre pacchetti 
e poi, quando si è pronti per il remastering, utilizzare la GUI o lo script e riavviare. Se qualcosa va storto, è 
sufficiente riavviare nuovamente con l'opzione di rollback e si avvierà l'ambiente precedente.

Molti utenti avranno già familiarità con lo strumento MX Snapshot per la rimasterizzazione (vedere anche 
un'applicazione più vecchia ma ancora utile RemasterCC), e molti membri della comunità MX Linux lo utilizzano 
per produrre versioni non ufficiali di MX Linux che possono essere monitorate sul forum di supporto MX. L'ISO 
rimasterizzata (una "respin") può essere inserita su un Live Medium nel modo consueto (vedere la Sezione 2.2) e 
quindi installata, se lo si desidera, aprendo un terminale root e inserendo il comando: minstall-launcher.

Figura 6-7: Schermata di apertura di Snapshot.

 VIDEO: Rimasterizza il tuo Live-USB

 VIDEO: MX Spins: Workbench!

 VIDEO: MX Spins: Stevo's KDE!

https://mxlinux.org/wiki/system/frugal-installation
https://mxlinux.org/wiki/system/frugal-installation
https://mxlinux.org/wiki/help-files/help-live-remasterpersistence-remastercc
https://forum.mxlinux.org/viewforum.php?f=127
https://www.youtube.com/watch?v=LpI_a4xPKdM
https://www.youtube.com/watch?v=zwLz2vLc_qg
https://www.youtube.com/watch?v=87Qb3_S8dGA


 VIDEO: Live USB con persistenza (modalità Legacy)

 VIDEO: Live USB con persistenza (modalità UEFI)

6.6.4 SSH (Secure Shell)

SSH (Secure Shell) è un protocollo utilizzato per accedere in modo sicuro a sistemi remoti. È il modo più comune 
per accedere a computer remoti Linux e Unix-like. MX Linux viene fornito con i pacchetti principali necessari per 
eseguire SSH in modalità attiva, il principale dei quali è OpenSSH, un'implementazione gratuita di Secure Shell 
che consiste in un'intera suite di applicazioni.

• Avvia o riavvia il demone ssh come root con il comando:

/etc/init.d/ssh start

• Per avviare automaticamente il demone ssh all'avvio del computer, fare clic su Impostazioni > Sessione e 
avvio > Avvio automatico delle applicazioni. Fare clic sul pulsante Aggiungi, quindi nella finestra di 
dialogo inserire un nome come StartSSH, una breve descrizione se lo si desidera e il comando

/etc/init.d/ssh start

Premere OK e il gioco è fatto. Al prossimo riavvio, il demone SSH sarà attivo.

• Gli utenti KDE su MX Linux possono fare lo stesso utilizzando Impostazioni > Impostazioni di 
sistema > Avvio e spegnimento > Avvio automatico.

Risoluzione dei problemi SSH

A volte SSH non funziona in modalità passiva, inviando un messaggio di connessione negata. In tal caso puoi 
provare quanto segue:

• Modificare come root il file "/etc/ssh/sshd-config". Intorno alla riga 16 troverete il parametro 
"UsePrivilegeSeparation yes". Modificatelo in:

UsePrivilegeSeparation no

• Aggiungere se stessi (o gli utenti desiderati) al gruppo "ssh" utilizzando MX User Manager o modificando 
come root il file /etc/group.

• A volte i certificati possono essere mancanti o non aggiornati; un modo semplice per ricostruirli è 
eseguire (come root) il comando:

ssh-keygen -A

• Verifica se sshd è in esecuzione digitando:

https://www.youtube.com/watch?v=RC4SmhsG3K0
https://www.youtube.com/watch?v=DJmukS-bSxw
http://en.wikipedia.org/wiki/Secure_Shell


/etc/init.d/ssh status

Il sistema dovrebbe rispondere "[ ok ] sshd è in esecuzione".

• Se uno dei PC utilizza il firewall [Uncompliated], predefinito per MX 23 e versioni successive, verificare 
che la porta 22 UDP non sia bloccata. Deve consentire il traffico IN e OUT.

ALTRO: Manuale OpenSSH

6.7 Sincronizzazione dei file

La sincronizzazione dei file (o syncing) consente di mantenere identici i file in posizioni diverse. Può assumere 
due forme:

• unidirezionale ("mirroring"), in cui un computer sorgente viene copiato su altri ma non 
viceversa.

• bidirezionale, in cui più computer vengono mantenuti identici.

Ad esempio, gli utenti di MX Linux lo trovano utile quando gestiscono più installazioni per sé stessi, i propri 
familiari o altri gruppi, eliminando così la necessità di effettuare più di un aggiornamento. Esistono numerosi 
software di sincronizzazione disponibili, ma i seguenti due sono stati testati e si sono dimostrati utili per gli utenti di 
MX Linux:

• Unison-GTK (nei repository)

• FreeFileSync

http://www.openssh.com/manual.html
https://en.wikipedia.org/wiki/File_synchronization
https://en.wikipedia.org/wiki/Comparison_of_file_synchronization_software
https://github.com/bcpierce00/unison
https://www.freefilesync.org/


7.1 Introduzione 
MX Linux eredita il suo design fondamentale da Unix, un sistema operativo che esiste in varie forme dal 1970. Da 
esso è stato sviluppato Linux, da cui Debian produce la sua distribuzione. Il sistema operativo di base è 
l'argomento di questa sezione. Gli utenti provenienti da sistemi legacy come MS Windows in genere trovano molti 
concetti sconosciuti e si sentono frustrati nel cercare di fare le cose nel modo in cui sono abituati a farle.

Questa sezione fornirà una panoramica di alcuni aspetti fondamentali del sistema operativo MX Linux e di come 
questi differiscono dagli altri sistemi, per facilitare la transizione.

Link

• Wikipedia: Unix

• Home page di Linux

• Wikipedia Debian

7.2 La struttura del file system
Il termine "file system" ha due significati fondamentali.

• Il primo è il file system del sistema operativo. Si riferisce ai file e alla loro organizzazione che il sistema 
operativo utilizza per tenere traccia di tutte le risorse hardware e software a sua disposizione durante il 
funzionamento.

• L'altro uso del termine file system si riferisce al file system del disco, progettato per l'archiviazione e il 
recupero di file su un dispositivo di archiviazione dati, più comunemente un'unità disco. Il file system del 
disco viene impostato quando la partizione del disco viene formattata per la prima volta, prima di scrivere 
qualsiasi dato sulla partizione.

7.2.1 Il filesystem del sistema operativo
Se si apre Thunar File Manager e si fa clic su File System nel riquadro sinistro, si noterà una serie di directory con 
nomi basati sullo standard Unix Filesystem Hierarchy Standard.

7 Sotto il cofano

https://en.wikipedia.org/wiki/Unix
http://en.wikipedia.org/wiki/Unix
http://www.linux.org/
http://en.wikipedia.org/wiki/Debian
https://refspecs.linuxfoundation.org/FHS_3.0/fhs/index.html


Figura 7-1: Il filesystem MX visualizzato in Thunar.

Ecco una semplice descrizione delle principali directory in MX Linux insieme a un esempio di quando gli utenti 
lavorano comunemente con i file in quelle directory:

• /bin

• Questa directory contiene i file di programma binari utilizzati dal sistema durante l'avvio, ma che 
possono anche essere richiesti dalle azioni dell'utente una volta che il sistema è completamente 
avviato e funzionante.

• Esempio: molti programmi di base della riga di comando, come la shell Bash, e utilità come /dd/, 
/grep/, /ls/ e /mount/ si trovano qui, oltre ai programmi utilizzati solo dal sistema operativo.

• /boot

• Come si può intuire, qui si trovano i file necessari a Linux per l'avvio. Il kernel Linux, il 
cuore del sistema operativo Linux, è conservato qui, così come i bootloader come GRUB.

• Esempio: nessun file qui è comunemente accessibile agli utenti.

• /dev



• /etc

• In questa directory si trovano file speciali che collegano i vari dispositivi di input/output del 
sistema.

• Esempio: nessun file qui è comunemente accessibile direttamente dagli utenti, tranne che 
nei comandi di montaggio CLI.

• Questa directory contiene i file di configurazione del sistema e i file di configurazione delle 
applicazioni.

• Esempio: il file /etc/fstab specifica i punti di montaggio per i file system aggiuntivi su 
dispositivi, partizioni, ecc. che possono essere configurati per un utilizzo ottimale.

• Esempio: i problemi di visualizzazione a volte comportano la modifica del file /etc/X11/xorg.conf.

• /home

• Qui risiedono le directory personali dell'utente (dati e impostazioni). Se sono presenti più utenti, 
viene creata una sottodirectory separata per ciascuno di essi. Nessun utente (eccetto root) può 
leggere la directory home di un altro utente. La directory dell'utente contiene sia file nascosti (il 
cui nome è preceduto da un punto) che file visibili. I file nascosti possono essere visualizzati 
cliccando su Visualizza > Mostra file nascosti (o Ctrl-H) in Thunar File Manager.

• Esempio: in genere gli utenti organizzano i propri file utilizzando inizialmente le directory 
predefinite, come Documenti, Musica, ecc.

• Esempio: un profilo Firefox si trova nella directory nascosta .mozilla/firefox/

• /lib

• Questa directory contiene librerie di oggetti condivisi (analoghi alle DLL di Windows) necessari 
all'avvio del sistema. In particolare, i moduli del kernel si trovano qui, sotto
/lib/modules.

• Esempio: nessun file qui è comunemente accessibile agli utenti.

• /media

• I file per supporti rimovibili come CD-ROM, unità floppy e chiavette USB vengono 
installati qui quando i supporti vengono montati automaticamente.

• Esempio: dopo aver montato dinamicamente un dispositivo periferico come un'unità flash, è 
possibile accedervi qui.

• /mnt

• I dispositivi di archiviazione fisici devono essere montati qui prima di poter essere accessibili. 
Dopo aver definito le unità o le partizioni nel file /etc/fstab, il loro file system viene montato qui.

• Esempio: gli utenti possono accedere ai dischi rigidi e alle loro partizioni montati qui.

• /opt

• Questa è la posizione prevista per i principali sottosistemi di applicazioni di terze parti installati 
dall'utente. Alcune distribuzioni collocano qui anche i programmi installati dall'utente.



• Esempio: se installi Google Earth, questo è il luogo in cui verrà installato. Anche Firefox, 
Libre Office e Wine si troverebbero qui.

• /proc

• Posizione delle informazioni sui processi e sul sistema.

• Esempio: nessun file qui è comunemente accessibile agli utenti.

• /root

• Questa è la directory home dell'utente root (amministratore). Si noti che non è la stessa cosa di 
"/" la radice del file system.

• Esempio: nessun file qui è comunemente accessibile agli utenti, ma i file salvati mentre si è 
connessi come utente root possono essere salvati qui.

• /sbin

• I programmi vengono installati qui se richiesti dagli script di avvio del sistema, ma 
normalmente non vengono eseguiti dagli utenti, ad eccezione di root, ovvero le utilità di 
amministrazione del sistema.

• Esempio: nessun file qui è comunemente accessibile agli utenti, ma è qui che si trovano file come
modprobe e ifconfig.

• /tmp

• Questa è la posizione dei file temporanei prodotti dai programmi, come i compilatori
, durante la loro esecuzione. In generale, si tratta di file temporanei a breve termine, utili a un 
programma solo mentre è in esecuzione.

• Esempio: nessun file qui è comunemente accessibile agli utenti.

• /usr

• /var

• Questa directory contiene molti file per le applicazioni degli utenti ed è in qualche modo analoga 
alla directory "Programmi" di Windows.

• Esempio: molti programmi eseguibili (binari) si trovano in /usr/bin.

• Esempio: la documentazione (/usr/docs) e i file di configurazione, la grafica e le icone si 
trovano in /usr/share.

• Questa directory contiene file che cambiano continuamente mentre Linux è in esecuzione,
ad esempio log, posta di sistema e processi in coda.

• Esempio: è possibile consultare /var/log/ utilizzando MX Quick System Info quando si cerca di 
determinare cosa è successo durante un processo come l'installazione di un pacchetto.

7.2.1 Il filesystem del disco
Il file system del disco è qualcosa di cui l'utente medio non deve preoccuparsi più di tanto. Il file system 
predefinito utilizzato da MX Linux si chiama ext4, una versione del file system ext2



che è journaled, ovvero scrive le modifiche in un log prima di applicarle, rendendolo più robusto. Il file system 
ext4 viene impostato durante l'installazione quando si formatta il disco rigido.

In generale, ext4 ha più anni di esperienza rispetto a qualsiasi altro suo rivale e combina stabilità e velocità. Per 
questi motivi, non consigliamo di installare MX Linux su un file system su disco diverso, a meno che non si abbia 
una buona conoscenza delle differenze. Tuttavia, MX Linux può leggere e scrivere su molti altri file system su disco 
formattati e può anche essere installato su alcuni di essi, se per qualche motivo uno di essi è preferibile a ext4.

Link

• Wikipedia. Confronto tra file system

• Wikipedia Ext4

7.3 Autorizzazioni

MX Linux è un sistema operativo basato su account. Ciò significa che nessun programma può essere eseguito 
senza un account utente e che qualsiasi programma in esecuzione è quindi limitato dai permessi concessi all'utente 
che lo ha avviato.

NOTA: gran parte della sicurezza e della stabilità per cui Linux è noto dipende dall'uso corretto di account utente 
limitati e dalla protezione fornita dai permessi predefiniti di file e directory. Per questo motivo, è consigliabile 
operare come root solo per le procedure che lo richiedono. Non accedere mai a MX Linux come root per 
eseguire le normali attività del computer: ad esempio, eseguire un browser web come utente root è uno dei pochi 
modi in cui è possibile contrarre un virus su un sistema Linux!

7.3.1 Informazioni di base
La struttura predefinita dei permessi dei file in Linux è piuttosto semplice, ma più che adeguata per la maggior 
parte delle situazioni. Per ogni file o cartella, ci sono tre permessi che possono essere concessi e tre entità 
(proprietario/creatore, gruppo, altri/mondo) a cui vengono concessi. I permessi sono:

• Il permesso di lettura significa che i dati possono essere letti dal file; significa anche che il file può essere 
copiato. Se non si dispone del permesso di lettura per una directory, non è possibile nemmeno vedere i 
nomi dei file in essa contenuti.

• Il permesso di scrittura significa che il file o la cartella possono essere modificati, aggiunti o eliminati. 
Per le directory, specifica se un utente può scrivere sui file nella directory.

• Il permesso di esecuzione indica se l'utente può eseguire il file come script o programma. Per le directory, 
determina se l'utente può accedervi e renderla la directory di lavoro corrente.

• Ogni file e cartella acquisisce un singolo utente designato come proprietario quando viene creato sul 
sistema. (Si noti che se si sposta un file da un'altra partizione in cui ha un proprietario diverso, manterrà il 
proprietario originale; ma se lo si copia e incolla, verrà assegnato all'utente). Ha anche un singolo gruppo 
designato come gruppo, per impostazione predefinita il gruppo a cui appartiene il

http://en.wikipedia.org/wiki/File_system
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proprietario. Le autorizzazioni concesse agli altri influiscono su tutti coloro che non sono il proprietario o 
il gruppo proprietario.

NOTA: per gli utenti avanzati, è possibile impostare attributi speciali aggiuntivi oltre a lettura/scrittura/esecuzione: 
sticky bit, SUID e SGID. Per ulteriori informazioni, consultare la sezione Collegamenti di seguito.

Visualizzazione, impostazione e modifica dei permessi
MX Linux offre molti strumenti per visualizzare e gestire i permessi.

• GUI

• File Manager. Per visualizzare o modificare i permessi di un file, fare clic con il tasto destro del 
mouse sul file e selezionare Proprietà. Fare clic sulla scheda Permessi. Qui è possibile impostare i 
permessi concessi al proprietario, al gruppo e ad altri utilizzando i menu a tendina. Per alcuni file 
(come gli script, ad esempio), è necessario selezionare la casella per renderli eseguibili, mentre per 
le cartelle è possibile selezionare una casella per limitare la cancellazione dei file al loro interno ai 
proprietari.

NOTA: è necessario operare come root per modificare i permessi di un file o di una directory il 
cui proprietario è root. Sulle cartelle più grandi è NECESSARIO aggiornare la finestra del File 
Manager, altrimenti i permessi verranno visualizzati in modo errato, anche se sono stati 
effettivamente modificati. Basta premere F5 per aggiornare la finestra, altrimenti verranno 
visualizzati i permessi originali. Dolphin File Manager offre "Permessi avanzati" che altrimenti 
richiederebbero comandi da terminale per essere modificati o visualizzati.

• MX User Manager è un modo semplice per modificare i permessi associando un utente a 
gruppi specifici.

• CLI

• Partizioni interne. Per impostazione predefinita, per montare le partizioni interne è necessaria 
la password di root/superutente. Per modificare questo comportamento, clicca su MX Tweak > 
Altro.

• Nuove partizioni esterne. La formattazione di una nuova partizione con ext4 richiede i permessi 
di root, il che può portare a risultati imprevisti o indesiderati, impedendo all'utente normale di 
scrivere qualsiasi file sulla partizione. Per modificare questo comportamento, consultare il Wiki 
di MX Linux/antiX.

• Operazioni manuali. Sebbene MX User Manager copra la maggior parte delle situazioni 
quotidiane, a volte può essere preferibile utilizzare la riga di comando. I permessi di base sono 
rappresentati da r (lettura), w (scrittura) e x (esecuzione); un trattino indica l'assenza di permessi.

Per visualizzare i permessi di un file sulla riga di comando, digitare: ls -l NomeFile. Potrebbe 
essere necessario utilizzare il percorso completo del file (ad esempio, /usr/bin/gimp). L'opzione -l 
farà sì che il file venga elencato in formato lungo, visualizzando i suoi permessi insieme ad altre 
informazioni.

https://mxlinux.org/wiki/system/format-ext4-filesystem-be-owned-regular-user
https://mxlinux.org/wiki/system/format-ext4-filesystem-be-owned-regular-user


Figura 7-2: Visualizzazione dei permessi di un file.

I caratteri immediatamente dopo il trattino iniziale (che indica che si tratta di un file normale) 
contengono i tre permessi (lettura/scrittura/esecuzione) per il proprietario, il gruppo e gli altri: 9 
caratteri in totale. Qui si vede che il proprietario ha i permessi di lettura e scrittura ma non di 
esecuzione (rw-), mentre il gruppo e gli altri possono solo leggere. Il proprietario in questo caso 
è specificato come "newbie" e appartiene al gruppo "users".

Se per qualche motivo fosse necessario cambiare la proprietà di questo file a root utilizzando la 
riga di comando, l'utente "newbie" utilizzerebbe il comando chown come in questo esempio:

chown root /home/newbie/.asoundrc

Per i dettagli sull'uso di chown, così come per il più dettagliato chmod, vedere la sezione Link.

Link

• MX Linux/antiX Wiki: Permessi

• Permessi dei file

7.4 File di configurazione

7.4.1 File di configurazione utente
I file che contengono le impostazioni individuali dell'utente (come i punteggi più alti dei giochi o il layout del 
desktop) sono memorizzati nella directory home dell'utente, in genere come file o directory nascosti, e possono 
essere modificati solo dall'utente stesso o dall'amministratore. Questi file di configurazione personali vengono 
modificati direttamente meno spesso dei file di sistema, poiché la maggior parte della configurazione utente viene 
effettuata graficamente attraverso le applicazioni stesse.

Quando si apre un'applicazione e si fa clic su Modifica > Preferenze, ad esempio, le selezioni vengono scritte in un 
file di configurazione (solitamente nascosto) nella directory utente. Allo stesso modo, in Firefox, quando si digita 
about:config nella barra degli indirizzi, si modificano i file di configurazione nascosti. I file di configurazione Xfce 
sono memorizzati in ~/.config/.

7.4.2 File di configurazione di sistema
I file che contengono le configurazioni o le impostazioni predefinite a livello di sistema (come il file che determina 
quali servizi vengono avviati automaticamente durante l'avvio) sono in gran parte memorizzati nella directory /etc/ e 
sono modificabili solo

https://mxlinux.org/wiki/system/permissions


modificabili da root. La maggior parte di questi file non viene mai modificata direttamente dagli utenti normali, 
come ad esempio questi:

• /etc/rc.d/rc5.d — Contiene i file per controllare il runlevel 5 in cui MX Linux si avvia dopo il login.

• /etc/sysconfig/keyboard — Utilizzato per configurare la tastiera.

• /etc/network/interfaces — Definisce le interfacce Internet sul sistema.

Alcuni file di configurazione possono contenere solo poche righe o essere addirittura vuoti, mentre altri possono 
essere piuttosto lunghi. Il punto importante è che se stai cercando un file di configurazione per un'applicazione o 
un processo, vai alla directory /etc e dai un'occhiata.

Attenzione: poiché questi file influenzano l'intero sistema,

1) esegui il backup di qualsiasi file che intendi modificare (il modo più semplice è in Thunar: copia e incolla 
di nuovo, aggiungendo facoltativamente BAK alla fine del nome del file),

e

2) fai molta attenzione!

7.4.3 Esempio
I problemi audio possono essere risolti con una serie di strumenti grafici e da riga di comando, ma ogni tanto un 
utente ha bisogno di modificare direttamente il file di configurazione di sistema. Per molti sistemi, questo sarà 
/etc/modprobe.d/snd-hda-intel.conf. Si tratta di un file semplice il cui paragrafo iniziale è simile a questo:

# alcuni chip richiedono che il modello sia impostato 
manualmente # ad esempio la serie asus g71 potrebbe 
richiedere model=g71v

options snd-hda-intel model=auto

Per provare a ottenere l'audio, potresti decidere di sostituire la parola "auto" con le informazioni esatte relative al 
modello audio. Per scoprire il tuo modello audio, potresti aprire un terminale e digitare:

lspci | grep Audio

Il risultato dipenderà dal sistema, ma avrà la seguente forma:

00:05.0 Dispositivo audio: nVidia Corporation MCP61 High Definition Audio (rev a2)

Ora puoi reinserire queste informazioni nel file di configurazione:

# alcuni chip richiedono che il modello sia impostato 
manualmente # ad esempio la serie asus g71 potrebbe richiedere le 
opzioni model=g71v snd-hda-intel model=nvidia

Salvate il file, riavviate il computer e, se tutto va bene, l'audio dovrebbe funzionare. Se il primo tentativo non ha 
funzionato, potete provare con maggiore precisione utilizzando invece model=nvidia mcp61.

Collegamenti



• Comprendere i file di configurazione di Linux

• Permessi dei file

7.5 Livelli di esecuzione 
MX Linux si avvia per impostazione predefinita utilizzando un tipo di processo di inizializzazione (init) chiamato 
sysVinit. Dopo aver completato il processo di avvio, init esegue tutti gli script di avvio in una directory specificata 
dal runlevel predefinito (questo runlevel è indicato dalla voce ID in /etc/inittab). MX Linux ha 7 runlevel (altri 
processi come systemd non utilizzano i runlevel allo stesso modo):

Tabella 10: Livelli di esecuzione in MX Linux.

Livello di 
esecuzione

Commento

0 Arresta il sistema

1 Modalità utente singolo: fornisce una console root senza accesso.
Utile se si perde la password di root

2 Multiuser senza rete

3 Accesso alla console, senza X (cioè senza GUI)

4 Non utilizzato/personalizzato

5 Accesso GUI predefinito

6 Riavvia il sistema

MX Linux è impostato di default sul runlevel 5, quindi tutti gli script di init configurati nel file di configurazione 
del livello 5 verranno eseguiti all'avvio.

Utilizzo
Comprendere i livelli di esecuzione può essere utile. Quando gli utenti hanno un problema con X Window Manager, 
ad esempio, non possono correggerlo sul livello di esecuzione predefinito 5, perché X è in esecuzione su quel 
livello. Ma possono passare al livello di esecuzione 3 per risolvere il problema in uno dei due modi seguenti.

• Dal desktop: premere Ctrl-Alt-F1 per uscire da X. Per passare effettivamente al livello di 
esecuzione 3, diventare root e digitare telinit 3; questo fermerà tutti gli altri servizi ancora in 
esecuzione sul livello di esecuzione 5.

• Dal menu GRUB: premere e (per modificare) quando viene visualizzata la schermata GRUB. Nella 
schermata successiva, aggiungere uno spazio e il numero 3 alla fine della riga (per impostazione 
predefinita dove si trova la parola "quiet") che inizia con "linux" situata una sopra la riga più bassa (il 
comando di avvio effettivo). Premere F-10 per avviare il sistema.

Una volta che il cursore si trova al prompt, effettuare il login con il proprio nome utente e password normali. Se 
necessario, è anche possibile effettuare il login come "root" e fornire la password amministrativa. I comandi utili 
quando si guarda il prompt sul runlevel 3 includono:

Tabella 11: Comandi comuni del runlevel 3.

https://mxlinux.org/wiki/system/permissions
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Comando Commento
runlevel Restituisce il numero del runlevel in cui ci si trova.

halt Eseguire come root. Spegne la macchina. Se non funziona sul proprio sistema, provare con 
poweroff.

reboot Esegui come root. Riavvia la macchina.

<applicazione> Esegue l'applicazione, purché non sia grafica. Ad esempio, è possibile utilizzare il comando nano 
per modificare i file di testo, ma non leafpad.

Ctrl-Alt-F7 Se hai utilizzato Ctrl-Alt-F1 per uscire da un desktop in esecuzione ma non sei passato al livello 
di esecuzione 3, questo comando ti riporta al desktop.

telinit 5 Eseguire come root. Se ci si trova al livello di esecuzione 3, immettere questo comando per 
accedere al gestore di login lightdm.

Collegamenti

• Wikipedia: Livello di esecuzione

• The Linux Information Project: Definizione di runlevel

7.6 Il kernel 

7.6.1 Introduzione

Questa sezione tratta le interazioni comuni dell'utente con il kernel. Consultare i link per altri aspetti più tecnici.

7.6.2 Aggiornamento/Downgrade

Nozioni di base
A differenza di altri software presenti nel sistema, il kernel non viene aggiornato automaticamente, tranne che al di 
sotto del livello di revisione minore (indicato dal terzo numero nel nome del kernel). Prima di modificare il kernel 
corrente, è bene porsi alcune domande:

• Perché voglio aggiornare il kernel? C'è un driver di cui ho bisogno per un nuovo hardware, ad 
esempio?

• Devo effettuare il downgrade del kernel? Ad esempio, i processori Core2 Duo tendono ad avere strani 
problemi con il kernel MX-Linux predefinito che vengono risolti passando a un kernel Debian meno 
recente (utilizzando MX Package Installer).

• Sono consapevole che modifiche non necessarie potrebbero causare problemi di vario tipo?

MX Linux fornisce un metodo semplice per aggiornare/downgrade il kernel predefinito: apri MX Package Installer 
> Kernel. Qui vedrai una serie di kernel disponibili per l'utente. Seleziona quello che desideri utilizzare (chiedi sul 
forum se non sei sicuro) e installalo.

http://en.wikipedia.org/wiki/Runlevel
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Una volta verificato e installato il nuovo kernel, riavvia e assicurati che il nuovo kernel sia evidenziato; in caso 
contrario, clicca sulla riga delle opzioni e seleziona quello che desideri.

Figura 7-3: Opzioni del kernel in MX Package Installer per architettura a 64 bit.

Avanzato
Molti utenti ricorrono normalmente a MX Package Installer per aggiornare il proprio kernel, ma è possibile farlo 
anche manualmente. Ecco un approccio di base per aggiornare manualmente il kernel Linux sul tuo sistema.

• Per prima cosa, scopri cosa hai attualmente installato. Apri un terminale e digita inxi -S. Ad esempio, 
un utente della versione MX-25 a 64 bit potrebbe vedere qualcosa di simile a questo:

Kernel: 6.1.0-2-amd64 x86_64 bit

Assicuratevi di annotare il nome del kernel dall'output di quel comando.

• In secondo luogo, seleziona e installa un nuovo kernel. Apri Synaptic Package Manager, cerca linux-
image e cerca un numero di kernel più alto che corrisponda all'architettura (ad esempio, 686) e al 
processore (ad esempio, PAE) che hai già, a meno che tu non abbia un buon motivo per cambiare. Installa 
quello che desideri o di cui hai bisogno nel modo consueto.

• In terzo luogo, installa il pacchetto linux-headers corrispondente al nuovo kernel selezionato. Ci sono due 
metodi per farlo.

• Esamina attentamente le voci di Synaptic che iniziano con linux-headers e abbina il kernel.



• In alternativa, puoi installare le intestazioni più facilmente dopo aver riavviato il nuovo kernel 
digitando il seguente codice in un terminale root:

apt-get install linux-headers-$(uname -r)

Le intestazioni verranno installate anche se si utilizza un comando come m-a prepare.

• Al riavvio, dovresti avviare automaticamente il kernel più recente disponibile. Se non funziona, hai la 
possibilità di tornare a quello che stavi utilizzando: riavvia e, quando viene visualizzata la schermata 
GRUB, evidenzia Opzioni avanzate per la partizione che desideri avviare, quindi seleziona il kernel e 
premi Invio.

7.6.3 Aggiornamento del kernel e driver

Il supporto dinamico dei moduli del kernel (DKMS) ricompila automaticamente tutti i moduli dei driver DKMS 
quando viene installata una nuova versione del kernel. Ciò consente ai driver e ai dispositivi esterni al kernel 
principale di continuare a funzionare dopo l'aggiornamento del kernel Linux. L'eccezione riguarda i driver grafici 
proprietari (Sezione 3.3.2).

• Driver NVidia

• Se installati con sgfxi, devono essere ricompilati con sgfxi, vedere la Sezione 6.5.3

• Se installati con il programma di installazione del driver MX Nvidia o tramite synaptic/apt-get, 
potrebbe essere necessario ricompilare i moduli del kernel. Rieseguendo il programma di 
installazione del driver MX Nvidia dal menu dovrebbe essere possibile reinstallare e ricompilare i 
moduli. Se il riavvio si blocca al prompt della console, diventare root e inserire "ddm-mx -i 
nvidia" per reinstallare e ricompilare i moduli del driver.

• Driver Intel

• Potrebbe essere necessario aggiornare il driver [jb: link alla sezione precedente], a seconda 
del kernel selezionato come obiettivo dell'aggiornamento.

Una nota sui moduli DMKS e Secure Boot
I moduli DMKS non sono firmati da Debian e, pertanto, verranno ignorati all'avvio se gli utenti utilizzano la 
funzione UEFI Secure Boot. Tuttavia, è possibile utilizzare i driver DKMS (1) firmando con una chiave locale e 
informando l'UEFI di tale modifica, oppure (2) disabilitando completamente la verifica dei moduli. È più facile 
farlo che spiegarlo e ci sono un paio di opzioni

1. Utilizzare l'utilità mokutil per fornire la chiave locale che firma i moduli DKMS

mokutil --import /var/lib/dkms/mok.pub

2. Utilizzare mokutil per disabilitare la convalida dei moduli DKMS

sudo mokutil -–disable-validation

https://en.wikipedia.org/wiki/Dynamic_Kernel_Module_Support


Con entrambe le opzioni, verrà richiesta una password. Non dimenticarla, poiché sarà necessaria al riavvio. 
Procedi con il riavvio e fornisci la password: il sistema dovrebbe consentirti di registrare la chiave sul tuo UEFI 
locale o confermare che la convalida è disabilitata, dopodiché i moduli potranno essere caricati durante l'avvio.

7.6.4 Altre opzioni del kernel
Esistono altre considerazioni e scelte relative ai kernel:

• Esistono altri kernel preconfigurati come il kernel Liquorix, che è una versione del kernel Zen e ha lo 
scopo di fornire una migliore esperienza d'uso desktop in termini di reattività, anche sotto carichi pesanti 
come durante i giochi, oltre a una bassa latenza (importante per il lavoro audio). MX Package Installer.

MX Linux aggiorna frequentemente i kernel Liquorix, quindi è più facile
.xsession-error tramite MX Package Installer > Applicazioni popolari > Kernel; oppure MX Package 
Installer > MX Test Repo.

• Le distribuzioni (ad esempio, la distribuzione gemella di MX Linux, antiX) spesso ne sviluppano una propria.

• Gli esperti possono compilare un kernel specifico per un particolare hardware.

Link

• Wikipedia: Kernel Linux

• Anatomia del kernel Linux

• Archivi del kernel Linux

• Mappa interattiva del kernel Linux

7.6.5 Panico del kernel e ripristino
Il kernel panic è un'azione relativamente rara intrapresa dal sistema MX Linux quando rileva un errore interno 
irreversibile dal quale non è possibile ripristinare in modo sicuro. Può essere causato da una serie di fattori diversi 
che vanno da problemi hardware a bug nel sistema stesso. Quando si verifica un kernel panic, provare a riavviare 
con MX Linux LiveMedium, che supererà temporaneamente eventuali problemi software e, si spera, consentirà di 
visualizzare e scaricare i dati. Se ciò non funziona, scollegare tutto l'hardware non necessario e riprovare.

La tua prima preoccupazione è quella di accedere e mettere al sicuro i tuoi dati. Si spera che tu ne abbia un backup 
da qualche parte. In caso contrario, puoi utilizzare uno dei programmi di recupero dati come ddrescue fornito con 
MX Linux. L'ultima risorsa è portare il tuo disco rigido a un'azienda di recupero dati professionale.

Una volta messi al sicuro i dati, potresti dover eseguire una serie di passaggi per ripristinare un sistema MX Linux 
funzionante, anche se alla fine potresti dover reinstallare il sistema utilizzando LiveMedium. A seconda del tipo di 
guasto, è possibile eseguire i seguenti passaggi:

http://en.wikipedia.org/wiki/Linux_kernel
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1. Rimuovere i pacchetti che hanno danneggiato il sistema.

2. Reinstallare il driver grafico.

3. Reinstallare GRUB utilizzando MX Boot Repair.

4. Reimpostare la password di root.

5. Reinstallare MX Linux, selezionando la casella di controllo per mantenere /home (vedere la Sezione 2.5) 
in modo che le configurazioni personali non vadano perse.

Se hai domande su queste procedure, chiedi pure sul forum.

Link

• Home page della libreria GNU C

• Ddrescue

7.7 Le nostre posizioni 

7.7.1 Software non libero
MX Linux è fondamentalmente orientato all'utente, quindi include una certa quantità di software non libero per 
garantire che il sistema funzioni il più possibile fin da subito. L'utente può visualizzare un elenco aprendo una 
console o un terminale e digitando:

Esempi:

• Il driver "wl" (broadcom-sta) e firmware non libero con componenti proprietari.

• Uno strumento dedicato per l'installazione dei driver grafici Nvidia.

Motivazione: è molto più facile per gli utenti esperti rimuovere questi driver che per gli utenti normali installarli. 
Ed è particolarmente difficile installare un driver per una scheda di rete senza accesso a Internet!

http://www.gnu.org/software/libc
https://www.gnu.org/software/ddrescue/ddrescue.html
https://www.gnu.org/philosophy/categories.en.html
https://fossbytes.com/difference-between-shell-console-terminal/


I termini Linux possono inizialmente risultare confusi e scoraggianti, quindi questo glossario fornisce un elenco di 
quelli utilizzati qui per aiutarti a iniziare.

• applet: programma progettato per essere eseguito all'interno di un'altra applicazione. A differenza di 
un'applicazione, le applet non possono essere eseguite direttamente dal sistema operativo.

• backend: anche back-end. Il backend include i vari componenti di un programma che elaborano gli input 
dell'utente inseriti tramite il frontend. Vedi anche frontend.

• backport: i backport sono nuovi pacchetti che sono stati ricompilati per funzionare su una 
distribuzione rilasciata al fine di mantenerla aggiornata.

• BASH: shell predefinita (interprete della riga di comando) sulla maggior parte dei sistemi Linux e su Mac 
OS X, BASH è l'acronimo di Bourne-again shell.

• BitTorrent: anche /bit torrent/ o /torrent./ Un metodo inventato da Bram Cohen per distribuire file di 
grandi dimensioni senza la necessità che un singolo individuo fornisca l'hardware, l'hosting e le risorse di 
larghezza di banda necessarie.

• boot block: area di un disco al di fuori dell'MBR contenente le informazioni necessarie per 
caricare il sistema operativo e avviare il computer.

• bootloader: programma che sceglie inizialmente un sistema operativo da caricare dopo che il BIOS ha 
completato l'inizializzazione dell'hardware. Di dimensioni estremamente ridotte, l'unico compito del 
bootloader è quello di trasferire il controllo del computer al kernel del sistema operativo. I bootloader 
avanzati offrono un menu che consente di scegliere tra diversi sistemi operativi installati.

• caricamento a catena: anche /caricamento a catena/. Invece di caricare direttamente un sistema operativo, 
un boot manager come GRUB può utilizzare il caricamento a catena per passare il controllo da sé stesso a 
un settore di avvio su una partizione del disco rigido. Il settore di avvio di destinazione viene caricato dal 
disco (sostituendo il settore di avvio da cui è stato caricato il boot manager stesso) e viene eseguito il nuovo 
programma di avvio. Oltre a quando è necessario, come nell'avvio di Windows da GRUB, il vantaggio del 
chainloading è che ogni sistema operativo sul disco rigido, e potrebbero essercene dozzine, può essere 
responsabile di avere i dati corretti nel proprio settore di avvio. Pertanto, GRUB residente nell'MBR non 
deve essere riscritto ogni volta che vengono apportate modifiche. GRUB può semplicemente eseguire il 
caricamento a catena delle informazioni rilevanti dal settore di avvio di una determinata partizione, 
indipendentemente dal fatto che sia cambiata o rimasta la stessa dall'ultimo avvio.

• cheat code: i codici possono essere inseriti all'avvio di un LiveMedium per modificare il 
comportamento di avvio. Sono utilizzati per passare opzioni al sistema operativo MX Linux per 
impostare parametri per ambienti particolari.

• Interfaccia a riga di comando (CLI): nota anche come console, terminale, prompt dei comandi, shell o 
bash. Si tratta di un'interfaccia testuale in stile UNIX, a cui anche MS-DOS è stato progettato per 
assomigliare. Una console root è quella in cui sono stati acquisiti i privilegi amministrativi dopo aver 
inserito la password di root.

• ambiente desktop: il software che fornisce un desktop grafico (finestre, icone, desktop, barra delle 
applicazioni, ecc.) per un utente del sistema operativo.

• immagine disco: file contenente il contenuto completo e la struttura di un supporto o dispositivo 
di archiviazione dati, come un disco rigido o un DVD. Vedi anche ISO.

• Distribuzione: una distribuzione Linux, o distro, è un particolare pacchetto del kernel Linux con vari 
pacchetti software GNU e diversi desktop o gestori di finestre. Poiché, a differenza del codice proprietario 
utilizzato nei sistemi operativi Microsoft e Apple, GNU/Linux
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è un software libero e open source, letteralmente chiunque nel mondo abbia le capacità può liberamente 
basarsi su ciò che è stato fatto e innovare una nuova visione di un sistema operativo GNU/Linux. MX 
Linux è una distro basata sulla famiglia Debian Linux.

• File system: anche sistema di file. Si riferisce al modo in cui i file e le cartelle sono organizzati 
logicamente sui dispositivi di archiviazione di un computer in modo che possano essere trovati dal 
sistema operativo. Può anche riferirsi al tipo di formattazione su un dispositivo di archiviazione, come i 
comuni formati Windows NTFS e FAT32, o i formati Linux ext3, ext4 o ReiserFS, e in questo senso si 
riferisce al metodo effettivamente utilizzato per codificare i dati binari su disco rigido, floppy, unità flash, 
ecc.

• firmware. I piccoli programmi e le strutture di dati che controllano internamente i componenti 
elettronici

• free-as-in-speech: Il termine inglese "free" ha due possibili significati: 1) senza costo e 2) senza 
restrizioni. In parte della comunità del software open source, un'analogia utilizzata per spiegare la 
differenza è 1) "free" come nella birra contro 2) "free" come nella libertà di parola. Il termine
/freeware/ è usata universalmente per riferirsi al software che è semplicemente gratuito, mentre la frase 
/free software/ si riferisce in modo approssimativo al software che è più propriamente chiamato software 
open source, concesso in licenza con un qualche tipo di licenza open source.

• frontend: Anche front-end. Il frontend è la parte di un sistema software che interagisce direttamente 
con l'utente. Vedi anche backend.

• GPL: GNU General Public License. Si tratta di una licenza con cui vengono rilasciate molte applicazioni 
open source. Essa specifica che è possibile visualizzare, modificare e ridistribuire il codice sorgente delle 
applicazioni rilasciate con tale licenza, entro certi limiti, ma che non è possibile distribuire il codice 
eseguibile a meno che non si distribuisca anche il codice sorgente a chiunque ne faccia richiesta.

• GPT: uno schema di partizionamento utilizzato dall'UEFI nativo
• Interfaccia grafica utente (GUI): si riferisce a un programma o a un'interfaccia del sistema operativo che 

utilizza immagini (icone, finestre, ecc.), al contrario delle interfacce testuali (riga di comando).
• Directory home: una delle 17 directory di primo livello che si diramano dalla directory root in MX 

Linux, /home contiene una sottodirectory per ogni utente registrato del sistema. All'interno di ciascuna 
directory home, l'utente dispone di privilegi di lettura e scrittura completi. Inoltre, la maggior parte dei file 
di configurazione specifici dell'utente per i vari programmi installati sono memorizzati in sottodirectory 
nascoste all'interno della directory /home/username/, così come le e-mail scaricate. Gli altri file scaricati 
vengono solitamente salvati per impostazione predefinita nelle sottodirectory 
home/nomeutente/Documents o
/home/nomeutente/Desktop.

• IMAP: Internet Message Access Protocol è un protocollo che consente a un client di posta elettronica di 
accedere a un server di posta remoto. Supporta sia la modalità di funzionamento online che offline.

• Interfaccia: punto di interazione tra i componenti di un computer, spesso riferito al collegamento tra 
un computer e una rete. Esempi di nomi di interfacce in MX Linux includono WLAN (wireless) ed 
eth0 (cablato di base).

• IRC: Internet Relay Chat, un protocollo più vecchio che rende più facile lo scambio di messaggi di 
testo.

• ISO: immagine disco conforme a uno standard internazionale che contiene file di dati e metadati del file 
system, inclusi codice di avvio, strutture e attributi. Questo è il metodo normale per distribuire versioni di 
Linux come MX Linux su Internet. Vedi anche immagine disco.



• kernel: il livello di software in un sistema operativo che interagisce direttamente con l'hardware.
• LiveCD/DVD: un compact disc avviabile da cui è possibile eseguire un sistema operativo, solitamente 

con un ambiente desktop completo, applicazioni e funzionalità hardware essenziali.
• LiveMedium: termine generico che include sia LiveCD/DVD che LiveUSB.
• LiveUSB: un'unità flash USB su cui è stato caricato un sistema operativo in modo tale da poter essere 

avviato ed eseguito. Vedi LiveDVD.
• Indirizzo MAC: indirizzo hardware che identifica in modo univoco ogni nodo (punto di connessione) di 

una rete. È formato da una stringa di solito composta da sei serie di due cifre o caratteri, separate da due 
punti.

• Pagina man: abbreviazione di manuale, le pagine man contengono in genere informazioni dettagliate su 
switch, argomenti e, talvolta, sul funzionamento interno di un comando. Anche i programmi GUI hanno 
spesso pagine man che descrivono in dettaglio le opzioni disponibili dalla riga di comando. Sono 
disponibili nel menu Start digitando un # prima del nome della pagina man desiderata nella casella di 
ricerca, ad esempio: #pulseaudio.

• MBR: Master Boot Record: il primo settore da 512 byte di un disco rigido avviabile. Dati speciali scritti 
nell'MBR consentono al BIOS del computer di trasferire il processo di avvio a una partizione con un 
sistema operativo installato.

• md5sum: un programma che calcola e verifica l'integrità dei dati di un file. L'hash MD5 (o checksum) 
funziona come un'impronta digitale compatta di un file. È estremamente improbabile che due file non 
identici abbiano lo stesso hash MD5. Poiché quasi ogni modifica apportata a un file comporta anche una 
modifica del suo hash MD5, l'hash MD5 viene comunemente utilizzato per verificare l'integrità dei file.

• mirror: anche sito mirror. Una copia esatta di un altro sito Internet, comunemente utilizzata per 
fornire più fonti delle stesse informazioni e garantire un accesso affidabile a download di grandi 
dimensioni.

• modulo: i moduli sono pezzi di codice che possono essere caricati e scaricati nel kernel su richiesta. 
Estendono le funzionalità del kernel senza la necessità di riavviare il sistema.

• mountpoint: il punto del file system di root in cui un dispositivo fisso o rimovibile è collegato 
(montato) e accessibile come sottodirectory. Tutto l'hardware del computer deve avere un mountpoint 
nel file system per essere utilizzabile. La maggior parte dei dispositivi standard come tastiera, monitor e 
disco rigido principale vengono montati automaticamente all'avvio.

• mtp: MTP sta per Media Transfer Protocol (protocollo di trasferimento multimediale) e opera a livello 
di file in modo che il dispositivo non esponga l'intero dispositivo di archiviazione. I dispositivi Android 
meno recenti utilizzavano l'archiviazione di massa USB per trasferire file da e verso un computer.

• NTFS®: il New Technology File System di Microsoft ha debuttato nel 1993 sul sistema operativo 
Windows NT, orientato alle reti aziendali, e con alcune revisioni è entrato nei computer desktop degli 
utenti Windows mainstream nelle versioni successive di Windows 2000. È il file system standard 
dall'introduzione di Windows XP alla fine del 2001. Gli utenti Unix/Linux dicono che sta per "Nice Try 
File System"!

• open-source: software il cui codice sorgente è stato reso disponibile al pubblico con una licenza che 
consente agli utenti di modificarlo e ridistribuirlo. In alcuni casi, le licenze open-source limitano la 
distribuzione del codice binario eseguibile.



• pacchetto: un pacchetto è un insieme discreto e non eseguibile di dati che include istruzioni per il gestore 
di pacchetti relative all'installazione. Un pacchetto non contiene sempre una singola applicazione; potrebbe 
contenere solo una parte di un'applicazione di grandi dimensioni, diverse piccole utilità, dati relativi ai 
caratteri, grafica o file di aiuto.

• gestore di pacchetti: un gestore di pacchetti come (Synaptic o Gdebi) è un insieme di strumenti che 
automatizzano il processo di installazione, aggiornamento, configurazione e rimozione dei pacchetti 
software.

• Pannello: il pannello altamente configurabile in Xfce4 appare di default sul lato sinistro dello schermo 
e contiene icone di navigazione, programmi aperti e notifiche di sistema.

• Tabella delle partizioni: una tabella delle partizioni è un'architettura del disco rigido che espande il 
vecchio schema di partizionamento Master Boot Record (MBR) utilizzando identificatori univoci globali 
(GUID) per consentire l'esistenza di più delle quattro partizioni originali.

• Persistenza: la capacità, quando si esegue un LiveUSB, di conservare le modifiche apportate durante 
una sessione live.

• Porta: una connessione dati virtuale che può essere utilizzata dai programmi per scambiare dati 
direttamente, invece di passare attraverso un file o un'altra posizione di archiviazione temporanea. Alle 
porte sono assegnati numeri per protocolli e applicazioni specifici, come 80 per HTTP, 5190 per AIM, 
ecc.

• purge: comando che rimuove non solo il pacchetto specificato, ma anche tutti i file di configurazione e 
dati ad esso associati (ad eccezione di quelli presenti nella directory home dell'utente).

• repo: forma abbreviata di repository.
• repository: un repository software è una posizione di archiviazione Internet da cui è possibile 

recuperare e installare pacchetti software tramite un gestore di pacchetti.
• root: root ha due significati comuni in un sistema operativo UNIX/Linux; sono intimamente 

connessi, ma è importante comprenderne la distinzione.
• Il file system root è la struttura logica di base di tutti i file a cui il sistema operativo può accedere, 

siano essi programmi, processi, pipe o dati. Dovrebbe seguire lo standard Unix Filesystem 
Hierarchy Standard, che specifica dove collocare tutti i tipi di file nella gerarchia.

• L'utente root è il proprietario del file system root e quindi ha tutti i permessi necessari per 
eseguire qualsiasi operazione su qualsiasi file. Sebbene a volte sia necessario assumere 
temporaneamente i poteri dell'utente /root/ per installare o configurare programmi, è pericoloso e 
viola la struttura di sicurezza di base di Unix/Linux effettuare il login e operare come /root/ a meno 
che non sia assolutamente necessario. In un'interfaccia a riga di comando, un utente normale può 
diventare temporaneamente root eseguendo il comando su e inserendo la password di root.

• runlevel: un runlevel è uno stato operativo preimpostato su un sistema operativo di tipo Unix. Un sistema 
può essere avviato in uno qualsiasi dei diversi runlevel, ciascuno dei quali è rappresentato da un numero 
intero a una cifra. Ogni runlevel designa una diversa configurazione di sistema e consente l'accesso a una 
diversa combinazione di processi (ovvero, istanze di programmi in esecuzione). Vedere la Sezione 7.5.

• script: file di testo eseguibile, contenente comandi in un linguaggio interpretato. Di solito si 
riferisce agli script BASH che sono ampiamente utilizzati "dietro le quinte" del sistema operativo 
Linux, ma possono essere utilizzati anche altri linguaggi.



• sessione: una sessione di login è il periodo di attività tra il login e il logout di un utente da un sistema. 
In MX Linux, questo indica tipicamente la durata di un particolare "processo" utente (il codice del 
programma e la sua attività corrente) che Xfce invoca.

• SSD: un'unità a stato solido (SSD) è un dispositivo di archiviazione non volatile che memorizza dati 
persistenti su una memoria flash a stato solido.

• codice sorgente: il codice leggibile dall'uomo in cui il software è scritto prima di essere 
assemblato o compilato in codice macchina.

• swap: una porzione dell'unità riservata per memorizzare i dati che non trovano più spazio nella RAM. 
Può essere una partizione fissa o un file flessibile; quest'ultimo è solitamente migliore.

• switch: uno switch (anche /flag/, /option/ o /parameter/) è un modificatore aggiunto a un comando per 
cambiarne il comportamento. Un esempio comune è -R (ricorsivo), che indica al computer di eseguire 
il comando in tutte le sottodirectory.

• symlink: anche collegamento simbolico e collegamento soft. Un tipo speciale di file che punta a un altro 
file o directory e non a dati. Consente allo stesso file di avere nomi e/o posizioni diversi.

• tarball: un formato di archiviazione, come zip, popolare sulla piattaforma Linux. A differenza dei file 
zip, però, i tarball possono utilizzare uno dei diversi formati di compressione, come gzip o bzip2. Di 
solito terminano con estensioni di file come .tgz, .tar.gz o .tar.bz2.
Molti formati di archivio sono supportati in MX con un'applicazione grafica chiamata Archive Manager. 
Di solito un archivio può essere estratto semplicemente cliccando con il tasto destro del mouse su di esso 
in Thunar.

• (U)EFI: Unified Extensible Firmware Interface è un tipo di firmware di sistema utilizzato sui 
computer recenti. Definisce un'interfaccia software tra un sistema operativo e il firmware della 
piattaforma e rappresenta il successore del vecchio BIOS.

• Unix: anche UNIX. Il sistema operativo su cui è basato Linux, sviluppato alla fine degli anni '60 dai Bell 
Labs e utilizzato principalmente per server e mainframe. Come Linux, Unix ha molte varianti.

• UUID (Universally Unique IDentifier). Un identificatore univoco universale (UUID) è un numero a 128 
bit che identifica oggetti o dati Internet univoci.

• Gestore di finestre: componente di un ambiente desktop che fornisce le funzioni di base di 
ingrandimento/riduzione/chiusura/spostamento delle finestre nell'ambiente GUI. A volte può essere 
utilizzato in alternativa a un ambiente desktop completo. In MX Linux, il gestore di finestre predefinito 
è Xfce4.

• X: Anche X11, xorg. Il sistema X Window è un protocollo di rete e di visualizzazione che fornisce 
finestre su display bitmap. Fornisce il toolkit e il protocollo standard per costruire interfacce grafiche 
utente (GUI) su sistemi operativi simili a Unix e OpenVMS, ed è supportato da quasi tutti gli altri 
sistemi operativi moderni.


